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Exercise 0 — SIFT Lab Installation

Objectives

. Install and prepare your lab workstation for digital forensic analysis for the week.
) Move the evidence files gathered during IR evidence collection phase to our analysis platform for
further scrutiny.

Exercise Preparation

1. Install VMware Workstation/Fusion or VMware Player from vmware.com
o hitips://www yimware com/prodacts/workstation
e hups//wwwvm com/products/player
o hito/fwww ymware com/products
2. Install RedLine on your Windows Host or VM
o Located on your USB under \SIPT-Lab-Iostallirvedling
e You might need to install .NET before the installation. The installed for the FULL version of .NET is found
in_A\SIFT-Lab-Installlredliine
e Itis CRITICAL that you install and make sure RedLine functions before the beginning of Section 2 in the
course. Do not simply wait to install it minutes prior to needing it for the RedLine exercises
e ltis also highly recommended that you install RedLine on your host system instead of your virtual
machine to increase processing power during memory analysis
e You can check to see if Redline works correctly by simply executing it and getting to the “Main Screen”
3. If Windows Host, Install 7zip
o Located on your USH under \NST#T-Tab-Yn

4. Copy and Install the SIFT Workstation from:
o tocated anyour USB under \STIFT-Tab-Install \SIFT\STET

fusion

3 - FORLBOY _zip

» This PC » FORSG8 (D » SHT-lab-Ilnstall » SIFT
A ) Fa
il
SIFT 3.- FORSU8.zip
Virtual Machines

Hamm Share View

o v This PC + Documents s Virtual Rachines
deos ~ J
e © SIFT 3 - FOR508.2ip
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[Whar is on the USB?

1. The USB Contains the data from the 4 systems potentially involved in the intrusion breach.
2. The name of each of the directories is listed by:
e Operating System
e System Owner
o IP Address
e OS-User-IP
e Example: xp-tdungan-10.3.58.7

4 win7-32-aromanoff-10.3.583
J5 win7-64-nfury-103.586

& win2008R2-controiler-10.3.58.4
& xp-tdungan-10.358.7

3. In each of the directories you will find 3 additional directories.

» FORSOS (K:) » xp-tdungan-103587 »

B Bum New folder

s xp-tdungan-c-drive
& xp-tdungan-incident-response
4 xp-tdungan-memory

a. c-drive directory
e This is the location of the collected hard drive images.

e Onthe xp-tdungan-c-drive directory you will also see a precooked directory.

® The precooked is where we have some data preformatted in case certain tools take too long to
process the data. Each exercise that uses precooked data will let you know.

FORS08 (K:_} I 3 i xp-tdungan-10.3.58.7 pr-tgungan-c-dri'.‘e b

Burn New folder

xp-tdungan-c-drive E04
xp-tdungan-c-drive.bd
xp-tdungan-c-drive.E03 : i
xp-tdungan-c-drive.E02
R xp-tdungan-c-drive.E01
precocked
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b. Incident Response directory
e This is the location of data collected during Incident Response on each system.

FORS08 (]} » xp~tEn;a_r;-iC;3_.53.'.‘t » :rp-tdungan-rncident-resﬁ;‘:nse M

Burn New folder

xp-tdungan-Redline-Live-Audit

h) autcruns-xp-tdungan.csv

¢. Memory directory
e This is the location of the memory image collected during Incident Response.

FORS08 (E:)-. » 1;:1(5696&10.3.5&7 » xp-tdungan—mepmor)'

Burn MNew folder

xp-tdungan-memery-raw.001

xp-tdungan-memory-ravw.td
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Exercise - Setting up your Lab - Preparation for the Week

1. Tweak the settings of your VMware configuration to allow for more memory and processor power as
your system will allow. Note: Do not ever increase it beyond the maximum recommended settings.
2. launch VMWare Player, Fusion, or Workstation
1. File -> Open ->
2. \Path-To\Virtual Machines\SIFT 3 - FOR508\SIFT 3 - FOR508.vmx

3. Upgrade your virtual machine if you can -> VM -> Upgrade or Change Version (Follow Wizard).

= SIFT 3 - FOR508 - VMware Workstation - O

Fide tdit view VM Tabs Help
- > L & 0) ee X

SIFT 3 - roRs08

- Levices
i = hienwory 4 GR
| “EPocessors 8

= Haed sk 8O3 500 GR
| ZHard Disk 2 SCS 1000 6B {Persisters)
FeNetveork Adapter NAT

| SUSBLontroler  Present
# Sound Catd Aaiter detact
R Disglay Agto detect

= Descriptior

Figure 1 - Update Version to Latest

4. Adjust Memory -> Select “Edit Virtual Machine Settings” -> Select Memory

NOTE: Do not give your VM more than % of your machines memory. If your machine slows down as a
result, reduce the amount of memory allocated to the VM.
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Hardvale Qptions

- Oy
L4 Processars
w=Mard Disk {5C513

“=Hasd Disk 2 (5CS1}
TiNebvork Adaptet
S8 Controller

4 Sound Cand

* Display

Virtual Machine Settings

Summay Memory
oL = “ B specify the amount of nsencory alfocated to this virtual
3 maching, The memory size must be a mulliple of 4 MB.
500 GB : -
1003 GE (Persistent) L Menory far this virtual macine: A0B6 T My
NAT
Present #4 GB
Auto detect NGe
Aute detect \6 G8
5 2 Mydmum recommendes memory
(Memory swapping may
occur beyond this size.)
2G8 S3as il
656 1
168 )
S22 M8 3 Recommendsd memory
- 1024 MB
128 MB

Figure 2 - Edit Memory Configuration

5.

Power on Your Virtual Machine.

1. Press “Power on virtual machine” and select “I copied it”.

6.

This vr tual machine may have been moved or copred.

In arder to configure certan management and netvarkang features, Yware
Viorkstabon needs 0 know if yeu moved this virtual machne o f you copeed 2.

If you don'tknowi, answer T coped it

1 moved it
0 Icomedit

Cancei

Start your SIFT VMware Workstation in VMware Workstation.

i

File Edit

T Dhavioes
= Memory
“AProcessars

—Harrd Disk {5

L USR Controller
3 Saung Cord

2 Display

> Dmserigtion

View WM

SIFT 3 - FOR588

SIFT 3 - FORSOB

wHord Disk 2 (S0 10C0 GB 1Persistent}
FaNetwonk Adapter NAT

SIFT 3 - FORSCS - VMware Workstation

Tabs

Hilp

= o

machipe ffmm—

4GB
By

506 GB

Present
Auto datest
Auto detect
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7. Login the VMware machine.
» LOGIN = sansforensics
» PASSWORD = forensics

O Een ) 536AM (O

sansforensics ®

Password

Guest Session

DFIR

BEITAL FORENSICS ¢ NCIDENT RESPONSE

8. Double Click on the SIFT Workstation icon and browse to the /cases directory (Click on the
Filesystem Icon ->/cases).
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=

- :.
ThE
=~y

sife-cheatsheel pdf

BIFYERE

mount_paints

SANS DFIR pd!l

Host-Computer-
Deive

logztimeline-
cheatsheet pdl

windows-to-unx-
cheatsheet.pdf

Find-Evil-Posterpdl

€ A Y AM X SINSIOrensics (b

DFIR

DIGITAL FORENMES & INCIDENT RESPONE

9. Insert the FOR508 Course USB into your Host System. Note if you know how to connect the USB
directly to the SIFT, the following can be done inside the SIFT itself or by using shared directories. If
you are not familiar with those techniques | have found for those new to VMware simply showing
files can be dragged into the VM is quite useful.

10. Begin copying files to the SIFT workstation we will use for the core exercises for the course. We copy
them into the SIFT to increase speed and processing. While the copying process can be slow, it will
save hours of agony later in the course.

11. On the FOR508 USB, browse to the directory and open it:
» Driveletter:>\xp-tdungan-10.3.58.7

CGrganize » v Ogen

4% Computer
e 05
s RECQUERY {03
o FORS0S (K]
¢ SHIELD- USE (L)
s QUTPUT kY

@ (et B (omp;{;;vb- FORSO3 (K} » | “r

Share vaith = Burn New folder

wind-32-nremancf-10.3.55.5
win?-64-nfury-10.3.585

wn2008R2-contecller-10.2.58.4

xp-tdungan-10.3.58.7 (
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*9 o » Computer » FORS0S (K) » xp-tdungan-10.3.58.7 » v." ) I

Qrganze

hare vy « Suin Mew feldes v L ¢

B Computer
o wp-tdungan-c-dnve
- 051(C:)
« » RECOVERY (D:
o FORS03 (K]
o SHIELD-USE (Ly)
== QUTPUT (M)

rp-tdungan-ncident-response

p-tdungan-memery

12. Drag and Drop the 3 directories “xp-tdungan-c-drive, xp-tdungan-incident-
response, xp-tdungan-memory”toyour/cases/folder into your Ubuntu SIFT Workstation
Virtual Machine.
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13. Change directories to the DriveLetter:>\win7-32-nromanoff-10.3.58.5

“; v v 1 am» Computer » FORS8(F:;) v & Seasch FCR5G2 )
A Name ° Date meddied Type Size
@gzﬁpgn & eample-memory-images 1073072012 44 PM  File folder
St( ) . J5 Win7-32-nromanoff-10.3.50.5 < —— )7 584 File folder
‘é'; D:;:;(D"f  oRis ind J win7-64-nfury-103.585 41212537 AN File folder
e F""‘{E‘) -rindons Ji win2008R2- controller-10.3.58.4 41272012958 AM  File folder
- ik & xp-tdungan-10.3.58.7 41272012 1430 AM  File folder
< CODEMETER (G:)
» RECOVERY (H:) v
% w 4 3 » Computer + FORS08(F) » win7-32-nromanoff-10.3.58.5 v &
P
-~
A Name Date modified Type
4 % Comput o
? On;pc,ﬂ J win7-32-nromanoff-c-drive 412/2012 1027 AM  File fclder
; & Sto( ) o & win7-32-nomanoff-incident-response 471372012 1012 AM  File folder
et g E win?-32-niomanoff-memory 4/12/20121030AM  File folder

=y - ] DVD RW Drive (E:) FOR408_Windows._
> wis FORS0R (F)

14. Drag and Drop the 3 directories “win7-32-nromanoff-c-drive, win7-32-nromanoff-
incident-response, win7-32-nromanoff-memory” toyour/cases/folder into your
Ubuntu SIFT Workstation Virtual Machine.
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15. Change directories to the DriveLetter:>\example-memory-images and copy the directory
to the /cases directory.

~ 1 am * Computer » FORS03 (F:)

A HName

/M Computer
o eample-memany-images (——'—
i 053 4 2 el
g Storage (O}

winT-32-nromeznoff-10.3.58.5

. DVD RW Drive (E:) FOR408 Windows_{ 4 winT-64-nfury-10.3.58.6 SNYVRGITAM  Fle folder
B i
: Al ~naoms 4 win2008R2-controller-10.3.58.4 ;
o FORSO8 (F:} e 1013 <5 7
& ~ 1 e * Computer » FORS0S (F) v &
N ¢ {ifis Tyt
4 'K Computer - — T
05 example-memory-images 25 PM Fille folder
= S : D:) win7-32-nromancff-10.3.35.5 TMENE 2T AM  Fle tolder
La Storage (D:
vin -6d-nfury-10.3.58.4 4 2012537 AM
{% DVD RW Drive (E:) FOR403_Windows_§ < : gt =
FORS08 (F win2008R2-controllerf0.3.58.4 12958 AM File fold
- CODEM;T.;P E xp-tdungan-10.3.59 411223 AN File feld
[ SLEH
+ « RECOVERY (H) v
5 items 1 item selected
e i e e e
; Back
" Location IJ'CBS-QS 4 Q 100° Q icon View v

Places~ =
|

& sansferensics . 2 i 4 [S—
] & Desktop example-memory- win7-32-nromanoff-c- win7-32-nromanofi- win7-32-rromanoff-

__ File System images drive incident-response memeory
| s Netwerk

_ Floppy Drive

€3 p o op ‘,__._J T 2 = _]

o ras xp-tdungan-c-drive xp-tdungan-incident- xp-tdungan-memory

44 Downloads response

mount_points
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16. Check your work! When completed, change directories to the /cases directory in your terminal and
run the file listing command “1s”. You should see all the directories here that you just copied.

" root@SIFT-Workstation: /cases

file  Edit View Terminal Help
sansforensics@SIFT-Workstation:~$ sudo su
root@SIFT-Workstation: /home/sansforensics# cd /cases/

root@SIFT-Workstation:/cases# 1s

root@SIFT-Workstation:/cases#

17. You have successfully prepped your SIFT Workstation for FOR508 — Advanced
Forensics Analysis and Incident Response for the first part of the week!!
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STARK RESEARCH LABS

ADVANCED ADVERSARY INTRUSION SCENARIO

Scenario Designed and Created by Rob Lee

APT Team - John Strand and Timothy Tomes

—_— e e e e e e
Case Background Exercise 1 - Intro Page 1



|DAY 0 - APRIL 6, 2012 FRIDAY @5 PM EDT

A 3-4 LETTER GOVERNMENT AGENCY

CONTACTS YOUR COMPANY BY PHONE

“WE HAVE SEEN A FEW HUNDRED
MEGABYTES OF SENSITIVE DATA LEAVE
YOUR NETWORK BOUND FOR A FOREIGN
COUNTRY.”

“DON'T ASK HOW WE KNOW, BUT YOU
MIGHT WANT TO CHECK 10.3.58.7 ON
YOUR NETWORK”

e ——
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COMPANY INFORMATION:

Stark Research Labs is a government sponsored laboratory that researches specialized metal alloys
and bio engineering capabilities. Lately, SRL has been tasked to find the secret and once lost alloy
formula for VIBRANIUM-Alloy. The lead researcher, Timothy Dungan, has been making progress
and it looks like with the help of others he was finally able to replicate the formula

M. Hill is the current SRL-LABS Director and Administrator appointed by the President.

ONE WEEK AGO - MARCH 31, 2012 @ 16:11:16

From "Timothy Dungan® Sat Mar 31 16:11:16 2012/

From: "Timothy Dungan" <SMTP:TDUNGANESTARK-RESEARCH-LABS.COM>/
Subject: Test Success - Alloy Combination

To: 'mhill.shield@yahoo.com)

Cc: 'nromanoff@stark-research-labs.com'

Pate: Sat, 31 Mar 2012 16:11:16 +0000

We have finally replicated the long lost secret of Vibranium-Iron alloy.

After months of testing we have found that the secret to combing the alloy was
accidentally discovered when a lab student (Peter of Horizon Labs) stopped by. See
attached report. Next Steps?

-Timothy

———— e ——————
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EXCITED, TIMOTHY DUNGAN POSTS PUBLICALLY ABOUT THE FIND!

‘PUBLIC TWEET ON 31 MAR 2012

1 M Timocthy Dungan 4 Reply T3 Retyeet W Favorte - Cpen
: FINALLY We found it!!! Thanks to PETER!!!

S —
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THE VERY NEXT DAY, MARIA HILL RESPONDS - ARPIL 1, 2012

Date: Sun, 1 Apr 2012 07:08:48 -0700 (PDT)

From: Maria Hill <mhill.shield@yahoo.com>

Reply-To: Maria Hill <mhill.shield@yahoo.com>

Subject: Re: Test Success - Alloy Combination

To: Timothy Dungan <tdungan@stark-research-labs.com>

In-Reply-To: <1331844046.4518.YahooMailNeo@webl22203.mail.nel.yahoo.com>
---2079400718-714555717-1333289328=:84815

Content-type: text/plain
Timothy,

This is wonderful news. Incredible. Peter from Horizon labs should be

commended. We will immediately move to phase II. Hopefully HYDRA has no real idea
of our plans. Hydra has been behind specific APT attacks originating from Madripoor
in Asia. That has been their base of operations for quite some time. The nation
was taken over by HYDRA with Madame Hydra as de facto ruler, using the nation to
finance terrorist plots against the world. HYDRA is a criminal organization
dedicated to the achievement of world domination through terrorist and subversive
activities on various fronts, resulting in a fascist New World Order. Since the
takeover, this Asian nation has started to infiltrate many sectors in almost every
industry stealing economic information, intellectual property, and targeting key
executives with spear phishing attacks.

Be on the lookout for anything suspicious as Im sure word will get out that we made
a breakthrough. Im positive they have spies inside our operations at Stark Research
Labs.

At all costs, please make sure you secure any information regarding the Star Fury
projects, our undercover agent lists, our backstopped credit card accounts, and any
information regarding our new base in DC. Finally, you have to protect the key
information to the secret formula at all costs. Having HYDRA find and recover any
of this information could be devastating to our operations.

Thanks again for this wonderful news and stay in contact. Looking forward to
hearing more updates.

-MH

e e e e e —————————
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‘ FAST FORWARD - APRIL 6, 2012 @5PM

The SRLIRT is called into action. Your mission, if you choose to accept it, is to answer the following

queStiO]fIS. "—7/‘{‘\)}\'(‘”& 7.,.)0‘%("-\. ) ne f(cl\ r"fr/'fv{’ on<L_

Did a breach occur?

What systems were compromised?
What was taken?

How did they breach our network?
Where did they go?

Who compromised us?

What malware was used?

What should we do?

NS LD

_— . ————
—————c—________ - ————  — _—_ —____— = ]}

Case Background Exercise 1 — Intro Page 6



«+ World Leader

5 y ip < i

develep for the North

| G,

Sl R Sl

Enterprise network with over 1,000 users and systems. A few key systems in SRL subnet network are
as follows.

e 10.3.58.4 Win2008R2 Domain Controller

e 10.3.58.5 Win7-SP1-32bit N. Romanoff Workstation

e 10.3.58.6 Win7-SP1-64bit N. Fury Workstation

e 10.3.58.7 WinXP-SP3-32bit Timothy Dungan Workstation

Internal Networks
10.3.58.X — Workstation and Lab Stations
10.3.16.X — Workstation and Lab Stations

Falconlll — VPN Concentrator

« Full auditing turned on per recommended guidelines.
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o Users are restricted to being users (cannot even install a program if they wanted to).

o  Windows 2008R2S5P1 Domain Controller

» Systems installed and have real software on it that is used (Office, Adobe, Skype, Tweetdeck,
E-mail, Dropbox, Firefox, Chrome).

» Fully patched (Patches are automatically installed).

» Enterprise Incident Response agents (F-Response Enterprise).

o Enterprise A/V and On-Scan capability (McAfee Endpoint Protection — Anti-virus, Anti-
spyware, Safe surfing, Anti-spam, Device Control, Onsite Management, Host Intrusion
Prevention (HIPS) ).

o Network Using HBSS (Host Based Security System — Per DOD Recommendations)

» Firewall only allowed inbound 25,80 and outbound 25, 80, 443 only.

» Users have been "using" this network for over a year prior to the attack. That way it has the
look and feel of something real. These users have setup social media (yes they are on twitter...
you might be friends with them), e-mail, Skype, etc. Each character user has a backstory and a
reason to be there working.

» Rsydow is the Domain Administrator

o SRL-HELPDESK Account is local admin account w/shared password

ADDITIONAL INFORMATION REGARDING SRL DOMAIN

e Local Admin User (SRL-Helpdesk) found on each system w/same password.
e Not every user has migrated to Win7 and Win2008. We do still have some legacy WinXP
systems.

o Most of the employees telecommute from home to the lab. The VPN concentrator is located on
the \ \FALCONIII system. Most users RDP into their systems from the VPN.

USER’S POTENTIALLY COMPROMISED:

TIMOTHY DUNGAN - 10.3.58.7

SOCIAL MEDIA ACCOUNTS

e LINKEDIN:
o http://www linkedin.com/pub/timothy-dungan/3a/153/678
e Twitter: @TimothyDungan
o https://twitter.com/#!/TimothyDungan
e Googlet:
o https://plus.google.com/104381120365479308959/posts
¢ Facebook User
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e  Gmail Account

SENSITIVE DATA ON 10.3.58.7

Metal and Alloy Research

e —

Case Background Exercise 1 — Intro Page 9



This page intentionally left blank.



Exercise 2 - Mounting Evidence Using SIFT

| Objectives

e  Mount an acquired disk image into the SIFT workstation so you can see the files and folders and begin

analysis of the system.

e Learn the process for examining and manipulating compressed images, such as split EO1s, using the

SIFT workstation.

Exercise Preparation

]

1. Start your SIFT VMware Workstation in VMware Workstation.

2. Login the VMware machine.
» LOGIN = sansforensics
» PASSWORD = forensics

Exercise — Step-by-Step Guide

1. Elevate your privileges to root.

$ sudo su -

2. Change directories to the /cases/xp-tdungan-c-drive/.

below, take note of how many and the sizes of the “E0Q1, EQ2, E03” files in the directory.

When you run the “Is” command

# cd /cases/xp-tdungan-c-drive/

# 1s -1h
-rwxrwxrwx 1 sansforensics sansforensics 2.0G Apr 9 2012
-rwxrwxrwx 1 sansforensics sansforensics 2.0G Apr 9 2012
-rwxrwxrwx 1 sansforensics sansforensics 2.06 Apr 9 2012
-rwxrwxrwx 1 sansforensics sansforensics 703M Apr 9 2012
-rwxrwxrwx 1 sansforensics sansforensics 1.7K Apr 9 2012

3. Mount the xp-tdungan-c-drive.EO1 image files in the /mnt/ewf_mount directory. Note the

result of this command will combine the compressed expert witness images into a single raw image. The

ewfmount command will always name this file “ewfl.” The ewfmount command will combine the (E01,

E02, E03, etc.) files together and uncompress them via the running mount process. When you run the “Is”

command below, take note of the file size of the uncompressed raw image.

For508 - SANS ©2015
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EO1 to Raw

Mount EC1 using + /mnt/ewf/ Directory will now contain a raw dd/raw image
ewfmount

e §} ewfmount image-name.E0l1 /mnt/ewf/

# ewfmount xp-tdungan-c-drive.EO1l /mnt/ewf_mount/
# cd /mnt/ewf mount

# 1s -1h

root@siftworkstation:/# cd /cases/xp-tdungan-c-drive/

root@siftworkstation: /cases/xp-tdungan-c-drive# ewfmount xp-tdungan-c-drive.EO01 /mnt/ewf_mount
ewfmount 20140608

root@siftworkstation:/cases/xp-tdungan-c-drive# cd /mnt/ewf_mount

root@siftworkstation: /mnt/ewf_mount# ls -1lh

total 0

-r--r--r-- 1 root root 16G Oct 28 20:48 ewf1

4. Mount the xp-tdungan-c-drive raw image found in the /mnt/ewf_mount directory on the
/mnt/windows mount directory.

mount -of[opticns] device directory

{Useful Options]
-o Use the following options separated by commas --

N0 spaces

ro, mount as read only

loop, mount on a loop device (used for image files)

noexec, do not execute files from mounted partitions

offset=byte num, if mounting a physical drive you can use the
offset option tc have it mount at % bytes
into the physica! disk

show sys files, show NTFS volume metafiles

streams_interface=windows use alternate data steams

Figure 1 Mount Command Options and Explanations

# mount -o ro,loop,show_sys_files, streams_interface=windows ewfl
/mnt/windows_mount/

# cd /mnt/windows_mount

# 1s
EWf
J/ {metw\t
. . . . DIL,L‘“;\E)N
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root@SIFT-Workstation:/mnt/windows mount# 1s

—

$Secure
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Exercise 3 — CTI - Indicator Creation and

Examination

Objectives J

e Install and Launch 10C Editor on your Windows Workstation

e Examine I0C Editor’s interface and examine default APT1 “Comment Crew” indicators
[ ]

[ ]

Build your own 10C based on the information provided by the Government Agency that contacted you
Use Boolean logic and different operators to ensure your 10C is properly configured

Exercise Preparation

» Install Mandiant 10C Editor from your USB on your Windows Host (or VM) in the \SIFT-Lab-
Install\IOC Editor folder

ENCIET. L abs traaln O Edib g
F\SIFT-Lab-InstalNlOC Editor

”~

MName

18! Mandiant l0Ce.msi h

> Launch Mandiant 10C Editor (Win 7 and Win 8 shown below)

Jed

Mandiant
— Everywhere ~
¥ Mandiant 10Ce
a5 Mandiant I0Ce User mandiant (S8
MessageOps
NMicroseft Office 2012 \
4 Back
0
logo_mandiant_intelligent_respo.

vor logo_mandiar :_ir":tt!]lt_t‘:ﬂr ﬁiﬂl

» Open “I0OC Directory” \SIFT~Lab-Install\IOC Editor\APT1 - IOCS\
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14 10Ce 2.2.0 - FASIFT-Lab-InstathIOC Editon\APT? - I0CS SNG n
Filz  Search  Tools Help

Nare Created Updated Souce ” | Hame AURIGA (FAMILY) Tioa e
Append B~ APT1 Rle Hashes 20130210 08:11:53Z 281302013 00.002  Mandand § il

AURIGA FAMILY) 261202400611537 20130210 BLOO0Z Mandart | (V07 Mendent ::::::w ﬁ;"““'

BANGAT (FAMILY} 20130210 8611532 20130210 I E0A0Z  Mandand GUIR  43243990-affd-486ea-s3%c-64addEb32a12 tamdy 29T

BISCUIT FAMLY} 20130210 0611532 20120210 1300007 Mandart — fondy NG

BOUNCER FAMILY) 20120216 06.14532 20120290 1300002 Mandan | CeXed 2013-02-15 0¢:11:832 ! T

CALENDAR FAMILTS 20130210 06:11:532  2013-02-10 13.80.00Z  Mandiant Modfied: 2213-92-10 13:49:002

COMBOS FANILY: 20130210 561157 2013-02-10 1360 002 Mardart e

COGKIERAG {FAMILY) 20130290 08:10:532 2013024012 00.602  Mandant D:“E';"h e — e —
DAIRY FAMILY) 20130210 06 11532 20130240 1300002 Manciart hiry Amstware ares b aige ymourt of functonalty w ANGAT backdeor a
GDOCUPLOAD FAMILYY 2013029006 13532 201302 101300007 Mandart | 1o orsens s sty i, e . o oo ke procestes pefomnng
GETMAIL (FAMILY} 2013021206 11532 2013-02-10 1366007  Mandiant irjection. nggng off the cument user or satling dovn the ol machine  The AURIGA mahware v
GLOOXMAIL FAMILY) 2013021656 11532 2013-02-10 1350002 Mandant

GOGGLES FAMILY} 20130210 0611:532 20130210 1300:002 Mandae  |Add: AND OR ftem - &
GREENCAT FAMEY) 2013621006 11:532  201302-10 1300002 Mandant = or .
HACKSFASE (FAMILY) 201202-10 0611532 20130210 1200007 Mandiant File Compile Tise is 2008-0£~25700:29:112

HELABTS FAMILY) 20130210 6611:532 20134210 1300 002 Mandiant File Terpile Tize i Z009-03-04T03:35:452

KURTON FAMELY} 20130210 0811532 201302-10 13.00.002  Mandiant File Compile Time ia 2010-33-01T08:26:01Z

LIGHTBOLT (FARILY) 28130210 56 11:532 25130210 13.00.002  Mandiant Tile Compile Time i3 I050-11-06T13:54:442

LIGHTDART (FAMILY} 20120210 06.11:532 20130240 1300 002 Mandiant AND

LOKGRUN FAMILY) 2013021808 115832 20130210 1366002 Mandiant Fole Size xa 17408

MANMTSME FARILY) 20130210 0811832 2613028 1360007  Mandant File Compirle Time 18 29%9-04-28T10:802682 TO 208%-04-23T15:20:
MAPIGET (FAMILY: 213V21006 14532 20130218 1300002 Mandant RnD

MIEASP FAMILY 2013021006 11532 2013.02.50 1280002 Mandart File PEInfs Version Info Legalfcprzight is Q) $3/Daamand Mult
NEWSREELS FAMILY) 20130216 06.11.532 20130210 1300002 Mandant Tale ;;Info Verzica Info Language is Englizt (Tnasted Svates}
SEASALT FAMILY 201392100611 832 20120210 1300002 Mandant i:zlc PEInts Versioa Infe TilaDeseriprion iy RioDrv Ush Drivez
STARSYPOUND FAMILY)  2013-021006111:632 20130210 1300062 Mandiant e B Ve potree WaEITEn BRES O T R IR s EEEEE 53 et
S¥ORD {F,-\NIE.Y} 1302100611837 20136210 BOGNT  Mandant ;i;e i’;;v;..‘.; ‘:'o;:;e;x ;n;m Z;;:;ul;!m. is '1:6:*;32- o
TAEMSGSOL FAMILY) 25130210 06:11:832 20930210 13207 Mandant o T
TARSIPECUPSEFAMILY;  201302.1006:11:532 2613-0210 1300007 Mandart file PIInfc Vagxyion Infe Producthame s S3/Dtamond Multimed
TARSIP-HOON FARILY 2302108611832 HNL20 300007 Mandant File PIInfc Versicn Infs CompanyNaxe iz S3/Diamcnd Mulvimed
WARP (FAMILY) 23130210061 1:637 2012823013 80007 Mandani

WEBC2ADSPACE FAMILYY 20130210 86:11832 2130210 1300:002  Mandant < >
‘(IJEBCZAAUSOWFAHILY} 20130216 06.11:532 33128210 1300062 Mmd\a;\t" Cave

Loaced ICCs: &7

lExercise — 10C Familiarization

Spend about 5 minutes browsing the various APT1 indicators and the 10Cs that have been created already.
The main objective is to identify a specific “level of detail” and familiarization with the Boolean expressions
of the various malware families

Select DAIRY (FAMILY) of malware and step through the 10C ruleset in the lower right hand corner
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Name: DAIRY (FAMILY)

Type Refere
Adthor  Mandant famiy DAIRY
threatgroup  ART
GUID: 2902a26b-8233d-4233-a07d~d4900429dd2D famiy ARTI
Created: 2z013-02-10 06:11:53Z2 category Backdoor

Moddied. 2513-02-14 13:99:052

Deschpbion:
Mertbers of s mahvare famiy are backdeors that provide fle downloading, process listing. prozess king. and reverse shell capabities

This matware may alse add dsef 1o the Authonzed Applcations ist for the Wndows Frewait

Add: AND OR Rem -

ox
i3 9254425732cel372585235343 509"l
iz 233%dciciliza?iTblce2id5EE30332

vy
Wb
2 ped b
»n

oy

L}

oMoy oy
il
oy
T n
ny o
g
[ YL (4
1%
"
-3
t
o g
[£]
n
1
[}
v
o
]
w
=
[
g
e
‘g
a
B
[\
[
[
5
"
a
m
x
"

3
8

Tiie Dstected Ancmalies 13 gheaksus_isz_zezn
File Compile Time i 2038-01-28T22:52:49C
: File Szze is 5488
2 OR
Tile Harme i3 LasavpiZ.exe

Fi:le Rame 1s Winver3SL.exe
o ARD

Regissry Path ocntains ServicesiSharediccessiParameters\FirewsllPelieyvStardazdirofileddutherizedapplicazicnsilisz
o CA
Regiatzy Texs convainsz laaepil.exe
2033ty TeXT COoRnTaLnI WALVAIES).exe

3. Detail the Boolean Expression 10C language by stepping through the logic. Again all we would like you to
do here is mainly become familiar with the language.

IExercise — Create an 10C based on Threat Intelligence provided by Government Agency

As a part of the notification, the government agency that notified you also gave you a basic indicator of the APT group
HYDRA that have compromised other locations. Look at the provided information and create an 10C for the indicator

e Family —-HTTPPUMP
e Threatgroup — APT
e Family—HYDRA

e (Category - Backdoor

Note this information is found in a textile (so you can copy the text) called HTTPPUMP . txt in the \SIFT-
Lab-Install\IOC Editor folder

Description: Members of this family are full featured backdoors that communicates with a Web-based
Command & Control (C2) server over HTTP port 80 using XMLRPC over HTTP for encoding. Features include
interactive shell, gathering system info, uploading and downloading files, and creating and killing processes,
Malware in this family usually communicates with a hard-coded domain using XMLRPC over HTTP on port 80.
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Some members of this family rely on launchers to establish persistence mechanism for them. Several variants

use %USER%\Local Settings\Temp or %USER%\AppData\Local\Temp as working directories, additional
malware artifacts may be found there.

I0C Provided --
e (MD5=c4b0458c04abdaa773348c2668212b45 or Filename = a.exe,b.exe, c.exe)
o AND
»  (Compile Time=2011-10-13 04:19:530r 2011-10-19 02:39:12)
= File Size = 9216 or 9245
= AND

e Directory location = \Temp
e Strings inside malware = httppump

e \CurrentControlSet\Services\Netman\domain
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Exercise — Build the I0C Template Family

1. Select File -> New -> Indicator

File | Search Tools Help

New 4 ._] Indicator  Ctrls l;_'
7 OpenlOC Directory... Ctrl+0 Indicater from '
o Save Ctrl+$ E_j Window  Ctri+W h:

2. Set Name = HTTPPUMP (Family)
3. Set Author = SANS Student

e HTTPUIP o) < (e Petees

Author: | SANS Student h |

GUID. '86c197bb-81£3-4d61-bEdS-bc3Fa5891aLE
Created: 2015-03-03 21:45:462
Modfied: 2015-03-03 21:45:482
Descroti
4. Right Click Area to the Right of the Name and Author Location (It should say “Type/Reference”)

Name: HTTPUMP (Famiy) | Type  Reference
Author. - SANS Student
Add Group
GUID: 88cl97bb-21£9-3d8l-béds-bo3£a5591aL¢€
Add Report
Created: .2015-03-03 21:45:482Z AdWCanidiant
Modfied. 2015-03-03 21:45:4¢€2 Add Category
Descnption: . Add Grade
| Add Threat Group
Add Other

5. Right Click -> Add Other -> Type = Family, Value = HTTPPUMP
£dit Reference ﬁ

Type: Va%ue )
Famiy HTTPPUMP|

Save Cance!

6. Right Click -> Add Other -> Type = Family, Value = HYDRA
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Edit Reference E_
Type: Vaiue
Famiy . [HYORA

Save Cancel

7. Right Click -> Add Threat Group -> Type “APT”
Edit Reference n_

Type: Value:
teatgoop | |APT] i

Save | Cancel

8. Right-Click -> Add Category -> Backdoor

Add Category BN |

Bm wser Helper Object
Credential Stealer

Explot

\GINA Replacement
| Malicious PDF
Password Dumper

9. Copy and paste the description for the malware from the textfile on your USB.

Name: EHITPUMP (Farrm

Puthor, {SANS Student [Famiy  HTTPROMP
GUID: [BEc1ITBD-a12Y-4d6L-bEd5-beBtataTaLE | o o o APT

Created. 2013-03-03 21:48:462 s category  Backdoo
Podfed 2015-03-03 7i:45:462 :
Desenption

Membace of this famidy are s featured backdoors that communicates wih a Web-based Comymand & Cortrol {23 servar over HTTR sort 88 tsing XMLRPC over 4T TP fox ercodng Featires mclude

ntemctive shel, gathanng systerm info, wploadng and Yies. and creating and kiling processes, Maware & the famiy usually communicates with 2 had-coged doman using XMLAPC over KTTP
{on port 80, Soma members of this famiy rely on launchers 1o estabksh persistence mechanism foc them  Severa vanants use WUSER M Local Settings* Tamp or SUSERY \AppDatasiocaltTemp as woding
Aareciones, akilional maiwam adlacts may de loung there
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Exercise — Build the 10C using the provided information

1. Right Click on 1°* “OR” -> Add ltem -> File Item -> File MD5 -> Type
“c4b0458c04abdaa773348c2668212b45”

on ] ikt File Filename Changed
1skitem
| Add jtem : OnsEntryt File Filename Created
. : nsentryltem > |
I Add Logic ’ i File Filename Medified
I TITERRCUUNTEINY TUIYR Dl’l\‘éfh&ﬂ'}
_ File Full Path
Email
File import Function
Eventlogltem >
. ) File Import Name
FileDownicadHisteryltem  »
- File INode
Fileltem = =
- File MD5
FormHistoryltem
) File Modified Time
Hiveltem
File Name
Hookltan Y
2. Right Click on 1°* “OR” -> Add Item -> File Item -> File Name -> Type “a . exe”
on | ] | File Filename Modihied
Diskitem >
Add ltem » File Full Path
" 3 DasEntryltem ! ) )
Add Legic L . file Import Function
' Daveriten )
] file Import Name
Email )
Fite INode
Eventlogltem » )
| ) ‘ File MD35
, FiteDownloadHistoryltem  » | ) o
- - File Modified Time
Fileftem =
- File Name
FermHistoryltem - :
File Number of Imported Functions
Hiveltem » )
i Fite Owner
Hockitemn »
Lils Nkl

3. Right Click on 1°* “OR” -> Add Item -> File Item -> File Name -> Type “b. exe”
4. Right Click on 1* “OR” -> Add Item -> File Item -> File Name -> Type “c.exe”

5. CHECK YOUR WORK -> YOUR IOC SHOULD NOW LOOK LIKE THIS

OR
File MD5 i3 c4b0458c04z2bdaa773348¢c2&€8212b4dS
File Name ccontains a.exe
File Name contains b.exe
File Mame contains c.exe

Figure 1 Current i10C at End of Step 4

6. Right Click on “OR” -> Add Logic -> Select “AND”
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Add item ’ _¥tdaa??3343c256321
Add Logic > AND
;—-zrﬂt—ﬂw TTUTIUEINYTUTY
;- File Name contains c.e OR

7. Right Click on 1*' “AND” -> Add Logic -> Select “OR”

--OR
File
File
File
File

MDS i= c4b0458c043kdaa773348¢c26¢858212p1
Name contains a.exe
Name contzins b.exe

Mame contains c.exe

=] Add Item » l
Add Logic |

e e e e |
| It

| Change Logic

AND
OR |

8. Right Click on 2™ “OR” -> Add Item -> File Item -> File Size -> Type “9216"

Tiie STIings CoOntaina Nl — -
on] | Fileltem > :
Add Item 4 FormHistoryltem v
! Add Logic 4 Hiveltem y |
i Change Logic b Hookltem -
Y lel
Delete loduleltem »
MNetwork »
Prune

File Shalsum

File ShaESosum

File Size

File Stream Shalsum e
File Stream Sha256sum

File Detected Characteristics

File Detected Signatures

9. Right Click on 2" “OR” -> Add Item -> File Item -> File Size -> Type “9245”

10. CHECK YOUR WORK -> YOUR 10C SHOULD NOW LOOK LIKE THIS

UR
----- File Name contains a.exe
File Name contains b.exe
i~ File Name contains c.exe
©- AND

OR

.....

-File Size is 9216
File Size ias 924%S

B
.....

~File MDS is c¢4b0458c04abdaa773348c2668212b4S

Figure 2 Current 10C at End of Step 9
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11. Right Click on 1** “AND” -> Add Logic -> Select “OR”

3 OR

File MDS i3 c4b0458c04a3bdaaT73348c2658212bY
File MName contains a.exe
File Wame containg b.exe
File Name containg c.exe

LI

Add Item |

i
Add Logic » AND
Change Logic 4 OR

12. Right Click on 3rd “OR” -> Add Item -> File Item -> File Compile Time -> Type “2011-10-
13T04:19:532"

rile Strings contalins o
on! | Fileltem » File Certificate Subject

Add item b FormHistoryltem » File Changed Time

Add Legic ’ Hiveltem > File Compile Time

Change Logic » Hookitem » File Created Time
Moduleltem » File Detected Anomalies

Delete

| MNetwork » File Detected Characteristics

Prune

~on File Detected Signatures

13. Right Click on 3rd “OR” -> Add Item -> File item -> File Compile Time -> Type “2011-10-
19T02:39:122"

14. CHECK YOUR WORK -> YOUR 10C SHOULD NOW LOOK LIKE THIS
&=-0R
§ File MDS is cibi458c04abdaa773348¢c2688212b45
g-u‘?ile Name contains a.exe
§~~-Fi1e Name contains b.exe
i~ File Name contains c.exe
- aND
=
| l-File Size is 9216
i +-File Size is 324§
B-OR
{ l-File Compile Time is 2011-10-13T04:18:532
- ¥File Compile Time is 2011-10-19T02:39:122
Figure 3 Current 10C at End of Step 13

15. Right Click on 1% “AND” -> Add Logic -> Select “AND”

16. Right Click on 2nd “AND” -> Add Item -> File Item -> File Full Path -> Type “\temp\”
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File Size is 9245

file Cempile Time ia 2-31:
File Compile Time is 20]

Add ltem »
Add Logic -
j Change Logic » |

|
|

Fileltem v
FormHistaryltem L
Hiveltem ’ |
Hookitem »
Moduleltem ’
Network >

File Filename Modified
File Full Path

File Import Function
File Import Name

File INed=

File MD5

File Modified Time

17. Right Click on 2nd “AND” -> Add Item -> File Item -> File Strings -> Type “httppump”

i File Size is 9245

CR

AND

.- File Size is
‘.File Size is

File Ccmpile
File Ccmpile

File Name contains b.exe
le Name contains c.exe

S21¢
9245

& on Fileftern b File Shalsum
' File Compile Time is 20] FormHistoryltem » | File Shal5ésum
;‘;I F’ile_Cem;_;ile Time fs iOJI Livetbars > | File Size
~ Additem Al Hookitem » | File Stream Shatsum
Add Logic L Moduleltem ’ i File Stream Sha256sum
Change Logic » Network ’ : File Strings
-1~ OR

File MDS is c4b0458c0dabdaa773348cZ2668212b45S
File Name contains a.exe

Time is 2011-10~-13T04:19:532
Time is 2011-10-13T04:18:532

File Full Path contains \temp\

18. Right Click on 2nd “AND” -> Add ltem -> Registryltem -> Registry Key Path -> Type

“\CurrentControlSet\Services\Netman\domain”
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THUVEILErT L3
- AND
File Full Path contains \temp) Hookitem »
File Stringa cencaina hotppump Moduieltem »
"f-nln ..—:‘:' __“ y Fath .--.- w-:-: -"_":' LU rent . of
Add item > Network > |
Add Logic » Portitem > Detected Anomaly
Add Ancther Prefetchitem » Registry Hive
Processitern » Registry Key Modified Date
Change Term » - -
9 Registryltem > Registry Key Path

Ch!nge Conition ’ BeytaEateltam b Bamjetr: MumsSihKe o

19. Congrats!! You are now complete with your first |OC that you have added.
It should look like this in the end.

& OR

& aND

= OR
i~ File
File

= OR
File
i File
File
File

-File MDS is c4bl458c043bdaa773348¢c2€€68212b45%
:-File Name contains a.exe

File Name ceontains b.exe
- -File Name contains c.exe

Size is 921¢
Size ig 9245

Compile Time is 2011-10-13T04:18:5832
Compile Time is Z011-10-13T54:15:532

Full Path contains \temph
Strings contains httppump

Regizzry Key Path ceontains \CurzentControlSet\Services\Netman\domain

Figure 4 Current iOC at End of Step 11
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Exercise Takeaways

Building a good 10C is sometimes very tedious, but an analyst that is armed with a decent I0C list is extremely

powerful. There are many indicator languages out there including STIX, YARA, and OpenlOC. Threat indicators
and management is extremely powerful during incident response.

Both Redline and Volatility have OpenlOC support built into their capabilities. And using capabilities such as
the Live Analysis with Redline, it is feasible to scan a single target with both host and process based indicators.

In the end, understanding how an indicator can be built and how it can be used to look for malware variants is
important for incident response and hunting in the world today. The best information your malware analysis
team can provide is a decent threat indicator for the host and the network scanning teams. Learning the
basics of how to build a single signature is useful.

The more you discover and the more you can add will help make your threat indicator scanning much more
useful and practical.
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Exercise 4A - Conference/Onsite Version

Description

This version of the lab is intended to demonstrate the capabilities of remote forensic and incident response
analysis by connecting to a system that the instructor has set up. This typically would be in classes where we
are live and have limited access to additional systems for this exercise.

When you get back to your own lab, work/home network, or if you are attending the class via On-Demand,
vLive, or Simulcast remotely, please accomplish Exercise 4B.

In Exercise 4B, you will not only configure the Enterprise License server, you will also create your own agent,
deploy it in your network, and connect to another host in your environment. Not only is it a bit more complex,
it usually takes about twice as long to complete. In a classroom environment, we will demonstrate remote

forensics by having the students connect to a preexisting deployed agent scenario to demonstrate the
features of remote incident response.

If attending in a live conference or onsite course, the instructor will set up a demonstration system (or two) to
have you connect to. Please obtain that IP address from the instructor.

If you are an On-Demand, vLive, or Simulcast student, please accomplish Exercise 4B.

IExercise Preparation

Receive any IP Addresses from your instructor that you can connect to:

IP ADDRESS:

|Objectives |

o Connect/Disconnect to remote system hard drives and memory using the SIFT workstation

|Exercise — Install and Configure F-Response Enterprise |

1. Start your SIFT VMware Workstation in VMware

2. login the SIFT VMware machine.
» LOGIN = sansforensics
» PASSWORD = forensics

3. IMPORTANT!! Open a terminal inside the SIFT workstation and make sure you are a root user by
running the command sudo su -
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$ sudo su -

Exercise — USE SIFT Workstation to connect to remote system(s) you have deployed the agent to and started the
service

1. Switch to your SIFT Workstation

2. login to see the available nodes (note in this EXAMPLE, we are using the server IP which on my system is
192.168.112.1, but on your system, this should match the IP address that your instructor provided to
you.) IP_ADDRESS = Instructor Provided IP address

$ sudo su -

# f-response-accel-lin -n sansforensics -p forensicsl234 -s IP ADDRESS

root@siftworkstation: /# f-response-accel-lin -n sansforensics -p forensicsi234 -s 192.168.112.1
F-Response Acclerator - Linux Version 5.9.3

F-Response Acclerator for tinux requires Open-iSCSI.

Checking for Open-t15CSI utils now..

PDpen-15CSI {iscsiadm) feund.

Connecting to F-Response Target 192.168.112.1:3260...

Discovery Results.
F-Response Target = ign.2008-02.com.f-response. jotumheim:disk-0
F-Response Target = 1qn,2008-62.com.f-response.jotumheim:vol-¢
F-Response Target = iqn.2008-92.com.f-response.jotumheim: pmem
Populating Open-iSCSI with node details..

Node information complete, adding authentication details.

3. Login to Remote Hard Drive Target - Usually Disk-0. Note in the above example, my system name was
jotumheim. The exact name of the system you are logging into will change for each system you are
logging into. Please note that it is a lowercase “L” in the £-response-accel-1lin command.

oot@siftworkstation:/# f-response-accel-lin -1 iqn.2008-02.com.f-rasponse. joturheim:disk-0

-Response Acclerator - Linux Versien 5.9.3

-Response Acclerator for Linux requires Open-iSCSI.

ogging in to [iface: default, target: iqn.2008-02.con.f-response.jotumheim:disk-0, portal: 192.168.112.1,3260]

ogin to [iface: default, target: ign.2008-02.com.f-response.jotumhsim:disk-0, portal: 192.168.112.1,3260]: successful
QN: iqn. 2008-02.con. f-response. jotunhein:disk-0 attached as /dev/sd: <
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4. Run fdisk -l and examine output locating new drive that is attached at /dev/sdc

# fdisk -1

Disk /dev/sdg: 214.7 GB, 214748364800 bytes

255 heads, 63 sectors/ftrack, 26108 cylinders, total 419430400 sectors
Units = sectofs of 1 * 512 = 512 bytes

Sector size (lpgical/physical): 512 bytes / 512 bytes

I1/0 size (minikun/optimal): 512 bytes / 512 bytes

pisk identifierg ©x47856f08

Device Boot

Start End Blocks Id System
/dev/fsdc1l  *

2048 419428351 209713152 7 HPFS/NTFS/exFAT

5. Mount larger partition viz},the SIFT Workstation using the mount command. (Note: /dev/sdc2 is what
it is on the example, your 'a.ctual results will vary depending on your system). You can determine the
largest partition by examinmg the partition with the largest number of blocks. Also, usually on Win7 and
later systems the 2" partitic‘rp is the C:\ of the system

# imageMounter.py /dev/sdc /mnt/windows_mount2

root@siftworkstation: /home/sansforensics# imageMounter.py /dev/sdc /mnt/windows |
mount2/
[+] Creating Temp Mount Point at /mnt/windows_mount2/@
[+] Attempting to Mount Partition @ at /mnt/windows_mount2/0
[ -] Mounted /dev/sdc at /mnt/windcws_mount2/6
[-1 To unmount run 'sudo umount /mpt/windows_mount2/6’

6. Change Directories to the /mnt/windows_mount2 directory and examine files. You should now be able
to see the files from the remote system with the F-Response Agent installed. Below is a generic example.

# cd /mnt/windows_mount2 /0

# 1ls

root@stftworkstation: /home/sansforensics# cd /mnt/windows_mount2/6/
root@siftworkstation:/mnt/windows_mount2/0# 1s

_ SSecure




7. Change Directories to the windows/System32/config directory and extract the registry
contents of the SAM and SYSTEM hives. Please note that due to “lowexr/upper
case conversions’’ your exact directory path might vary on your own system.
You might need to use “tab complete” to help you complete the directory path.

# cd /mnt/windows mount2/0
# cd Windows/System32/config
# rip.pl -r SAM -f sam > /cases/sam.txt

# less /cases/sam.txt

root@siftworkstation:/mnt/windows_mount2/1# cd Windows/System32/config/

root@siftworkstation: /mnt/windows_mount2/1/Windows/System32/config# rip.pl -r SAM -f sam > /cases
/san.txt

Parsed Plugins file.

Launching samparse v.20120722

samparse complete,

root@sifiworkstation: /mnt/windows_mount2/1/Windows/System32/config# less sam.txt

# rip.pl —-r SYSTEM -f system > /cases/system.txt

# less /cases/system.txt
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[Exercise - Attach Remote Memory and Perform Memory Acquisition

1. Login to Appropriate Target - Usually PMEM. Please note that it is a lowercase “L” in the f-response-
accel-lin command. ??7??7? = your target system name.

Example (Memory) = ign.2008-02.com.f-response.?????:pmem

# f-response-accel-lin -1 ign.2008-02.com.f-response.??2?2?2?%?? :pmem

oot@siftworkstation: /# f-response-accel-lin -1 1qn.2008-02.com. f-response.jotumheim: pmem

-Response Acclerator - Linux Version 5.0.3

-Response Acclerator for Linux requires Open-iSCSI.

ogging in to [iface: default, target: iqn.2008-02.con.f-response.jotumheim:pmem, portal: 192.168.112.1,3260]

ogin to [iface: default, target: iqn.2008-02.com.f-response.joturheim:pmem, portal: 192.168.112.1,3266]: successful
IQN:iqn.2008-02.com. f-response. jotumheim:pmem attached as /dev/sdc,

2. Run fdisk -l and examine output locating the memory imagey
a. ltshould not show a valid partition table at /dev/sdd

# fdisk -1

isk /dev/sdd: 9636 MB, 9636413440 bytes

64 heads, 32 sectors/track, 1148 cylinders, total 2352640 sectors
nits = sectors of 1 * 4096 = 4096 bytes

Sector size (logical/physical): 4096 bytes / 4@96 bytes

1/0 size (minimum/optimal): 4096 bytes / 4096 bytes

isk identifier: 0OxQ0000600

isk /dev/sdd doesn't contain a valid partition table

In the next section we will learn how to use Volatility and Redline during memory analysis.

Exercise — Detach Remote F-Response Targets

1. Detach the remote target system memory and hard drives.
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# f-response-accel-lin -u ign.2008-02.com.f-response

.22727272727277 . pmem

# cd /
# umount /mnt/windows mount2/0

# f-response-accel-lin -—u ign.2008-02.com.f-response

For508 - SANS ©2015 Exercise 4A Conference/Onsite Version




Exercise Takeaways

Being able to connect to 100s of system in your environment to perform incident response is critical. Using a
deployable agent via group policy will allow you to connect to almost any IP address in your environment.

The next step is analysis and then making it automated -- using a script to connect and pull specific data from
100s of systems in your enterprise.

The days of pulling a hard drive each time you want to analyze a system are over. The time to be able to
perform remote analysis is here and using tools such as F-Response, Mandiant MIR, Encase Enterprise, and
many others gives the ability to scale from a single system to thousands.
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Exercise 4B - Enterprise Forensics

(OnDemand/vLive/Simulcast) Version

Description

This version of the lab is intended to demonstrate the capabilities of remote forensic and incident response
analysis by connecting to a system that the instructor and faculty has set up. This typically would be in classes
where we are live and have limited access to additional systems for the setup. This exercise will not only show
you how to connect to remote systems, but how to set up, configure and deploy F-Response Agents on your
own networks.

In this exercise you will not only configure the F-Response-Enterprise License server, you will also create your
own agent, deploy it in your network, and connect to another host in your environment.

Please note — this follow on exercise is meant to be completed on your own networks and not in live
classroom environments such as SANS conferences or Onsites. To demonstrate F-Response, the instructor will
set up a system for students to connect to. If attending in a live conference or onsite course, the instructor will
set up a demonstration system (or two) to have you connect to and please follow Exercise 4A. Please obtain
that IP address from the instructor.

If you are an On-Demand, vLive, or Simulcast student, please continue Exercise 4B.

PLEASE NOTE - If you are having trouble with the F-Response Enterprise Lab Setup, there is a
troubleshooting guide at the end of this exercise.

Objectives 4]

o Install and configure an enterprise incident response and forensics capability

e Create a deployable agent

e Deploy agents on to target systems in your environment

e  Connect/Disconnect to remote system hard drives and memory using the SIFT workstation

Exercise — Install and Configure F-Response Enterprise

1. Start your SIFT VMware Workstation in VMware

2. Login the SIFT VMware machine.
» LOGIN = sansforensics
» PASSWORD = forensics

3. Open aterminal inside the SIFT workstation and make sure you are a root user by running the
command sudo su -
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$ sudo su -

4, SIFT WORKSTATION: Check IP Address of SIFT Workstation using “ifconfig”

$ ifconfig

Note you are looking for output similar to the following where the IP address of the example system is
192.168.112.138.

sansforensics@siftuworkstation:~$ ifconfig

etho Link encap:Ethernet HWadde ©0:8c:29:61:54:dfF

anet addr:192.168.112,138 Bcast:192.168.112.255 MHask:255.255.255.8
inets addr: feB9::20¢:29ff:fe61:54dF/64 Scope:link

UP BROADCAST RUNNING MULTICAST MTU:1580 Metric:i

RX packets:838 errors:0 dropped:0 overruns:® frame:@

TX packefs:2503 errors:© dropped:@ overruns: carrier:6
collisions:@ txgueuelen:19@o

RX bytes:562459 (562.4 KB) TX bytes:244357 (244.3 KB)

Read the “inet addz” of your output and write down the IP Address of your SIFT workstation.

SIFT IP ADDRESS =

5. Locate and insert your F-Response Enterprise Dongle into your Windows System

6. Windows System: Turn off your windows system firewall or open up ports on your enterprise
network to allow for the following ports to communicate over TCP (Control Panel -> System and
Security -> Windows Firewall -> Turn Firewall On or Off)

1. 3260 —This is the main port F-Response uses to communicate with the target machine’s
resources (iSCSI TCP).

2. 5681 —This port is used to communicate with the F-Response Licensing Manager. (TCP is used for
most editions of F-Response, UDP is used for F-Response Tactical Edition).

7. Insert your COURSE USB with DFiR on the side into your Windows System
) Nawgateto‘wmz“; nmzx}}‘x - v 5
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8. Install “F-Response Enterprise” software (F-ResponseEnterprise.exe)on your

Windows System. All steps require you to simply select “Next” and Finally “Install” and
“Finish”

157 Setup - F-Response Enterprise Edition —— & s

Welcome to the F-Response
Enterprise Edition Setup Wizard
Thank you for purchasing F-Respanse Enterpnse Edition
Please remember, the most curent version of F-Respanse
Enterprise Edition is abvays avarlable online at

wwy f-response com

This selup application wilt instalt F-Response Enterpnse Edition
on your computer i

Itis recommenxded that you close all ether applications bsfore
continuing.

Click Next to continue, or Cancel to ext Setup

“ Next > Cancel

154 Setup - F-Response Enterprise Edition ~ — ™ 3]

Lticense Agreement
Please read the following important infarmation before continuing

Please read the followng License Agreement You must accept the temms of this
agreement before continuing with the instaltation

IAGILE RISK MANAGEMENT LLC MASTER SOF TWARE LICENSE AGREEMENT A
TERMS AND CONDITIONS

} Scope of Agreement, Definitions. This Agreement covers the hcense and
permitied use of the Agile Risk Management LLC ("Agle”} F-Response Soflware
Uniess otherwse defined in this seclion, the capritalized terms used n this
Agreement shall be defined in the conext in which they are used  The followang
terms shall have the following meanincs

11 “Agile Softwase” or “Software” means any and all versions of Agife’s F-
Response software.
12 ‘Customer” means the person or entdy identfied on the invaice and anly v

*o I azcapt the agreement

I do not accept the agreement

hmﬂ > Cancel
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i3 Setup - F-Response Enterprise Edition ~ — =

Where should F-Respanse Enierprise Edition be installed?

J,  Setup wilinstal F-Response Enterprise Editioninto the following foider.

To continue, click Next. [ you would like to select a different folder, ciick Browse.

Browse
Atleast 18.8 MB of free disk space is required.
< Back Next > Cancel
i) Setup - F-Response Enterprise Edition = fL= n

Select Start Menu Folder
Where should Setup place the program’s shottcuts?

b Setupwill create the program's shorcuts in the ‘oliowing Start Menu folder.

To continue, click Next. If you would kke to select a differsnt folder, click Browse.

Browse. .

< Back Nexl » Cancel
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s Setup - F-Respanse Enterprise Edition - B “ _

Ready to Install 7
Setup is now ready to oegin instaling F-Response Enterprise Edition on your

compuler

Click |astafl tc continue with the installzlion, or dlick Back if you want o review or change
any setings

Destination locatior
C:Program FilesiF-Response

Start Menu folder
F-Response Enlerprise Edition

N\

< Back Instail Cancel

(P Setup - F-Response Enterprise Edition =

Completing the F-Response
Enterprise Edition Setup Wizard

Setup has finished instaling F-Response Enterprise Edition on
your computer.

Don't forcet to insert your F-Response License dongle before
instaling and starting the F-Response License Manager Server

Iiy addiion, F-Response requires the Micrasoft iSCS1 Inthalor
(Windows XP), if you have niot already installed the Microsoft
ISCS1 Initator and are using Windaows XP please use the link
below Windows Vista, 2068, and 7 users already have iI5CS1
installed and will see noink U S Pat No. 7,899 822 8,171 108

Click Finigh to exit Setup

Finuish
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Exercise — Set up the F-Response Enterprise License Manager

1. Insert F-Response Enterprise Dongle into a Windows operating system. The F-Response Enterprise
software you just installed allows you to create remote agents. It will also serve as your license manager
for remote workstations connecting to other system targets in your environment.

2. Launch LICENSE MANAGER MONITOR

F-Response Enterprise Edition
f3 F-Response Accelerator

s F-Response Cloud Connector
) F-Response Database Object Connec |
& F-Response Email Connector |
Q_F-l{es_;mnse Enterprise Management
*- F—Response License Manager Monitor ]
|f“‘} Uninstall F-Response Enterprise Edith
#3 Update F-Response Dongle y

3. Install F-Response LM Service and check “Set to Auto Start”

/3 F-Response License Manager Mo... — =/ n

License Manager Configuration
P Address: [ 192,169, 1.43 J

e Port:l 631

License Manager Control

* Instal i Install F-Response LM Service

- [V Set to Auto Start?

‘ I Start F-Response LM Service

Stop FResporse LM Service

I Uninstall F-Response LM Service

oK
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4. From the “IP Address:” dropdown select the IP Address that matches the same subnet of your SIFT
Workstation IP Address documented in step #4 during your Exercise Preparation above. NOTE: In the
example listed here, our SIFT IP Address was “192.168.112.138” thus the IP Address of the License
Manager will need to be on the same subnet “192.168.112.1".

/7 F-Response License Manager Mo... — & n |

License Managsr Configuration
IP Address: m":g‘mn B

Tce Port -9’ 1°3 14
'9‘* 163 29 1
License Manager Control

Install F-Response LM Service
F setro puts Start? |

l;; Start ] Start F-Response LM Service
= | Stop F-Response LM Service

Uninstall F-Response LM Service |

5. Startthe “F-Response LM Service” and select “OK”

/3 F-Response License Manager Mo... — &

License Manager Conﬁqwanm
IP Address: [ |

P Pnrt.] 5

License Manager Control
Irstel Instak F-Respanse LM Service

¥ sst to Auto Start?
Start F-Response LM Service

Stop F-Response LM Service

Uninstall F-Response LM Service

oK |
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Exercise — Create a Deployable Remote Forensic Agent

1. launch F-Response Enterprise Management Console

Dl 20 AN AR
/3 F-Response Accelerator
. F-Response Cloud Connector I
ﬁ F-Response Database Object Connec | et
g F-Response Email Connector - _
ﬁiiri -Response Enterprise Iu‘:.-.r..:;;errﬁenvt Console I
£ l£~R.es;ﬁotwse Licens-e-Manager Monite
[@ Uninstall F-Response Enterprise £dith
f@ Update F-Respanse Dongle

v B

Fi F-Response® Enterprise Management Console

File Scan Deployment Connect Active Chents Help

2. SelectFile -> Configure Options

# F-Response® Enterprise Management Console

File Scan Deployment Connect Active Clients Help
Configure Credentials...

Clear Messages
Exit
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Deployment Options Configure

F-Response Configuration
License Manager Configuration Host Configuration

Encryption [ | i
Padd 192 168 . 112 . 1 Physical Memory V| ,
TCPPort 5681 Flexdisk™ |_| Port 3251 '

TCP Port | 3260
Usarname  sansforensics

Pascyord 'sesscessseee

F-Response Windows Service Install Configuration |
Service Name F-Response Agent Service
Service Descaipton | F-Response Enterprise Agent Service|

Executable C:'\Program Files\F-Response \F-Respor Browse

Linix Platform Spedfic Deployment Options !

Platform V. Reset Current Reset Al .
Pre and Post Exec{Optional) i
PreStart | |

Poststop [ |

Additional Targets |

You will need to configure the following:

e License Manager IP -> DO NOT CHANGE
e License Manager Port -> 5681 — DO NOT CHANGE
e  Host Configuration-> Physical Memory-> CHECKED

e Username ->

s  Password ->

e  Service Name ->
e  Service Desc->

e  Executable ->

Press Ok to save changes.

3. “SelectFile ->

sansforensics

forensicsl234

F-Response Agent Service

F-Response Enterprise Agent Service

C:\program files\f-response\f-response enterprise edition\f-response-ent.exe

Configure Options” again
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P
.
. | File Scan Deployment Connect Active Clents Help
Configure Credentials...
:
Clear Messages
Exit
B
L,

[ 4. Click the button at the bottom of the window to Export the deployable F-ResponseAgent.MSI. Once
. created, this .msi file can be distributed to thousands of systems in your environment.

1 ' -

L; Additional Targets |

b Export... | ExportMsl... |

orowse orFolder S

Export MSL...

=

= i Network

28 Librares

@ J8 mshannon

=1 {8 Computer
@ g Floppy Disk Drive (A:)
= £ Local Disk (C7)
8 0w Drive (D2)
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5. Deploy Agent(s) to systems you would like to examine remotely. We recommend another system on
your network or lab. You can also use your own host, but it doesn’t show the true capabilities of the
enterprise incident response capability. Launch the “fresponse .msi” program on your local system
by double clicking on it.

Typically, we would deploy the agent to other systems in our environment via Group Policy or the F-Response
Enterprise Management Console.

For this example, we are going to install the F-Response Agent Service on the same system we are using as the
license server. However, this could be any generic windows system in your entire enterprise.

Launch the “F-Response Agent.MSI” to install the service locally on your system

6. Startthe F-Response Agent Service using your command prompt

Launch an Administrator Command Prompt and use “sc” to start the service

Programs
B cmd.exe

B! CemDust Qpen

i *¢' Run as administrator h
Documents = |

lC:\NINOOHS\systemBZ)SC start "F-Response Agent Service” |

Your output should look similar to the following:

C i NHINDOHS\system3Z2ysc start "F-Response Agent Service”
BERYICE_NAME: F-Response Agent Service

TYPE : 190 HWIN32 OWN_PROCESS

STATE : 2 START_PENDING

) {NOT_STOPPABLE, NOT_PAUSABLE, IGNORES_SHUTDOWN)

WINZZ EXIT_CODE : 0 (2xBY

SERVIZE EXTT_CODE : @ (@xd}

CHECKPOTNT : Px0@

WAIT_HINT i Dx7d0

PID 1 2964

FLAGS :
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7. Write down the IP address of the system you deployed the AGENT to by typing “ipconfig”

AGENT IP ADDRESS =

In this example, we are likely only using VMNET8

8. OPTIONAL -> Using the Services GUI, start the “F-Response Agent Service”

Right click on “Your System” and Select Manage

Manageh

Pin to Start

Show on Desktop
Map network drive...

El Disconnect network drive...

&+ Computer Management (Local
s i} System Tools
& Task Scheduler
> {a] Event Viewer
> @) Shared Folders
> &% Local Users and Groups
« @) Performance
=% Device Manager
4 2 Starage
i=f Disk Management
4 75 Services and Applications
. Services!
;;'1; WM Control

File Action View Help
@ L o ol e Mmoo
- Services (Local) Name ’ Description  Status Startup Type  Leg On As
| L Family Safety This service ... Manual Local Senvice

L. Fax Enables you.. Manual Network S...
74, File Histary Service Protects use.. Manual (Trig... Local Syste...
S FLEXnet Licensing Service This service ... Manual Local Syste...
{4 FLEXnet Licensing Service 64 i Manual Local Syste...
" F-Response License Manager Service 1.12 Running  Manual Local Syste...
¢ Function Discovery Peovider Host The FOPHO.. Running Manual Local Service
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Right-click, choose Start
Start

S

All Tasks L4
Refresh

Properties

Help
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Exercise — USE SIFT Workstation to connect to remote system(s) you have deployed the agent to and started the
service

1. Switch to your SIFT Workstation

2. Login to see the available nodes (note in this EXAMPLE, we are using the server IP which on my system is
192.168.112.1, but on your system, this should match the IP address that you deployed the agent to.)

$ sudo su -

# f-response-accel-lin -n sansforensics -p forensicsl234 -s
192,168 .XXX.YYY

root@siftworkstation: /# f-response-accel-1in -n sansforensics -p forensicsi234 -s 192.168.112.1
-Response Acclerator - Linux Version 5.9.3

-Response Acclerator for Limux requires Open-iSCSI.

hecking for Open-iSCSI utils now..

pen-iSCSI {iscsiadm) found.

onnecting to F-Response Target 192.168.112.1:3260...

iscovery Results.
-Response Target

1gn.2008-02.com.f-response. jotumheim:disk-0
-Response Target = 1gn.2008-02.com.f-response. jotumheim:vol-c
-Response Target = 1gn.2008-02.com.f-response. jotumheim: pmem
opulating Open-iSCSI with node details..

ode information complete, adding authentication details.

W onn

3. Login to Remote Hard Drive Target - Usually Disk-0. Note in the above example, my system name was
jotumheim. The exact name of the system you are logging into will change for each system you are
logging into. Please note that it is a lowercase “L” in the £-response-accel-1in command.

cot@siftworkstation: /# f-response-accel-lin -1 1qn.2008-02.com. f-rasponse. joturheim:disk-0

-Response Acclerator - Linux Version 5.0.3

-Response Acclerator for Linux reguires Open-iSCSI.

ogging in to [iface: default, target: ign.2008-€2.conm.f-response, jotumheim:disk-0, portal: 192,168.112.1,3260]

ogin to [iface: default, target: iqn.2008-82.com.f-response,jotumhaim:disk-0, sortal: 192,168.112.1,3260): successful
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4. Run fdisk -l and examine output locating new drive that is attached at /dev/sdc

# fdisk -1

Disk /dev/sdg: 512.1 CB, 512110196592 bytes

P55 heads, 63,sectors/track, 62260 cylinders, total 1000215216 sectors
Units = sectofs of 1 * 512 = 512 bytes
Sector size (Togical/physical): 512 bytes / 512 bytes

I/C size (mini’qmm/optimal): 512 bytes / 512 bytes
Disk identifier: 0x9efg8684e

Device Boot % Start End Blocks Id System
/dev/sdcl * ': 2048 718847 358400 7  HPFS/NTFS/exFAT
/dev/sdc2 « 718848 1000212479 499746816 7 HPFS/NTFS/exFAT

Mount larger partition via E;he SIFT Workstation using the mount command. (Note: /dev/sdc2 is what
it is on the example, your agtual results will vary depending on your system). You can determine the

largest partition by examinil’!g the partition with the largest number of blocks. Also, usually on Win7 and
later systems the 2" partition is the C:\ of the system

h
# imageMounter.py /dev/sdc /mnt/windows_mount2

root@siftworkstation:/# imageMounter.py /dev/sdc /mnt/windows_mount2
[+] Creating Temp Mount Point at /mnt/windows_mount2/0

[+] Attempting to Mount Partition 0 at /mnt/windows_mount2/0
[-] Mounted /dev/sdc at /mnt/windows_mount2/0

[-1 To unmount run 'sudo umount /mnt/windows_mount2/0"

[+] Creating Temp Mount Point at /mnt/windows_mount2/1

[+] Attempting to Mount Partition 1 at /mnt/windows_mount2/1
[-]1 Mounted /dev/sdc at /mnt/windows_mount2/1

[-] To unmount run 'sudo umount /mnt/windows_mount2/1'

6.

Change Directories to the /mnt/windows_mount2 directory and examine files. You should now be able
to see the files from the remote system with the F-Response Agent installed.

# cd /mnt/windows_mount2/1

# 1s

root@siftworkstation:/# cd /mnt/windows_mount2/1/

ESD

e

Drivers MsOCache
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7. Change Directories to the Windows/System32/config directory and extract the registry

contents of the SAM and SYSTEM hives. Please note that due to “lower/uppexr
case conversions’” your exact directory path might vary on your own system.
You might need to use “tab complete” to help you complete the directory path.

# cd /mnt/windows_mount2/1
# cd Windows/System32/config
# rip.pl -r SAM -f sam > /cases/sam.txt

# less /cases/sam.txt

root@siftworkstation:/mnt/windows_mount2/1# cd Windows/System32/config/
root@siftworkstation:/mnt/windows_mount2/1/Windows/System32/config# rip.pl -r SAM -f sam > /caseg
/sam. txt

Parsed Plugins file.

Launching samparse v.20120722

samparse complete,

rogt@siftworkstation: /mnt/windows_mount2/1/Windows/System32/config# less sam.txt

# rip.pl -r SYSTEM -f system > /cases/system.txt

# less /cases/system.txt
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[Exercise - Attach Remote Memory and Perform Memory Acquisition

1. Login to Appropriate Target - Usually PMEM. Please note that it is a lowercase “L” in the f-response-
accel-1lin command. ????7?? = your target system name.

Example (Memory) = ign.2008-02.com.f-response.?????.pmem

oot@siftworkstation: /# f-response-accel-lin -1 iqn.2008-82.com.f-response. jotumheim:prem

-Response Acclerator - Linux Version 5.6.3

-Response Acclerator for Linux requires Dpen-iSCSI.

ogging in to [iface: default, target: iqn.2008-62.con.f-response.jotumheim:pmem, portai: 192.168.112.1,3260]

ogin to [iface: default, target: iqn.2088-82.com.f-response.joturheim:pmem, portal: 192.168.112,1,3266]: successful
[QN:igqn.2008-82.com. f-response, jotumheim:pmem attached as /dev/sdd,

2. Run fdisk -l and examine output locating the memory image.a
a. It should not show a valid partition table at /dev/sdd

# fdisk -1

Disk /dev/sdd: 9636 MB, 9636413440 bytes

64 heads, 32 sectors/track, 1148 cylinders, total 2352646 sectors
Units = sectors of 1 * 4096 = 4096 bytes

Sector size {logical/physical): 4096 bytes / 4096 bytes

1/0 size (minimum/optimal): 4096 bytes [/ 4096 bytes

Disk identifier: 8x00000006

Disk /dev/sdd doesn't contain a valid partition table
7;774._._'7 S —

3. Image Remote System Memory using dc3dd .

Example (Memory) = ign.2008-02.com.f-response.?????:pmem =‘/dev/sdd (note
on your system /dev/sdd could be different)

# dc3dd if=/dev/sdd of=/cases/remote-system-memory.img hash=md5
hlog=/cases/remote-system-memory.md5

Foot@siftworkstation: /# dc3dd if=/dev/sdd o'=/cases/remote-system-memory.img hash=nd5 hlog=fcases/remote-system-memory.mds

Hc3dd 7.1.614 started at 2014-05-23 17:00:48 +0100

rompiled options:

Fommand line: de3dd if=/dev/sdd of=/cases/remote-system-nemory.img hash=md5 hlog=/cases/remote-system-memory.md5
Hevice size: 2352646 sectors {probed)

sector size: 4696 bytes (probed}

B92626176 bytes {374 ¥) copied ( 4%), 10,8541 s, 37 M/s

In the next section we will learn how to use Volatility and Redline during memory analysis
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Exercise — Detach Remote F-Response Targets

1. Detach the remote target system memory and hard drives.

cd /

#*+ F*

umount /mnt/windows mount2/1

# umount /mnt/windows mount2/0

For508 - SANS ©2015 Exercise 4B — Enterprise Forensics (OnDemand/vLive/Simulcast@Home) 18



Troubleshooting F-Response Enterprise

If you are having any problems using F-Response Enterprise you might need to check this troubleshooting
guide.

1. F-Response Agent Service not starting correctly?

a. Ensure your F-Response Enterprise Dongle is inserted and you have started the F-Response
Enterprise License Manager

b. Check your firewall. The firewall should be disabled or allow TCP ports 3260 and 5681 through.

c. Check the configuration options set in Step 2 of “Creating a Remote Deployable Agent” portion
of this exercise above. Recreate the .msi file if necessary.

2. Misconfigured the F-ResponseAgent.MSI and need to reconfigure/reinstall it?

a. Right click on F-ResponseAgent.msi file and click “uninstall”

= 1l

“kﬁfkﬁfﬁ” install
Repair
- Uninstall

b. Launch an Administrator Level “command prompt” and type the following: sc delete “F-
Response Agent Service”

Programs
B cmd.exe
- Open
B! CmDust
“w Run as administrator
= Administrator: CAWindows\System32\cmd.exe

Microsoft Windows [Version 6.3.96001]
(¢) 2013 Microsoft Corpeoration. All rights reserved.

C:\WINDOWS\system32)sc delete “F-Response Agent Service™
[SC]1 DeleteService SUCCESS

c. Reboot your system before starting over and installing a new .MS| file.
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'Ererc;‘se Takeaways

Being able to connect to 100s of system in your environment to perform incident response is critical. Using a
deployable agent via group policy will allow you to connect to almost any IP address in your environment.

The next step is analysis and then making it automated -- using a script to connect and pull specific data from
100s of systems in your enterprise.

The days of pulling a hard drive each time you want to analyze a system are over. The time to be able to
perform remote analysis is here and using tools such as F-Response, Mandiant MIR, Encase Enterprise, and
many others gives the ability to scale from a single system to thousands.

For508 - SANS ©2015 Exercise 4B — Enterprise Forensics (OnDemand/vLive/Simulcast/@Home) 20



Exercise 5A — Autostart Persistence Analysis

IObjectives

e Examine output from autorunsc.exe
e  Attempt to initially identify any suspicious processes

lExercise —Is there a suspicious process in the Autostart Programs on 10.3.58.7?

On the 10.3.58.7 system the autorunsc. exe was executed during Live Response on the system

C:\> autorunsc.exe —-accepteula —a * -s -h —c > autoruns-xp-tdungan.csv

In order to speed up the examination process, your live response team went ahead and filtered the data for

you using the output from AutoRuns found on the next page in this exercise.

1. Removed “Verified” and Trusted programs from Microsoft, Apple, Google, McAfee, and Paragon.
2. Eliminated the following columns to make it easier to read initially
a. Publisher —only included untrusted, unknown, or blank programs

i. There are some examples of well-known trusted publishers also having their code
signing certificates stolen. While not impossible, it is extremely rare that malware will
be using a trusted certificate from Microsoft to sign their code.

b. Description — most were blank and most didn’t have an adequate description to help you

determine which one is likely malware
c. MD5, SHA1, SHA256

For this exercise:
1. Examine the autorunsc.exe output on the next page.
2. Attempt to determine the most likely candidate that is a suspicious process. "List specifically what is
wrong or odd about each suspicious process {you may not need all of the blank lines provided)

a. N AR s T ey chilans
b.
c.
d.

3. Please note — answers will be provided in the next exercise — please do not work ahead.
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Category Image Path Launch String
HKLM\System\CurrentControlSet\Services Frespanse Services  c:\windows\system32\f-response-ent.exe f-response-ent.exe
HELM\System\CurrentControlSet\Services Changer Drivers File not found: CAWINDOWS\System32\Drivers\Changer.sys Changer
HKLM\ Gy stern\CurrentControlSet\Services iZormgmt Drivers File not found: CYMINDOWS\System32\Drivers\izomgm.sys  iZomgmt
HKLM\System\CutrentControiSet\Sevices Ibrifdc Drivers  File not found: CAWINDOWS\Systern32\Drivers\ibriide.sys frtfde
HKLM\System\CurrentCantrolSet\Services mfeavfk0l Drivers File not found: C:A\WINDOWS\System32\Drivers\mfeavfkOl.sys mfeavikol
HELM\System\CureentControlset\Services mfefirekGL  Orivers File not found: C:A\WINDOWS\System32\Drivers\rafefirek0l.sys  mfefirekol
HKLM\System\CurrentControlSet\Services Mnemosyne Orivers  c:\windows\system32\mnamosynei3s6.sys \?ACAWINDOWS\system32\Mnemasynei386.5ys
HKLM\System\CurrentContralSet\Services PCIDLMp Drivars  File not faund: C:RYWINDOWS\System32iDrivers\PCIDump.sys  PCIDump
HKLM\System\CurrentContrelSet\Services PDCOMP Drivers File not found: C:\WINDOWS\System32\Drivers\PDCOMP.sys  PDCOMP
HKIM\System\CuerentControlSet\Services PDFRAME Drivers Fite not found: C;AWINDOWS\System32\DriversiPDFRAME.sys  PDFRAME
HKLM\System\CurrentControlSet\Services PDRELI Drivers File not found: C:\WINDOWS\System32\Drivers\PORELI.sys PDREL)
HXLM\System\CurrentControlSet\Services PDRFRAME  Drivers File not found: CAWINDOWS System32\Drivers\PDRFRAME.sys PORFRAME
HKiM\System\CurrentControlSet\Services vmscsi Drivers  ¢\windows\system32\drivers\vmscsi.sys System32\DRIVERS\vmscsi.sys
HKM\Systerm\CurrentContivi$et\Services WDICA Drivers Fite nol found: CAWINDOWS Systern32\Oriver S\ WOICA. sys WEOICA
HKLM\SYSTEM\CurrentControlSet\Control\Print\Monitors ThinPrint Print c\windows\system32\tpvmmon.dll TPVYMMan.dlf
HKLM ' System\CurrentCortrolSet\Services\WinSock2 12 Network  c\program liles\vmware\vsocklib.dlt C:\Program Files\VMware\vsockhb.dll
HKLM\System\CurrentControlSet\Services\WinSock2 13 Network  c\program files\vmware\vsacklib.dll C:\Program Files\VMware\vsacklib.di|
HXKLMASOFTWAREMicresoftiWindows\Currentyersion\Rurt QuickTime Logon c:hprogram fies\quicktime\gttask.exe “CAProgram Files\QuickTime\QT Task.exe" -atbootirme
HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Run svchost Logon c:\windows\system32\dllhost\svchost.exe c\windows\system32\dilhost\svchost.exe
HKLM\Software\Classes\ "\ShellEx\ContextMenuHandiers 7-2ip Explorec  c\program files\7-ziphT-zip.dli HECR\CLSIDA{23170F6%-40C1-2784- 1000-000100030060}
HKLM\Software\Classes\Directory\ContextMenuHandiers 7-2ip Explorer  c\program flles\7-zip\7-zip.dll HKCR\CLSID\{23170£69-40C1-278A- 1000-DO0100020000}
HXIM\Software\Classes\Directary\Shellex\Dragbroptandlers  7-Zip Explorer  c\program files\7-ziph\7-zig.dll HKCRUCLSID\{23170F59-40C 1-2 78 A- 1060000 100020000}
HKLM\Software\Classes\CLS10\{083863F 1-70DE-11d0- BDA0-00AC Media Codecs  c:\pragram files\movie maker\wmmfilt.dll HKCR\CLSID\[F689C580-F60F-379F-886D-A01D091 75673}
HKuM\Software\Classes\CLSID\{ 683863 F1-70DE-11d0-BD40-00AC ShotBoundary Codecs  c\program files\movie maker\wmmfilt.dil HKCR\CUSID\[FEAS70313- DCI-4F 10-91DF- CETEE25624CF} |
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Exercise Takeaways

Without additional information, unless you already know and understand Windows OS processes, it is fairly
difficult to identify suspicious processes via a variety of tool output. While having a big collection of output

from various incident response tools is nice, it is not very useful if you cannot quickly and easily identify
anomalies.

In the next section, we will do this exercise again, but this time we will cover some of the core Windows 0S
processes that you should be aware of. With this additional knowledge, doing this exercise again will make
easy work of identifying anomalies in the output of a tool such as autorunsc.exe.

Following this takeaway is a step by step guide in how to directly examine autorunsc.exe output via the csv file
that it outputs. We welcome you to examine the csv file directly as it is good practice, but for this exercise we
would prefer you quickly just look at the output provided.
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IOut-Of-CJass Exercise — How to Examine and Filter autoruns—-xp-tdungan.csv

1. Openthe autoruns-xp-tdugnan.csv file found on your USB under /xp-tdungan-
10.3.58.7/xp-tdungan-incident-response using Microsoft Excel — simply “double
clicking” autoruns-xp-tdungan.csv usually works

This PC » FORS508-USB (F:) » xp-tdungan-10.3.58.7 » xp-tdungan-incident-response

-
] Mame Cate modified Type Size
[x] autoruns-xp-tdungan.csv@ 7472012 3:01 PM blicrosoft Excel € 222 KB
xp_tdungan_live_audit.mans 24272514 4:08 PRY Mandiant Analysis.. 633002 KB

2. Select View -> Freeze Panes -> Freeze Top Row

VIEW ACROBAT
e O = M e BT C13 View Side by Side o
' | S Hide [ o
MNew Arrange Freeze ) . 7 Switch
Window  All Panes~ de i Ressl W Windows *

Ereeze Panes
Keep rows and columns visible while the rest of
the worksheet scrolls (based on current sefection).

Freeze Top Row
| - = Keep the top row visible white scrolling through 2
5t MD5S SHA the rest of the worksheet,

bck 23043¢91a24d3 ;:“;:( Freeze First Column 2a7t
n Keep the first column visible winle s¢ R k
43¢7974883d7 b pines smn visible while scrolling ‘814

through the rest of the werksheet.

Fa9a3daaZi 4325000 r LrLooa 184U FaR VUL LU LUUEU LD 7152 U e dSE

3. Hide Columns “SHA-1"” and “SHA-256"
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B I Yo A - “W BN
J v
SHA-1 SHA-2

h9{2d339527dc985beSac 318a61 -1 Lo, 39
1513d71239f992fe678a1:54cct T, Paste Options: |
71|43295¢3a78d9fefdedc 67¢95¢ T i1
00| ef5728c819fa66bfeS5E aSe13: -

33|27bd216140f9390492 49900: | WUic sl a
o0 8daf0f7cf979dfofe76.462¢9  Incert fd
52/164e9ce62bdca39a47 3c7cch Deélete 0
b4193e0bcAcsb0ge6e2113430Ffc 73
585e29256f3e47541a02 65d2a! __ ' 33
56 5d0b0222b0f37a85d6 8ag11( - Cormat Ll 9
191592be5153e92d5f39808259(  Column Width.. 32
24739115 . Hide 11
b7|58d6 7ec6f1928¢ . I

4. Select HOME Ribbon.

Home Insert Page Layd
% Cu Calibri
=3 Copy ~
zZ Uu-

. J Format Painter

Ciphoard v

5. Select all Cells "CTRL-A".

6. In Home Ribbon -> Sort and Filter — Filter and you will be ready to begin analysis.

autoSum + | A
. 1% i
] fiti - i

¥

iSort & (Find &
p Cear - ~ Filter = Selec ~

j} l Sort Smattest to Largast
&1 santtargest to Smaliest
3§ Custom Sort..

= Eiter
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IOut-Of-C!ass Exercise — Autorunsc Output Analysis

1.

There are some examples of well-known trusted publishers also having their code signing certificates stolen.
However, if you happen to discover a new one, especially a stolen certificate from Microsoft, Apple, Google, or
McAfee — this would be nationwide news and you should prepare for your 10 minutes of fame as you will be
heavily interviewed on how you discovered it. In a nutshell, initially eliminate well known trusted publishers
from your examination. While not impossible, it is extremely rare that malware will be using a trusted

certificate from Microsoft to sign their code.

a. Select Dropdown Filter next to “Publisher” and Unselect (Select All)

For508 - SANS ©2015

Initially — Filter out all signed and trusted (verified) startup locations from being viewed. Select
“Publisher” column and select only those publishers that we are not sure about. While this is by far a
perfect way of eliminating trusted publishers from being examiner, it is initially good enough.

E
ien

F
* Publisher

k«' (Select All)

. -] (Not veritied) Apple Inc.
[ (Not veritied) igor Paviov
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b. Select all publishers that are “Not Verified”

For508 - SANS ©2015

e "y

Text Filter: '

[ (Select Al
\v¥| (Not veritied) Apple inc.
(] {Not verified) igor Paviov
-[¢] (Mot veritied) Microsoft Corporation
v (Not verified) VMware, inc.
- [} (Verified) Adobe Systems, Incorporated
o [} veritied) Agile Risk Management LLC
[ (Veritied) Apple Inc.
= [T verified) Google Inc
- [ veritied) Mcatee, Inc.
o [} fverified) Microsoft Corporation
© 3 verified) Microsoft Windows
¢ [} (Veritied) Microsoft Windows Cemponent Publ
- O everitied) Microsoft Windows Hardware Compa
~ {3 (veritied) Paragon Software GmbH
© [l veritied) Sur Micrasystems, Inc.
~ 1 Vesified) ThinPrint GmbH
[ verified) VMware, Inc.
{73 (8lanks)

oK - Cancel
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c. Before you select “Ok”, also select any publishers not immediately recognized as a core
y

software publisher (e.g. something you might need to “google search” to verify they are a real
company)

Al SortAtoZ
Zl SetZtoa
Sort by Colar

¥, Clesr Eites From Fabhonss

fepr tr & Aln
Friter &y folos

Text Filters

- ] (Select Al

-4 (Not verified] Apple inc.

i-[7 (Mot verified) igor Paviov

§ -7 {Not verified) Microsoft Corporation

L4 (Not verifiad) VMware, inc.

Eg:_] (Verfied) Adobe Systems, incorporated

§@ (Veritied) Agile Risk Mamagement LLC h
[ (Verified) Apple Inc.

{0 (verified) Googie In¢

$-L] (Veritied) McAfes, inc.

--£_1(Veritied} Microsoft Corporation

{7 (Verified) Microsoft Windows

-7 verified) Microsoft Windows Component Publisher

-] (Verified) Microsoft Windows Hardware Compatibility Publisher
~{] (Verified) Paragon Software GmbH

-1 (Veritiedi Sun Microsystems, |

- (Verified) ThinPrint GmbH b '
- (veritied) VMware, Inc.
{1 Btanks)
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d. Before you select “Ok”, also select “blanks”
8] SotAtoZ
(2] SortZtoA

S
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Sot by Color

Clgar Fdter From Published
Fiter by Colos

Text Fiiters

earchn

o[} (Select Al

{4 ot verified) Apple inc.

{2 {Not verified) Igor Paviov

i-I7 (Not verified) Microsaft Corporation

L[/} (Not verified) VMware, Inc.

L{J{veritied) Adobe Systems, incorporated

- A (verified) Agiie Risk Management iLC

] (Veritied} Apple Inc.

[ (Veritied} Google Inc

-{] (veritied) McAfee, inc.

.-} (verified) Microsoft Corporation

-] Merified) Microsoft Windows

i1 (verified) Microsoft Windows Component Publisher
-] (verified) Microsoft Windows Hardware Compatibility Publistier
- (veritied) Paragon Software GmbiH

-1 (Veritied) Sun Microsystems, inc.

- 17 (Veritied) ThinPrint GmbH

%ﬂ{\.‘criﬁedj VMwarg, Inc.
- (Blanks) _

[ ok ]| concer |
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Exercise5B- Autostart Persistence Analysis

| Objectives |

° Examine output from autorunsc. exe

e  Attempt to initially identify any suspicious processes using the “What is Normal Poster?”

e  Using our understanding of core windows operating system processes and services, it is likely that any
malware that does not share characteristics with expected usage might be considered suspicious or
an anomaly.

LExercise —Is there a suspicious process in the Autostart Programs collected from 10.3.58.7?

On the 10.3.58.7 system the autorunsc. exe was executed during Live Response on the system

C:\> autorunsc.exe -accepteula —-a * -s -h —-c > autoruns-xp-tdungan.csv

In order to speed up the examination process, your live response team went ahead and filtered the data for
you using the output from AutoRuns found on the next page in this exercise.

1. Removed “Verified” and Trusted programs from Microsoft, Apple, Google, McAfee, and Paragon.
2. Eliminated the following columns to make it easier to read initially
a. Publisher —only included untrusted, unknown, or blank programs

i. There are some examples of well-known trusted publishers also having their code
signing certificates stolen. While not impossible, it is extremely rare that malware will
be using a trusted certificate from Microsoft to sign their code.

b. Description — most were blank and most didn’t have an adequate description to help you

determine which one is likely malware
c. MDS5, SHA1, SHA256

For this exercise:
1. Examine the autorunsc.exe output on the next page.
2. Look for processes identified by autoruns that are present on the “What is Normal” Poster. What is
the most likely candidate that is a suspicious process?
3. List specifically what is wrong with odd about the selected suspicious process.
a.

b
c.
d.
e
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C:\> autorunsc.exe -accepteula —a * -s -h -¢ > autoruns-xp-tdungan.csv

Entry Location Category Image Path Launch String
HKLM\System\CurrentContrelSes\Services Fresponse Services  c\windows\system32\f-response-ent.exe f-response-ent.exe

HK | M\System\CurrentControiSet\Services Changer brivers  Fie not found: CAWINDOWS\System32\DriversiChanger sys Changer

HKLM\System\CurrentControlSet\Services i2zomgmt Drivers  File not found: C:\WINDOWS\System32\Drivers\i2omgmt.sys  i2omgmt

HKLM\System\CurrentControlSet\Services lbrttdc Drivers  Fite not found: CAWINDOWS System32\Drivers\iorttdc.sys lprifde

HKLM\System\CurreniControlSet\Services mfeavfkol Drivers File not found: C:A\WINDOWS\System32\Drivers\mfeavfkOl.cys mfeavfkol

HKLMYSystem\CurreniCantrolSet\Services mfefirek01  Drivers File nat found: CAWINDOWS\System3\Briversimfefirek0l.oys  mfefirekl

HKLM\System\CurrentControlSet\Services Mnernosyne  Drivers c:\windows\system32\mnemosynei3s6.sys V?ACAWINDOWS\ system32\Mnemosyriei386.5ys
HELM\System\CurrentControlSat\Services LIbump Drivers fFile not found: CAWINDOWS\System3I2\Drivers\PLIDump.sys  PCibump

HKLM\System\CurrentControlSet\Services POCOMP Drivers Fite not found: C;\WINDOWS\System32\Drivers\PDCOMP.sys  PDCOMP

HKLM\System\CurrentControlSet\Services PDFRAME Drivers File not found; CAWINDOWS\Systema2\Drivers\PDFRAME.sys  PDFRAME

HKLM\System\CurrentControiSet\Services PDREL} Dnivers File not found: C:\WINDOWS\System32\Drivers\PDRELL.sys PDRELI

HKIM\System\CurrentCantrolSet\Services PDRFRAME Drivers File not found: C:YWINDOWS\System32\Driversi PDRFRAME,sys  PDRFRAME

HKLM\System\CurreniControlSet\Servites ¥msCcsi Orivers c:\windows\system32\drivers\vmscsi.sys System32\DRIVERS\vmscsi.sys
HKLM\System\CurrentControlSet\Services WDICA Drivers Fite not found: C:\WINDOWS\System32\Drivers\WOICA.sys WOICA
HKLM\SYSTEM\CurrentControiSet\Control\Print\Monitors ThinPrint Print c\windows\system32\tpvmmon.dl TPYMMon.dll

HX M\ System\CurrentControlSet\Services\Winsock2 2 Network — ciprogram fileshvmware\wsocklib.git C:\Program Files\YMware vsocklib.dil
HKLM\System\CurrentControlSet\Services\WinSock2 13 Network  c:\program files\vmware\vsocklib.dli C:\Progsam Files\VMwarevsocklib.dit
HKLM\SOFTWARE\Microsoft\Windows\CurrentVersicnkRun QuickTimne Logon c\program files\quicktime\gttask.exe "C\Program Fles\QuickTime\QTTask.exe” -atboottime
HKLM\SOFTWARE\Microsoft\Windows\Currentversion\Run svchost Logon c:\windows\system32\dilhost\svchost.exe c\windows\systemi2\dtlhost\svchost.exe
HKEM\Software\Classest *\ShellEx\ContexiMenuMandlars 7-Zip Explorer  chprogram files\7-zip\7-zip.dll HKCR\CLSIDN {238 70F 69-40C1-278A- 10G0-D00 100020000
HKLM\Software\Classes\Ditectory\ContextMenuHandlers 7-Zip Explorer  c:\program files\7-zip\7-zip.dlt HXCR\CLSID\ [23170F69-40C 1-278A- 1000-000100020000]
HXLM\SoTtware\Classes\Diretory\ShellexDraghropHandlers  7-Zip Explerer  c\program fles\7-zip\7-zip.dll HRCRVGLSIDN (231 70F69-40C1- 278A-10G0-000100020000)
HKUM\Software\Classes\CLSID\{083863F1-70DE-11d0-BD40-00A0 Media Codecs  c:\program files\movie maker\wmmfilt.dil HKCR\CLSIDY(FEBSC580- FEOF-479F-886D-A01D09175673)
HKLW\Software\Classes \CLSIDY{083863F1-70DE- 11d0-BD40-00AC ShotBoundary Codecs  ¢\program files\movie maker\wemmfilt.dl] HXCRACLSIDNFES8T0AD-DC92-4F10-51DE-CHTSE25624CF] |
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Exercise — Autorunsc Output Analysis Step-By-Step

Using the “What is Normal Poster?” to help us understand core windows processes, look at specifically
svchost.exe

svchost.exe

Image Path: %SystemRoot%\System32\svchost.exe
Parent Process: services.exe

Number of Instances: Five or more

User Account: Varies depending on svchost instance, though it typically will be Local System,
Network Service, or Local Service accounts. Instances running under any other account should be
investigated.

Start Time: Typically within seconds of boot time. However, services can be started after boot, which
might result in new instances of svchost.exe well after boot time.

Description: The generic host process for Windows Services. It is used for running service DLLs.
Windows will run multiple instances of svchost.exe, each using a unique “-k” parameter for grouping
similar services. Typical “-k” parameters include BTsvcs, DcomLaunch, RPCSS,
LocalServiceNetworkRestricted, netsvcs, LocalService, NetworkService, LocalServiceNoNetwork,
secsvcs, and LocalServiceAndNolmpersonation. Malware authors often take advantage of the
ubiquitous nature of svchost.exe and use it either directly or indirectly to hide their malware. They
use it directly by installing the malware as a service in a legitimate instance of svchost.exe.

Alternatively, they use it indirectly by trying to blend in with legitimate instances of svchost.exe,
either by slightly misspelling the name (e.g., scvhost.exe) or spelling it correctly but placing it in a
directory other than System32. Keep in mind that a legitimate svchost.exe should always run from
%SystemRoot%\System32, should have services.exe as its parent, and should host at least one
service. Also, on default installations of Windows 7, all service executables and all service DLLs are
signed bv Microsoft.

3. List specifically what is wrong with odd about the selected suspicious process.

C:\Windows\System32\dllhost\svchost.exe is the suspicious process

a. Image Path is C:\Windows\System32\dllhost. It should be C:\Windows\System32

b. Entry Location shows svchost.exe being referenced by
HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Run, but the poster identifies the
owning parent of svchost to be Services.exe (the Entry Location should be
HKLM\System\CurrentControlSet\Services)
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c. Since svchost.exe is present in a "Run" registry key, its start time will be when a user logs
onto the system, not at boot as identified on the poster

d. The Launch String (command line) should include a “-k” parameter with it as mentioned in
the poster Description field for svchost.exe.

e. The code is not signed by Microsoft (remember at the beginning of this exercise we listed
how the team pre-filtered the data, including removing any signed and verified programs
from Microsoft). Svchost.exe is a core windows process and should be signed and verified by
Microsoft similar to the one that exists in the C: \Windows\System32 folder.

Finding any one of these would be a good enough reason to look deeper at this suspicious process. If you
identified all of them from the output provided, you are a ninja!

fExercise Takeaways —|

In an intrusion case, spotting the difference between abnormal and normal is often the difference between

success and failure. Your mission is to quickly identify suspicious artifacts in order to verify potential
intrusions.

Even if you were able to identify the suspicious process in the first part of this exercise, it is likely you were not
able to identify all the parts of it that were anomalous.

Knowing what is normal on a Windows host helps cut through the noise to quickly locate potential malware

As a result of your examination of the autorunsc. exe output from the 10.3.58. 7 we have identified a
suspicious process called svchost that is in an incorrect directory ¢: \windows\ system32 that starts
automatically when a user logs into the system.

The last part of the exercise is intended for you to help facilitate memorization of a key windows process,

svchost.exe, and the properties that svchost . exe should exhibit on a windows operating system.

In the next section, we will begin memory analysis and attempt to identify if svchost is running and if it has

any indicators that might be even more suspicious.
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Optional Exercise, Exercise 6-

WMI, PowerShell and Kansa

Objectives

e  Review output from WMI commands
e  Use PowerShell to run individual Kansa modules
e  Optional: Enable PowerShell remoting on your system and execute Kansa

Exercise Preparation

1. Open an Administrator command prompt by right-clicking on the ecmd . exe icon (Windows 7) or right-
clicking on the Windows icon and selecting “Command Prompt (Admin)”.

Programs and Features ) B . .noand Prompt
Mobility Center Open
Power Options i () Run a5 admipistrator %
Event Viewer ) . :
O Pin to Taskbar
System ETK Imager )
N Unpin from Start Menu
Device Manager i
Network Connections & | totepad Remove from this list
Disk Managenment AD Registey Viewe Properties
Computer Management = ) )
Cormand Prompt @ fAozilla Firelex »
Command Prompt (Admin) [::i b
| 5 Detting Stared »
Task Manager * ’
Contrel Panel | @ Prefetch Paiser
File Explorer =
Search !' » ANl Programs
Run
r Shut down or sign out 4
Desktop
a7
Windows 8 Windows 7

2. Ensure your FOR508 USB drive is plugged in and change volumes to the one represented by the USB drive
(“F:” is assumed here, but your system may assign a different drive letter). Change directory to “SIFT-
Lab-Instal\Windows Tools”

C:\Windows\system 32> F:
F:\> ed “SIFT-Lab-Install\Windows Tools"”
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- s> /11t ator: Command Prompt -0

~

Microsoft Windows [Version 6.3.9600]
{c) 2013 Microsoft Corporation. All rights reserved.

C:\Hindows\system32)>F:
F:\>cd "\SIFT-Lab-Install\Windows Tools"
F:\SIFT-Lab-Install\Windows Tools)

For508 - SANS ©2015 Exercise 6 — WMI, PowerShell, and Kansa



|aercise — Questions with Step-by-Step

1. Live Collection with WMI
e Use notepad or another text editor to open the wmic_1lr local.cmd file from the “SIFT-
Lab_Instal\Windows Tools” folder on your FOR508 USB. Take a few minutes to read and get a
feel for the commands that are included in the script.

e Execute wmic_lr local.cmd. Youshould see the script run and output files will be
created in the same folder. Answer “no” to any questions for faster collection.

F:\SIFT-Lab-Install\Windows Tools> wmic_lr local.cmd

e You should have 15 or more new text files in the “Windows Tools” folder. Take five minutes to
review the output for some of the files with your favorite text editor.

~ disks _ |jobs patches | startup
 drivers . mappeddrives process | systeminfo

__environment_variables  netlegin services useraccounts

___groups __ network_config  shares username

2. Introducing PowerShell Scripts

e Type powershell in your command terminal to open Windows PowerShell.

F:\SIFT-Lab-Install\Windows Tools> powershell

Administeaton Windows PowerSheli - o HEM
A

F:\SIFT-Lab-Install\Windows Tools>powershell
Windows PowerShell
Copyright (C) 2013 Microsoft Corporation. All rights reserved.

PS F:\SIFT-Lab-Install\Windows Tools>

< >

For508 - SANS ©2015 Exercise 6 — WMI, PowerShell, and Kansa 3



* Change directory to “\SIFT-Lab_lInstall\Windows Tools\Kansa-master\Modules”, set your policy
to allow all PowerShell scripts to run, and remove any Zone.ldentifier alternate data streams
(using Unblock-File).

PS F:\SIFT-Lab-Install\Windows Tools> cd Kansa-master\Modules

PS F:\SIFT-Lab-Install\Windows Tools> Set-ExecutionPolicy
unrestricted

PS F:\SIFT-Lab-Install\Windows Tools> ls -r *.psl | Unblock-File

(Unblock-File is only available in PowerShell version 3+)

e Execute . \Process\Get-ProcsWMI.psl | Out-GridView and review the output.

PS F:\SIFT-Lab-Install\Windows Tools\Kansa-master\Modules>
- \Process\Get-ProcsWMI.psl | Out-GridView

& A\Process\Get-ProcsWMI.ps1 | Out-GridView - o B8
h ®
| Add criteria v |
| Caption | Commandline | CresionClassName | CreationDate

System ldle Process Win3d2_Process
System Win32_Process 20150302081008.1
sMss.exe Win32_Process 20150302081008.1
TsrIss.exe Win32_Process 20150302081013.8
winimt.exe wininit.exe Win32_Process 20150302081015.2.
csrss.exe Win32 _Process 20150302081015.2:
services.exe Win32_Process 20150302081015.5
lsass.exe CAWindowsisystem32\isass.exe Win32_Process 20150302081015.6.
winlogon.exe winlogan.exe Wind2 Process 20150302081015.9
svchost.exe CAWindows\system32\svchost.exe -k Dcomlaunch Win32_Process 20156302081016.4
curhost Are CAWindnweisvatem I N aur hnst.exe -k RPCSS Win3? Proacess 2615002081016 5

>

WMI provides a wealth of data about each process, and the PowerShell script nicely formats it
into a PowerShell object making it easy to view in the default outputter “Out-GridView”. Notice
that you can move columns and filter via the search form at the top of the dialog. In a real-
world investigation we would review data for suspicious processes. Close the viewer when you
are finished.

e Execute .\Disk\Get-TempDirListing.psl | Out-GridView and review the
output.
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PS F:\SIFT-Lab-Install\Windows Tools\Kansa-master\Modules>

.\Disk\Get-TempDirlListing.psl | Out-GridView

£y ADisk\Get-TempDirListing.ps1 | Out-GridView

| Add critena ¥ |

FuliName

C:S \Usezs\Ch;:: \AppOata‘ Locas\Temp‘\TCD ?baf tmp
CrUsers\ChadiappDataiiocaiTempi TCO260A 1 amp
ChUsersiChagiappDatailocantTempiTC 52839 1mp
CridserstChadiApplatailocal: TempiTCD2C 3 mp
CausersiChagiAppDatatlocaliTempi TCO3098 tmp
CiUsers\Chad\AappDatailocali TemptTID3 12E.tmp
CaUsers\ChadiAppDataitocanTempiTCO3
{AUsers\Chad\AppData\localiTemp\TCD313Dtmp

12 tmp

i Creatlc nTameUtc

12/2/2014 5:00:12 Y
272672015 8:26:24 PM
2:26/2015 8:26:24 PM
772272014 121702 AM
2/2572015 §:26:26 PN
111772014 7:31:22 PM
$11717/2013 73122 P
11/17/2014 73132 BM

LastAccessTimelite
12/2/2014 3:0C:12 PM
2/2b/3015 3:26:24 PM
272672015 2:36:24 PM
74222014 11702 AW
2/26/3019 8:26:26 PM
$171772014 7:31:22 PXY
11/17:2014 73122 B
11/177°2014 7:31:22 PM

- o IEN
@

LastWriteTimeUic
12/2/2014 5:00:12 PM
272672015 8:26:24 P\
2¢/26/2015 §:26:24 PM
772272014 117.02 AM
272672015 8:26:26 PM
1171772014 73122 80
/1772034 73122 PM
$1717/2074 723122 BM

This script is designed to gather information on files located in common “Temp” folders in
Windows. Since these locations are often abused by droppers and other malware, we would
review the output looking for unusual filenames. If you don’t often run Disk Cleanup, expect a
lot of files, many with strange names {which is one reason these folders are such a magnet for
malware). Creation timestamps can sometimes help identify anomalies, and later in the course
we will be putting data like this in context via Supertimelines, which make it easier to spot evil.

e Execute .\Log\Get-LogWinEvent.psl security | Out-GridView and review

the output.

PS F:\SIFT-Lab-Install\Windows Tools\Kansa-master\Modules>
.\Log\Get-LogWinEvent.psl security | Out-GridView
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&3 ALog\Get-LogWinevent.ps1 security | Out-GridView - o iES

_:'-\d::l critena v
TimeCreated N I Id | LeveiDisplayName | Message ) N J | %
Special privileges assigned to new logon.
Subject:
Security ID: $-1-5-18
ik q Account Name: SYSTEM
3722015 14926 PM 4672 Account Domain: NT AUTHORITY
Logaon ID: Ox3ET
Privileges: SeAssignPnmaryTckenPrivilege
An agcount was successfully logged on
Subject:
Secunty 10: $5-1-5-18
i . Aczount Name MA45008
3722015 1:49:26 P 4624  Information Account Dormain WORKGROUS
Logan 1D Ox3E7

i. Choose an Event ID type from the “ID” column and use the filter bar to view only events

of that type.
\Log\Get-LogWinevent.ps1 security | Out-GridView - o IES
4524 — A®
+ Add criteria v |
_TimeCreated | 1d | LeveiDisplayName | Message - —

An account was successfuily logged on.

Subject:
Secyrity 1D $-1-5-18

3/2/2015 1:49.26 PM 4,624 Information s ouniae: Sescs

Account Domain: WORKGROUP
Logon ID: 0x3E7
Logon Type: 3

o=

An account was successfully logged on.

Subject:
Secunty ID 5-1-5-18
; Account Name MASES
| 37272015 1:30:45 PM 4624 Information Account Domain: WORK3ROUP
LegoniD Ox3E7

In this example we used a PS script to extract the Security Event Log and display it in an
outputter (Out-GridView). In a real-world case, the script would default to writing the log to a
file on disk. These logs could then be collected in a database with similar logs from other
systems and analyzed for anomalies or used to track compromised account usage in the
environment.
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3. Optional (Advanced): Enable PowerShell Remoting and Execute Kansa

Many Kansa scripts were not designed to be run alone and need to be run via kansa.ps1 to be successful.
Since running kansa.ps1 requires PowerShell remoting enabled on the target system (your localhost in this
case), we opted to leave it as an optional exercise for when you get access to a test system where it is okay
to tinker with your system settings (it should also work within a VM).

Note: Kansa has some reliability issues with PowerShell Version 2. If you are running PS Version 2 and
having difficulties with this optional part of the exercise, we recommend first validating these steps with a
similar system that has PowerShell version 3 (or perhaps upgrading your current PowerShell instance). You

can find out your version by typing the following into PowerShell: $PSVersionTable.PSVersion

Administraton Windows PowerShelt - o r‘-..L 1

PS F:\SIFT—Lab—Install\'blindows Tools\Kansa-master?> -
$P8Ver‘51onTable.PSVersLon‘\

Major Minor Build Revision

Reference the TechNet article “Tip: Enable and Use Remote Commands in Windows PowerShell” to get
started with enabling WinRM, and/or follow the instructions below. [1] Keep in mind that PS remoting
can be difficult to enable on some systems due to existing configurations (conversely, it may also already
be enabled on some systems). Also, there are multiple different versions of PowerShell, and not all
commands below will work with all versions.

Step 1: PowerShell remoting requires that all network connections be set to something other than
“Public”. This will be your first hurdle. If you are running PowerShell version 4+, you can run the
following commands:

Get-NetConnectionProfile

Set-NetConnectionProfile —-InterfaceIndex XX —-NetworkCategory
Private

(XX is the number of the interface set to Public in Get-NetConnectionProfile. Run this
command for each profile set to public)
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- oM

Admunistraton Windows PowerSheli

PS F:\SIFT-Lab-Install\Hindows Tocls\Kansa-master) Get-NetConnectiorProfijle

Name
InterfacelAlias
Interfacelndex
NetworkCategory
IPv4Connect ivity
IPv&Connect ivity

Name
InterfaceAlias
Interfacelndex
NetworkCategory
IPv4Connectivity
IPv6Connectivity

e ww ww we e oaw

R T

Unidentified network
ngare Network Adapter VYMnet8

Pubhlic
LocalNetwork
LocalNetwork

Unidentified network
Ethernet

Public
LocalNetwork
LocalNetwork

PS F:\SIFT-Lab-Install\Hindows Tools\Kansa-master) Set-NetConnectionProfile -Int
erfacelndex 13 -NetworkCategory Private

For older versions of PowerShell, open the Network and Sharing Center in the system Control Panel.

Change any active networks to “Work Network” or “Private” depending on the version of Windows you

are using.

Conticd Pinel Horne

Change sdaptes 1ettings

Change a3 anced shating

ettmgl

HemeGioup
Internet Cptions

Windows Freaall
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ew your basic netwask infermation and set up rennections

A Gy, @

SAHS W Rebwesk 37 Internet
(This compates)

Yiew yeur setive networks

Accesslyper Internet

Eos Network 12
T — Connections: § Lowsinzer

™

Changs your aetwerlung settin

% 2t up & e oo
it

Setup & wirefess, bred

& Set Network Location

Select alecation for the ‘Netwark 127 network

{onnect o 3 et
Connet ot feconned This computer is connected to 2 netwerk, Windows wilf sutomaticslly apply the carrect

netwark settengs based anthe netwesk s focatien.

; Home network
ﬂ'\lg"; I 2t the tomsutens on this nebnork cre ot your home, and yau ecagrize them,
" this ks 3 teated homr netaork. Bon't shogse this for pyblic places such ag
callee shops 24 aiports.

Access filss and prndl |

= Yesuzleshoo! aeniileg
Cizgnase and repair fil

I Work network

Ity .., If alf tive 2aenauters cnihis aebaork e st your svoriplsce. asd YOU recogmze

tham thross ¢ frugted work netveack. Bont cheose this for public places such as
colew shops oy meposts

F==p Pubiic network

i you dent recagnize a6 the camputers on the netwerk ifcreamyle, YeU e i
3 seffershopar sport < you bave mabide broadband} thi 15 pukhe

1

netastk 99 5 ol trusted.
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Step 2: Enable PowerShell Remoting. Use the following command to enable PSRemoting:

Enable-PSRemoting -force

If this completes successfully, then configuration should be complete. If it does not complete
successfully, it may be worth trying a slightly different method using the command “Winrm
quickconfig”.

- Admmastrator Command Prompt - powershell

I
\SIPT -Lab-Install\Windows Tools:Kansa-mastes
‘ anRH has heen updated to receive reguests.
[ MinBRM service type changed successfully.
| MinRM service started.
nfxgured LocalficceuntIokenFilterPolicy to grant administrative rights remotel
to local users.

reat;d a WinRM listener on HITP://% to accept HS-Man reguests to any IP on thi
machine.

JinRM has been updated for remote nanagement.
‘U;nﬁﬂ firewall exception enabled.

Step 3: Run Kansa on the Local Host.

First, make sure you are in the “Kansa-master” folder and that your PS script execution policy is set to
unrestricted. Just in case you missed the step in a previous part of the exercise, use “Unblock-File” to
remove any Zone.ldentifier alternate data streams from the Kansa script directories.

PS F:\SIFT-Lab-Install\Windows Tools> cd “\SIFT-Lab-
Install\Windows Tools\Kansa-master”

PS F:\SIFT-Lab-Install\Windows Tools\Kansa-master>
Set-ExecutionPolicy unrestricted

PS F:\SIFT-Lab-Install\Windows Tools\Kansa-master> ls —-r *.psl |
Unblock-File

(Unblock—Filt—? is only available in PowerShell version 3+)

H
H

Now run Kansa specifying the localhost as the target.

PS F:\SIFT-Lab-Install\Windows Tools\Kansa-master> .\kansa.psl
-Pushbin -Target localhost
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23 Cale

et Administrator Windows PewaiShe - O ]':,___'i
2S F:\SIFT-Lab-Install\windows Tools\Kansa-master> .\kansa.psl -Pushbin ~-Target loc-

Get-LogUserAssist
Get-SvcFail
Get-SvCTrigs
Get-WMIEVLFi

Id Name PSiobTypeName  State HasMoreData Location

2 Job? Remotelab completed True tocalhost

Completed True localhost
VERBOSE: D:\temp\Kansa-master\Modules\Process\Get-Handle.ps
has dependency on .\Modules\bin\Handle.exe.
VERBOSE: Attempting to copy .\Modules\bin\Handle.exe to
True Tocalhost
True localhost
Frue Jocalhost
True Tocalhost
Remotelob Comp leted True tTocalhost

An output folder will be created in the “Kansa-master” folder and inside will be sub-folders for each
script that was successfully completed. Review the content in each folder to gain an understanding of
the type of data that Kansa collects. In a real-world environment, we would have used the “-Targetlist”
option to run simultaneously against multiple hosts, and the output of each host would be in the
corresponding Output folders for review.
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3ot Kansa-master - o il
Home Share View ©
@ » v P J5 « WindowsTools » Kansa-master v G Search Kansa-master e
o Favorites ~ Name Date modified Type 2
= Box Sync & Analysis 22072015 301 PM
EE Desktep Madules 27182013 3:16 PM File Tolder
& Downleads | Qutput 2015030214502 | 3/2/20156:45PM  Filefoldes
-, Recentplaces glignore 14/16/2014 2252 PM GITIGNOR
L2 Dropbox (SANSDFIR) {5 contributing.md 114162004 252 PM D File
{6} kansa 1171672014 2:52 PM slows |
+3, Homegroup £} LICENSE 11/16/2014 2:52 PM
{.} MStimitedPublicLicense 11716/2014 232 PM e
‘& Thiz PC {j README.md WIE/2014252PM  MDFle
e Desktop v < *
10 items -
PRE: Output_20150302184502 - olEl
“ Home Shars Yiew v 0:
(¢ © 4 ¥ « Kansa-on.. |» Output 20150302184502 [ ¢ searchOutput 2015030218452 0
i Desltop A Name ‘ Date modified Type A
1 Bocuments e ;
@ bocu & Auterunsc YIS &RASPM  File falder
+i§ Downloads . .
& wos & DHSCache 37272015 6:45 PM e folde
,g p::" & Handie 37212015 6:45 PM foldes
23 ures A p
o & LocalAdming 3/2/2015 543 PM folder
e "*”“’" 4 LogUsersssist 3/2/2015645PM  File folder
&y Local Disk (C} ) ) .
= B & Nestat 3727201554590 FileTokder
L i - 3 ProcsWMI 3272015645 PR Filefolder
ama FORSOB-UISE F: & PSProfiles 3/2/2015645PM  Fite folder
3 SvcFail 372/2015645PM  Filelotder v
v <
14 items

[1] Starting the WinRM service: https://technet.microsoft.com/en-us/magazine/ff700227.aspx

|Exercise - Key Takeaways

¢ WMI and PowerShell are a powerful (and free) means to collect system data across a Windows
enterprise.

e Itis important to test your scripts before you need them! While most commands and scripts are
straightforward, individual configuration choices within the enterprise can greatly affect your
success rate.
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Optional Exercise 7 —Redline Pre-Process

Objectives

e Set up Mandiant Redline to conduct a memory audit in preparation for the memory analysis exercise.
e If you do not want to complete this step, a pre-processed version of the memory image will be
provided in the next exercise.

Exercise Preparation

1. Install RedlLine (Microsoft Windows only tool)
e located onyour USE under \SIFT-Lab-Ins talil\redline
e Redline requires a recent version of the .NET framework, you might need to install .NET before the
installation. The installed for the FULL version of .NET is found in \ 8 3¥T~Lab~Installiredline

2. Execute Redline from the Windows Start menu (or equivalent)

3.  Attach your FOR508 USB media and find the xp-tdungan-memory-raw.001 image (it should be
located in \xp-tdungan-10.3.58.7\xp-tdungan-memory\)

4. Copy the xp-tdungan-memory-raw.001 file to a local drive (i.e.
C:\Users\<username>\Desktop)

|Exercise — Step-by-Step Guide

NOTE: Some older laptops and VM setups may take a very long time to process this memory image
(VMware Fusion is notoriously bad). If your system does not finish processing, a pre-processed analysis
file has been saved on your USB in the “xp-tdungan-10.3.58.7\xp-tdungan-c-
drive\precooked\redline” folder. Instructions for loading the pre-processed copy are present in
the next exercise.

Perform a “Saved Memory File” analysis of the xp-tdungan-memory-raw. 001 image.

1. Analyze Data
a. Select “From a Saved Memory File”
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Redline’

Collect Data

Create a Standard Collector >
Create a Comprehensive Collector >

Create an 10C Search Coltector >

Analyze Data

From a Saved Memory File > h

Open Previous Analysis >

2. Find the “Location of Saved Memory Image” dialog

Start yon.:r Ar'.af_ys’irs Se-s;énn =) g
[trocion YW RASNIST IR Comgaation W0 11 ISR v S SR e

Location of Saved MemoryImage: Cper Tontaining foider

captured. Redline will analyze this

image to aid in navigation and to ! -

assist n the identification of i Indicators of Compromise Location: Cpen foider |

potential issues. Redline zan also ;

search for Indicators of |mBcovses, l ‘

Compromise [described belovs at |

this time. If you wish to search for I
|
|

m

Indicators of Compromise 0Cs)
at a fater time, this option cart be
found under the [OC reports tab,

Indicators of Compromise:

Indicators of Compromise are
forensic artifacts [eft behind by an
intrusion. An I0C fite describes
these artifacts using the OpenlOC
forma:. When configuring an audit,
Redline verifies that the correct
data exists, or will be acquired, so
that these artifacts can be

I o

| Concel

For508 — SANS ©2015 Optional Exercise 7 — Redline Pre-Process



3. Browse to the xp-tdungan-memory-raw.001 file

a. You may need to select “All Files” on the drop down to see the “.001” file extension.

v 4 & » ThisPC » Desktop v & Search Desktop

Qrganize v News folder

A Name Date modified Type

& This PC
ra Desktop
i Documents

r@ xp-tdungan-memory-ravw R r MRS ] 201 Archive

& Downloads

& Music

» Pictures

H Videes -

File mame: [efe29G0.vem (A Files () v

'Memo; Imaiu I

b. Leave “Indicators of Compromise Location” unchecked.

4. Click “Next” in the bottom right corner.

5. Select “Edit your script” to choose analysis options

You have chosen to analyze a Saved Memory image File

This will collect available data from a Saved Memory image file and analyze it

Edit your scnpt h

= —

Specify Analysis Session Location

Please select 2 location where your data will be stored for future analysis

Save Your Analysis Session To:

Name: AnalysisSessiont

Location: CiaUsers\ChadiDesktop ! Browse

| [ ox ]
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6. Check “Strings” in both the Process Listing and Drivers Enumeration sections. Strings collection is one

of the most time intensive actions. Note that some options will be unavailable (greyed out), due to this
not being a live analysis. Click “Ok”.

E] View and Ecit Your_Scdpi.

I Memary Show Advanced Patameters
¥ Process Listing
| Handles J Part
J J Impors Venty Lig At
¥ Exports | Detect Injezted Sections |‘
< Drivers Enumeration
7! Imports Jend “natures -
v Expons
Il !
+ Hook Detection tl
o DT v SSDT indes
i || v ssDTinline ¢ Drivers
I
1
| , —
| Cancel 0K

7. Select save Your Analysis Session To: Please rename the save location to a directory and

name you will remember. xp-tdungan-memory.mans will work fine saved to your
C:\Users\<username>\Desktop. Click “Ok”,
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You have chosen to analyze a Saved Memory image File
This will collect available data from a Saved Memory Image file and analyze it

Edit wour senpt

Specify Analysis Session Location

Please select a location where your data will be stored for future analysis

Save Your Analysis Session To:

Name:  xp-tdungan-memary h

Location: C:i\Users\Chad Cesktop

8. Click through the Windows User Access Control (UAC) permission dialog if it appears.

9. When Redline completes processing, you will be ready to analyze!
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Exercise 8 - Memory Analysis with Redline

Objectives

e Learn memory forensics using the prescribed memory analysis steps.
e  Gain experience using Redline to analyze data present in memory structures.
e  Witness the value of string searching in Windows processes.

Exercise Preparation |

1. Install RedLine (Microsoft Windows only tool)
° | ocated on vour USB under \SIFT-Lab-Install\redline
e Redline requires a recent version of the .NET framewaork, you might need to install .NET before the
installation. The installed for the FULL version of .NET is found in \SL¥T~Labk~Installi\rediine

2. Perform a full memory audit of the xp-tdungan-memory~raw. 001 image, including process and
driver strings output (see Optional Redline Pre-Process exercise).

NOTE: Some older laptops and VM setups may take a very long time to process this memory image
(VMware Fusion is notoriously bad). If your system is still pre-processing at the start of this exercise,
cancel processing. A pre-processed analysis file has been saved on your USB in the “xp-tdungan-
10.3.58.7\xp-tdungan-c-drive\precooked\redline” folder

3. If you are using the pre-cooked image (i.e. you did not complete the “Optional Redline Pre-Process”
exercise), do the following:

e Copy the “xp-tdungan-10.3.58.7\xp-tdungan-c-
drive\precooked\redline” folder from the course USB to a local drive (your desktop is
one good option).

e Double-click the xp—tdungan .mans file located in the folder just copied

4. If for some reason double-clicking the xp_tdungan .mans file does not work, it can also be opened
directly via the “Open Previous Analysis” option in the main Redline menu.
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Redline’

Collect Data

Create a Standard Collector >
Create a Comprehensive Collector >
Create an 10C Search Collector »

| Analyze Data

From a Saved Memory File >

Open Previous Analysis > h

Mount your disk image so you can interact with files/folders on the xp-tdungan-c-drive

5. If your evidence is not already mounted in the SIFT workstation (from a previous exercise), you will
need to open a terminal in your SIFT workstation, elevate your privileges to root, and change into the
/cases/xp-tdungan-c-drive directory. Then uncompress and mount your evidence files so
you can see the xp—tdungan-c-drive file system in /mnt/windows_mount.

$ sudo su -
# cd /cases/xp-tdungan-c-drive/
# ewfmount xp-tdungan-c-drive.E01l /mnt/ewf mount

# mount -o ro,loop,show _sys files,streams interface=windows
/mnt/ewf mount/ewfl /mnt/windows mount
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Exercise — Questions

1. Identify Rogue Processes

e Review processes by MRI scores to identify any suspicious processes. What process has the
highest MRl score?

gvch-s’(,mk J 2 A0 3194

o Why did MRI score this process so high?

WY T’*ﬂ\

?ww-jb nll SO, W / run Feom MM A/C

e Was the process executed at boot? (Hint: compare to the start times of smss.exe, csrss.exe,
Isass.exe, svchost.exe, and other processes that typically start at boot)

fre

e What user account (SID) was logged on when the process was spawned?

(o0

e List the full path of the process binary:

CoN wdalses ) S/ b DN AU hos T (8 vehesT. s

e Review the contents of the folder where this binary is located within the tdungan disk
image (during the Exercise Preparation section you should have previously mounted
tdungan’s disk image to /mnt/windows_mount).

What additional file is located in the same suspicious directory?

AN cﬂ)t{)’b(\m’)

Open the newly discovered file in gedit (SIFT) or Notepad (Windows). What registry key
is referenced?

UKEY _Loc of = N ackini_\ vﬂu\,\\vau«]L(m(r-'/? 500\ gundacs VWl
IRV
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e View the hierarchical process list. Do you see any additional suspicious processes?

S-r’iﬂ"f{ﬁdu.w( YZd Vizzky
Jvck-s’L.m VM ‘“}Yﬂ/

e Why is information missing on some of the interesting processes?

2. Analyze Process DLLs and Handles
e Review Handles of each suspicious process identified in Question 1.

e Use least frequency of occurrence (LFO) to narrow your search. Are there any handles
worth looking into further?

Tha iy 4 ;”.—".«L{ ) f"‘\a,ﬂ_,,“'f 4 Aokl ‘z

fZp s 32494 .

e List the loaded DLLs for each suspicious process and sort by occurrence using the MRI Report
tab in “Full Detailed Information” (found via a double-click on any process name)
o What DLLs (if any) might call for further analysis?

"\b‘("'\fj \AM

3. Review Network Artifacts
¢ Do any network artifacts appear suspicious? What process spawned them?

h
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4. Use the Redline “Strings” output to look for additional evidence
e Search svchost.exe (PID 3296).

e Be creative. Terms like “http://", “https://", “ftp://", “.exe”, “C:\”", and

’

names of suspected malware or support files can sometimes bear fruit.

e Search csrss.exe (PID 976)
e The CSRSS process is the Client/Server Run-Time Subsystem and in Windows XP it is
responsible for the console and processes such as cmd. exe. Look for any command
line entries by searching for “cmd . exe” and other commpnd-line executable names.

Sterde An ftﬂk“
5. Optional Homework: Create and run your own Redline Collector

1) <Top Left Icon> > Create a Comprehensive Collector

Redifine &

] Create a Stangardd Colincier

| Creste a Compreherntove Callectay
Cerate an 100 Swarch Coliecior
Anatyze Collested Data

] Rralyze a Saved Memary File
Analyze tms Computer

Cpen a Saved Analytis

/A Bt Redline

2) Edit your script
a. Go through the various menus and select what you would like the script to collect. Since
we selected “Comprehensive Collector”, most options are already enabled. Any additional
selections will likely require a long time to complete.
b. If you would also like the collector to take a full memory image, select Acquire Memory
Image
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You have chosen to create a Compreheasive Collector |

The comprehensive collector wilt gather most of the data Redline is capable of colfecting. Note: this will not collect I

strings which can be manually enabled by choosing to edit the scapt below.

Edit your scrpt h

Acquire Memory Image

{1 Checking this option will acquire an image of memory that can te used to accurately acquire process mamory and
drivers during analysis in Redline

3) Specify Collector Location

a. Place this on a USB thumbdrive if you have one, or for testing purposes you can save and
run the collector from a local system drive.

1. ¥our Collector package will be crealed and saved to the location you specify below.

2. On the machine you want to audit run the RunRedlineAudit.bat’ script, preferably from a removable media (e.g. a
USB Hard Orive). This scapt will run the Collector as you configured it and save the results to a folder named "Audits’
next to the script.

3. When the collection is finished, transfer the results back to your analysis machine, and use the ‘Aralyze Collected
Data’ option on the start page of main menu.

A copy of these instructions can te found in the location you specified, in the file 'Readmendt’

Save Your Coltector To:  Open foider \
| | Browse ]

Collector [nstructions @

1. Your Collector package will be created and saved to the location you specify below.

2. On the machine you want to audit, run the "RunRedineAuditbat’ scnpt, preferatly from a
removable media {e.g. a U3B Hard Dave}. This script will run the Collector as you configured it
and save the results to a folder named "Audits’ next to the script.

3. When the collection is finished, transfer the results back 1o your analysis maching, and use the
"Analyze Collected Data’ option on the start page or main menu.

Choose from one of the options below or close this window to retum to the start page:

Coen Bregtory Co

A copy of these instructions can be found 1n the location you specified, in the file ‘Readme.txt’
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4) Open a command prompt with Administrator permissions on your target system and traverse to
the location of your Redline Collector. Execute the RunRedlineAudit.bat script. A new command
shell will be open and you should see output from the collectors being executed.

‘\Iemp\Be611na0011¢ctor)d1r
Uelume in drive D is
Volume Serial Number 1s 9250—9?96

Directory of D:\Temp\RedlineCollector
9/18/2314 H <DIR> .
j 1.108 éieuate.cnd

etNextSessxonFolder Js
clper.

832 RanRadlineﬁudit.bat
<DIR> x64

29 R <BLR> xB6
8 Pile(s> 16,569 bytes
4 Dirds> 155.205.468,168 ytes free

D:\Temp\RedlineCollector>RunRedlinefudit .hat

‘Executing cosmnand wSZdriuers-nodulaIise 1.4.46.0

Pre—-execution diagnestics fer command 932drivers-noduieli

‘PageFaultCount: 27842 PeakWlorkingSetSize: 29362784 UorkingSetSize. 15917056 Quot
PeakPagedPnolUsaye 243848 Quota?aged?oolvsa ge: 221344 QuotaPeakMonPagedi'oollsa
seo0s QuotaNonPagedPocllisage: 16832 Pagefilelisage: 76800608 PeakPagefileUsage

48
ommitiotal: 2267418 CommitLimit: 4814297 CommitPeak: 289284% Physicallotal: 419
1705 SystemCache: 265833 Kernellotal: 96689 KernelPaged: 63363 Kerne}Nungaged
3246 PageSize: 4896 HandleCount: 46957 Procesanunt- 115 ThreadCount:
KIssue numher="2" Jevel=""Info" sunmary="" gst&n range @xABB0AGAGRNZNGNNS — B»ABH0
PEABNBAR1AAB" context="EnurerateDevices’/

Klssue nunher="8" level="Info" sunmaryﬂ“Sgstem range BxB000808100600088 - Bx008D
9008430880880" context="EnunerateDevices'/

Klzsue number="@" level="Info™ sunnarg-”Sgstem range Ox0000000000103000 - OxBBLA
DOBACF65FPBB" context="EnumerateDevices™/

{Isswe number="@" level=“Info" sunnary-“Sgsten range 9+x0080000600106000 — 800800
1NP8Aan1 82988 context="EnumerateDevices’/

<l1ssue nunber="0" level=“Info" sunna»y*“Sgsten range BxB00B000BARA1F000 Bx0880
80000087880 context="EnumerateDevices'/

{ Issue nunher="17083" level="Info" surmary="Internal Informationflgorithm found ¥

a. A full collection script can take hours to run (in the future you can remove unnecessary
options in the audit script to speed up processing). Your results will be located in a folder
named according the System Hostname in the same location as your collector.
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{D:} » Temp » RedlineCollector » Sessions » AnalysisSessienl » Audits » MI5G0 » 20140518143212

~

Mame Date rodified Sire

_, w32dnvers-medulelist.gmr€87wpBGdbY,,.  G1E 2014 27 Al MIRESNPEGRE WKs
, w32deivers-modufelist.issues fGef3Dzm7... ¢ 12 2014 827 ANt SMATRED 2K8

. wildrivers-signature hjl2KUmptYdZHbw... & 152014 225 AN

. w3ldrivers-signature.issues P7KxpEMoo... 512/ 2014 535 AN 22 KB

. w32kernel-hookdetection.eadoTX9SCRGd... & 18 2014 5:29 AN $KE

., W32kemnel-hookdetection.issues.kYwkVu... 9/ 1872014 235 AW KyWRMVUKMIQED . KB

. w32processes-memory.issues kPjBmfiGk..  S/12/2014 238 AN KPIERVIGKIZSFLG. GKE

5) Open your results in Redline and start your analysis
a. <Top LeftIcon> -> Analyze Collected Data = Audit Location = <sub-folder of folder
named according to System Hostname> (or just double click the . mans file in the same
folder)
Redline®

Craate a Randard Colester
Create 3 Comprehensive Callector

Create an ICL Search Coliactor

1
Analyze Collected Data &
Analyze a Savec Memary file
Analyze this Camputer

Open 3 Saved Aralysis

A ExtRedlne
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Exercise — Questions With Step-by-Step

1. Identify Rogue Processes

e Review processes by MRI scores to identify any suspicious processes. What process has the
highest MRI score?

svchost.exe (PID 3296)

MR Process N.. MR S;o.-e ZPti) Path Start Time |
_ & schostere 97 3286  Cawindows\system32\dithost 2012-04-06 1307167 £
| Processes
Hierarchical Processas & spnlociere 34 12244 2012-04-06 07:25002 ¢ =
|| Driver Modules 4 sevicesave 61 1044 212-04-04 1038332 W
h uook: Jree U swehostere 61 1488 2012-04-04 10:38:35Z 5

e Why did MRI score this process so high?
Double-click on the process name and select “MRI Report”

Answer: Unexpected location and arguments

For508 - SANS ©2015 Exercise 8 — Memory Analysis with Redline



i v!am,_ﬁ” . ' -
g @3 ——
| Cevce Tree

Fooks

Timeline

Tags and Comments Process Details

Acguisitien Sistary Hseeriamig
cguisitien Sistar
Path: Chaindowsisyerem32idithest
Parent: ExpiorentXE (1600}
Arguments: “Chwindowsiystern32idihosisvchost axe”
Start Time: 2012-04-96 1907:367

|

|

|

| Parent Process Path:  CAOWINDOWS

1

| Kernel Time Elapsed:  00:00:02

‘ User Time Elapsed: 00050

Sip: S-1-5- 211545522229 B1 2407703 724 2455431004
SID Type:

Mabware Risk Index: 57

Export Repoit »

{‘ Tiug (r0cess was spaved wih wiespected srguments: "Thwindovsisysten 32 v
Wihostisvenostere” ™~

a This precess was spavaed from an unexpected iocation: “yemdowsisystam3 0 ",

|
i Malware Risk Index Hits
|
‘ \d¥hcst®.

Add Commeat or Hit >

Fast | IOC Reports | Not Cotectea | Process] MRl fapant | Sections | Handies ] Ports | Strings | Tags and Comments
| | |

e Was the process executed at boot? (Hint: compare to the start times of smss.exe, csrss.exe,
Isass.exe, svchost.exe, and other processes that typically start at boot)

Compare the Start Time of svchost.exe PID 3296 with the other svchost processes. It appears
to have started >5 minutes after (notice there is one svchost process from 4/4/2012 which
was likely a previous boot cycle). Also note that PID 3296 was started not long after the
“winlogon.exe” process. This could be an indication the malicious process was started when
a user logon occurred.

MRS Frcte;s N..  HMREScore Pit: Path Start Time Parent Name Arquments

$: swehostess 61 k134 012-04-04 S0:35:357 Jrervices ane

$

cvehostese 97 3238 {usindowsisyutem3Iisinony Z0L2-04-08 12.07:167 REvplorer EXE ‘Chwindows syster

30 sicrosiese 51 17 CWINDOWS S atem 32 Tiencaanens CAWINDOWS Syst

41 senosiase 62 138 CMVINDOWSsystamdl senesene SONTHECW S\t

§) scnostee £% 32 CAWINECW Sisystem3l SENVIIERE TR SAWINDC

3. suchostese 51 1432 CAWINDOWS Systern2 CRVINDOWS\Syst 2
o s 383 CWINDOW S System 2 TANWINDOWS St

i [ 1936 CAWINDOWS System32
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e What user account (SID) was logged on when the process was spawned?

The account assigned SID _S-1-5-21-1645522239-813497703-725245543-1004

e List the full path of the process binary:

C:\windows\system32\dllhost\svchost.exe

Pracesses
|
|

Device Tree
Faasls

Timelin )
-;: ,:, Comments Process Details

Asguisition Hntery Usernames
) Path: Chmndowsigpstem3ndithast
Parent: Explorer, EXE {213C0)
Parent Process Path:  CAWENDCWS
Arguments: “Chwindowssystam3 Zdilhostisvchost e
Staet Time: 2012-04-06 1302:142

Kernel Time Elapsed:  0C0C02

| User Time FHapsed: 200000

| SID: 5-1-5-21-16455222309-B1 3497703 - 7,534 5543-1004
SID Type:
Malware Risk Indec 97

| Export Report >

Hast |10C Reports ; NotCoilected Prfxes;: HARI Report | Sections I Handies 1 P:ns; Sznngs I Tagsand Cnmmenls |

&

e Review the contents of the folder where this binary is located within the tdungan disk
image (during the Exercise Preparation section you should have previously mounted
tdungan’s disk image to /mnt/windows_mount).

What additional file is located in the same suspicious directory?

winclient.reg
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-

9 e dc

Print

Bumn

Organize »

oY Mege ~

-

. { Faverites
‘ B Desktop
;. Scanned Documents —
# Downloads
*. Recent Places
& SkyDrive
© My BoxFiles

I ikearias
P3N winclient.reg
t Rejistration Entaes

Mew folder

“

® | svchost.exe
] winclientreg

Date modified: 4/2/2012 6:35 PM
Sce 342 bytes

8 - — —

» Network » SIFTWORKSTATION » mnt » windows_mount »

WINDOWS » system32 »

Date moddied Type
ANTI0R6I2PRE Applic
47272013635 PAY

Date created: 47272612 6:35 PM
Cfftine avadabitity: Notavailable

"’“Eﬁﬂ?n_&j { |

cation

Jisiralion Enine

Ty

E

Oftting statys: Online
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Eile  Edit

View Terminal Help
root@SIFT-Workstation:/mnt/windows_mount/WINDOWS/system32/dlthost# 11 -
total 161

-rwXrwxrwx 1 root root 182400 2008-64-14 86:12 -chos

~rwxrwxrwx 2 reoot root 342 2012.84-93 08:35 . i:
root@SIFT-Workstation:/mnt/windows mount/ﬂINDOﬂS/system32/d

st#

Open the newly discovered file in gedit (SIFT) or Notepad (Windows). What registry key
is referenced?

HKLM\SYSTEM\CurrentControlSet\Services\Netman\domain

winclientreg - Notepad
| File Edit Format Vlew Help

windows Registry Editor Vversion 5.00

N NGEn AN dOnE AT 4
"home *“http //199.73.28.114/ads/"
"pause''=dword:00000020
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If we believe svchost . exe is suspicious, the close proximity of winclient.reg
also makes it suspicious. While we do not yet know the significance of the registry key
and IP address information stored within winclient . req, they may later become
useful indicators of compromise.

e View the hierarchical process list. Do you see any additional suspicious processes?

There are two instances of “spinlock.exe” and two “cmd . exe” command prompts
spawned by the second “spinlock.exe” process.

1wt » Hierarchzal Frocestes
MR Rrocess Nare S8R1S¢ore PID Path
S) BTnZst ene 53 1308 CRWINDOWS s stam32
 Hisraschicol Procesnss! : suchostene 61 1472 CWVINDOWS Systen32
Crioer Kadoes ) ¥ schastede [H 1283
Cevice Tree F 2.
Hooks . b emd s L3S 3872
B stive (H v . (1 12234
Tags and Lomments g} P ssinlackese L 3648
Acguisitizn History - cmd aae 54 7316
i cmd exe LH 9448
C SvCnsstese 53 1828 COSIDOWSR G stem32
: VhtwareSenice exe 61 1£80 CiProgram BlesiyhwaretyMware Tc
H SehisLese 8L 732 COWINDCW S Sy stam3Z
- spoclov.exe 51 1844 COWIMNTCWSisystem32
4 Rt mae R? 1915 CEMANPO R it am 7
Hast | iCC Reports | hot Collected
W A

e Why is information missing on some of the interesting processes?

Malware Risk Index Hits

g - g . ! i
&% Tius process was spawned from a command shell. This is not a definite cause for concern but is i & i
atypical for most processes. fae

{3 [Comment}: This Process has exited

¢ {Comment]: This Process has exited

Add Comment or Hit >

Several of the processes exited prior to the memory acquisition
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2. Analyze Process DLLs and Handles
e Review Handles of each suspicious process identified in Question 1.
e Use least frequency of occurrence (LFO) to narrow your search. Are there any handles
worth looking into further?

The key “REGISTRY\MACHINE\SYSTEM\ CONTROLSETO001\SERVICES\
NETMAN\DOMAIN" has a low occurrence count within PID 3296. Recall that this is the

Hang @ Mame Pardie Type
2 Key
2 Key
\Denice HarddiskVel Lme P Documers and Settingn Sk aludesalacal §ez€|rsg52Tgn-g.;«:af~,l Irstenet File
<lEmuments and setlogsisil-Relpdack local settingsltemparary ntesret hledicantent €5 kiLtant
{- Documents and Sell ngs_SRL-—elpreck Leesl Gatvings Tevporary Internat Files_Coent 125 indes Secten
"Deige marddiskvol e BDotuments 3= fethrgs SA-kelpdestilookiesindey dat File
Cadturrenis and settrgzial-nelpdes<iiscaes! e vant
{ _Cocyments ard Jeitngs SBL-Ae ccesk_(ockies rdexdst 16381 Sezton
filz
< gacuments and settrgsistl-helpdesiciosat settingsthisteninrston e d kigtant
L_Documerts ano Sett ngs SRLHelpgesk Local Sattings Fstary Higtery 185 ndes dor L6384 Secren
(IR

List the loaded DLLs for each suspicious process and sort by occurrence using the MRI Report
tab in “Full Detailed Information” (found via a double-click on any process name)
e What DLLs might call for further analysis?

injected memory sections shown in this report view.
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¢. Click on Cell A-1.
¥ id ® TIMELINE_COLCR_TEMPLATE xlsx
m Home Insert Page layout Formulas Cata Revievs Vigw Add-lns
Bl C SERG i G-
® Cut Calibri 1l AT A= =g S G Wrap Tedt General
pﬂw; L3 Copy 7 - e, =
af : \/meat Painter B I U- - A- T EEE IFE EQ"’TC’G?‘f*‘AeM“' $ - %
Thspoard . Fant Aligamant N
Al b ft
2 A B C D E F G
1 | I
—_ B
2
3
4
5
6
=
d. Select 'DATA' Ribbon.
e. Import Data "FROM TEXT".
*" A ¥ TIMELINE_COLOR_TEMPLATE.sdsx
m Home Insert Page Layout Formulas Lot Revievs Vigwy Add-Ins
. | . > y \ 2 Connections A = N b |
=X } | ) = - / AlZ] g -
L&] o A1) | J | 2 Z| Al ? .o
Y 2R
From From  Fro From Othes Existing Refresh f\l Sort Filter N Texito W
Actess Web  TefR Sources~  Connections all - : 57 Adnced  Zolumng DY
Al v S
A B C D E F G
o
=
2
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f. Select timeline.csvfile->\\siftworkstation\cases\xp-tdungan-c-drive

& | Import Test File

G |- b Network » siftwotkstathon b cases » ap-tdungan-c-drve » - 4y
S
Crganae v Tiww loider
o SELD-USB LY - .
o DUTPUT (N4t

Bulk-extracier-suiput

E 2 precocked
e Network P

i Q00FFFL2S1EB-HO
1B OOOFFEI NIBF-HG
& OOFFFIMS3TS
D007 FFE36119-47
1% J00FFF135183-€7
K ONFEF] 2820207

—

keywotds g
resuits.ixt
) Gmeline.cey
swhitelnta
*p-tdungan-c drve it
. *p-tdungan-c-drve_bodfilet

g. TEXT IMPORT WIZARD Will Start.

h. Step 1 ->Select Delimited -> Select NEXT.
Text Import Wizard - Step 1 of 3 [-® 'IE
The Text Wizard has determined that your data is Fixed Width.

If this is correct, choose Next, or choose the data type that best describes your data.

Orignal data type
Choose the file type that best describes your data:
o Delmite - Characters such as commas or tabs separate each field.

Fields are ahgned in columns with spaces between each field,

Startimport atrow: 1 - Fie origin: 437 : OEM United States L' |

Preview of file \\siftsvorkstabonicases'xp-tdungarc-drive\bmehne.csv.

1l Hate, time, timezone  MACE, gource, sourcetype, type, user hess, shere, desc, versd #
3/‘31/20%3.97:&0:09,ESISEDI,..,B, FILE,HUIFS $MFT,8ST [...B] time,-,WKS-HI
"3/31/2@03, 97:00:00,ESTSEDT, M. .., FILE NTES SMET, $SI (M...]) time -, WKS-UI
03/31/2003,07:920:00,Z8TSEDT M. .., FILE NIFS SMFI,$SI [M...] time,-,WKS-WI
33/’31/2033, 07:00:02, ESTSEDT, M. .., FILI,NTTS SMFT, 58I [M...] time,-,WKS-WI} ~

Cancel
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i. Step 2->Unselect Tab under Delimiters -> Select Comma under Delimiters -> Select NEXT >

Text Import Wizard - Step 2 of 3 {8
This sareen lets you set the delimiters your data contains. You can see how your text is affected in the preview
below.
Delmiters
Tab
Semicolon {T] Treat consecutive delimiters as one
Y ";‘M gualifier: - |
Space =
Other:

Data preview

ate cime ~irmezeone MAC uccetype Rype izex by~
3/31/2003 P7:00:00 2 SMFT 51 [...B] cime i
P3/31/3003 P7:00:00 E L. SMET 51 M...] time i
03/31/72003 P7:00:00 1 $MFT SI M...] tims 'l
03/31/2003 P7:00:00 :§ SMET SI M._.} tima i -

‘ m

j. Step 3 ->Select Finish.
k. Where do you want to put the data? Simply Select OK.

Import Data |-® [p&hll
Where do you want to put the data?
© Existing worksheet:
=5AS1 [
£ New worksheet
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I.  Once imported View -> Freeze Panes -> Freeze Top Row.

By View Add-Ins

P : — R
P

3 [

Zoom 100% Zoomto Mew  Arrange : Freeze
Seleztion  Window  All Panes~

Lot

F 1
frcetype type EER
ES SMFT $SI1[...B] time

1 J' 9 Split

) view Side by Side

= Hide

A

Workspace Y

Unfreeze Panes

Unlock all rows and ¢oiumns to scroll
through the entire worksheet,

Freeze Top Row

Keep the top row visible while s<ralling
through the rest of the worksheet,
Freeze First Column

Keep the first column visible while scrolling
through the rest of the worksheet,

|
|

W

Save

m. Optional: Hide Columns Time Zone, Host, Version.
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Copy
Paste Options:

5

Paste Special...
Insert
Delete

ClzarContent:

Farmat Cells...
Column Width...
Hide

Unhide
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n. Select HOME Ribbon.
&
m Home Insert Page Lay¢
=& Cut e
) -Calibri
fa " w3 Copy
% J Format Painter L U~

o. Select all Cells "CTRL-A".

In Home Ribbon -> Sort and Filter — Filter and you will be ready to begin analysis.

p.
Aw | 3
] A
' Sort & | Find &
- Filter = ' Select -
g. Before you analyze too much — please save your new Color Timeline as an XLSX file:
/cases/xp-tdungan-c-drive/supertimeline.xlsx
Takeaways

e  Log2timeline is not a quick process to run.

e  Compare length of time to create a super timeline vs. a file system timeline.

e If you arein a rush, could you begin basic analysis with the much quicker file system timeline?
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Exercise 14 — Super Timeline Analysis

Objectives
e  Conduct a full system super timeline analysis of a compromised system
e |dentify when the hacker/intruder was first active on the system and where they possibly went
[ ]

Gain experience analyzing the colorized timeline output

Gain experience performing contextual based analysis of artifacts

Exercise Preparation

1. Please ensure your evidence is mounted correctly at /mnt/windows_mount if not, please follow

Exercise 2 — Mounting Evidence Using SIFT again to mount your evidence.

# cd /mnt/windows_mount

# 1ls
root@SIFT-Workstation:/mnt/windows_mount# 1s
Hsotachy
$Secure

If you do not see the above, then please foliow directions in Exercise 2 — Mounting Evidence Using SIFT
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IPre-Cooked Supertimeline

If your supertimeline has not finished processing yet, please use the pre-cooked version found in:
/cases/xp-tdungan-c-drive/precooked/timeline/ XP-TDUNGAN-TIMELINE-
FINAL.xlsx

|Exercise — Questions

1. Initially scan through the timeline for getting a feel for the difference between the filesystem timeline
and the super timeline. {5 Minutes Max)

2. Using the same questions from Exercise File System Timeline, see if they would have been easier to
answer using the Color Super Timeline. (10-15 Minutes Max) Do you see any additional information
that you can discern.

3. What additional artifacts are now clearly visible around the time that winclient.reg and the
C:\windows\system32\dllhost directory were created? What time was the reg.exe
executable run? Why was reg.exe executed at this time? What time was the
\ControlSet001\Services\Netman\domain key last modified?

o H/U/11L 25 I¥0( / Yl oo 136103 /[ W) e ik

4. Near the time that winclient.reg was imported on the system using the reg.exe command, we can see
an interesting event at McLogEvent. What time was this event detected? Why do you think this
event is meaningful for the case?

McLogEvent/257;Info;The Scan was unable to scan password protected
file 2011-W2.zip/2011-W2.pdf. Scan engine version used is 5400.1158
DAT version 6498.0000.

. Mtfe(n iy
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5. In many cases, an easy way to find adversary footprints on your network is to identify TTPs that they
use. The use of the “AT” command is a common advanced adversary technique to help in lateral
movement by first uploading a file to remote system and then using the “AT” command to execute it
at a predetermined time.

For the tdungan system, what time was the AT.EXE command first executed? Immediately
surrounding that event we see an indication that a remote machine might have been involved. What
directory was mounted of the remote machine? What is the IP address of that system? Why do you
think the remote system was involved? What is the significance of the remote system?

o /e |30 HD

6. List all the any other systems remotely used through mounting the CS share. When were the network
shares last mounted? Why is it possible that we can see that 10.3.58.5 was mounted twice? Which
file and directory did the first entry originate from?

7. On4/4/2012, the user vibranium executed EXCEL.exe, what two files did he open for the first time?

What types of files are those? Where are the LNK files originally located?
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# cd /mnt/windows_mount/Documents\ and\ Settings/vibranium/Recent/

# exiftool Metal\ Alloy\ List\ Research.lnk

# exiftool Detailed\ Vibranium\ R\&D\ Documents.lnk

8. When was the FIND.EXE Command executed last? Can you tell what the attacker was possibly looking
for? Which directory name were most of those files located in?

9. When was the last emd . exe executed?

10. When was the last net . exe executed? What do you think the remote IP was that net was used
against?

11. Have we seen the combination of cmd.exe, net.exe, 10.3.58.5, and Z: used in any previous analysis
prior to the super timeline? What was the full command that was executed based on prior analysis
and what can we correlate via timeline analysis?
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12. EXTRA: Also in the memory exercise, we saw that pe.exe was one of the artifacts found in the output

from csrss that executed c: \windows\system32\dllhost\svchost.exe on 10.3.58.5.
When was pe . exe last executed? What do you think the original name of this service is? Are there
any other systems that might have been the target of the pe.exe? What is the IP address of that
system?

13. EXTRA: Recover the email from the Outlook.pst file that has the 2011-W2.zip file as an attachment.

What is the md5 of the message that it was a part of? What is the md5 of the zipfile? What is the IP
address of the sender?

# cd /mnt/windows_mount/Documents and Settings/tdungan/Local
Settings/Application Data/Microsoft/Outlook

# cp Outlook.pst /cases/xp-tdungan-c-drive/

# cd /cases/xp-tdungan-c-drive

# pffexport Outlook.pst

# cd Outlook.pst.export

# £find . | grep zip

# cd Top\ of\ Personal\ Folders/Inbox/Message00274/
# md5sum Message.txt

# cat Message.txt

# mdSsum Message.txt
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# cd Attachments/

# mdSsum 2011-W2.zip

# cd ..

# cat InternetHeaders.txt
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Exercise — Questions With Step-by-Step

1. Initially scan through the timeline for getting a feel for the difference between the filesystem timeline
and the super timeline. (5 Minutes Max)

2. Using the same questions from Exercise File System Timeline, see if they would have been easier to
answer using the Color Super Timeline. (10-15 Minutes Max) Do you see any additional information
that you can discern?

3. What additional artifacts are now clearly visible around the time that winclient.reg and the
C:\windows\system32\dllhost directory were created? What time was the reg.exe
executable run? Why was reg.exe executed at this time? What time was the
\ControlSet00l1l\Services\Netman\domain key last modified?

/272012 20:33:16 A,
/272012 20:33:17 A
/242012 20:3317 .C

/272012 20:33.27 .8
3f2/2012 30:34:26 . B
Ar3/3012 20:35:10 L8
47242012 20:35.10 C

3272012 20:35:49 .,
47272012 20:36:03 LB
4272032 2036148 .8
(/272082 2003648 M.
$/2/2012 20:37:14 ..

Firefox History hitp:/www.irs.gov/ (Internal Resenue Service] [count: 1] Host: www.irs.gov visited from: http//207.58.245.179/ (107.58.245.179) (URL n
Prafetch [PXNEZY1TIISS. EXE] wis exacuted - run count 1 path: \DOCUME*I\TDUNGAN\LOCALS“A\TEMP\PKXEZYATIIS8.EXE hash: Ox0B

NIFS_DEFEC! crime:mtime TSK/Documents and Settingsftdungan/Local Settings/Ternp/hapedfdata tdungan
[P 3 SIS SILEATINIH TSK: /WINDOWS /Prefatch/PKXEIY ITHIB.EXE-OBCBF198.pf

NTFS_DETECT cetinve TSRAWINDOWS/system32/dithest

NTFS_DETECT wetinve TS AWINDOWS system32fdithest/winclignt.reg

NTFS_DETECT ciimesmtinse TSK/WINDOWS/system32/dithost Awinclient,reg

NIFS_DETECT ctimesmtime TSK/WINDOWS/system22dlihost

NTFS_OETECT cetine TSK:/WINDOWS/Prefetch/REG.EXE-DD2ASSFT.pl

WinEVT 560 / Ox0230] Severily: Success Record Nomber: 90237 Event Type: Unkrown 16 Event Category: 3 Saurce Name: Security Computer Nam
WIinEVT (560 / Dx0230] Severity: Success Record Numbet: 92237 Event Type: Unkpown 16 Event Category: 3 Saurce Name: Security Computer Nam
Mactime Bodyfile [Handle [Key)] MACHINEYSYSTEMYCONTHOLSE OGS SERVICESANETMANSDOMAIN svihast.exe D 3296/PPI0: 1900/P0set: 0x0a0135f0

e C:\WINDOWS\system32\dllhost was created at 4/2/2012 at 20:34:26 EDT

e reg.exe was executed at 20:36:03 -10 seconds — 20:35:53

e reg.exe was executed to add the beacon’s (svchost.exe) configuration information

e /ControlSet001/Services/Netman/domain was last modified at 4/2/2012 at 20:37:14

4. Immediately before the winclient.reg was executed on the system using the reg.exe command, we
can see an interesting event at McLogEvent. What time was this event detected? What do you think
this could mean?

McLogEvent/257;Info;The Scan was unable to scan password protected
file 2011-W2.zip/2011-W2.pdf. Scan engine version used is 5400.1158
DAT version 6498.0000.

e PDF’s are often used for spearphishing attacks. This could be an indicator that it wasin a

protected zipfile to protect it from being scanned by McAfee A/V protection.

5. In many cases, an easy way to find adversary footprints on your network is to identify TTPs that they
use. The use of the “AT” command is a common advanced adversary technique to help in lateral
movement by first uploading a file to remote system and then using the “AT” command to execute it
at a predetermined time.
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For the tdungan system, what time was the AT.EXE command first executed? Immediately
surrounding that event we see an indication that a remote machine might have been involved. What
directory was mounted of the remote machine? What is the IP address of that system? Why do you
think the remote system was involved? What is the significance of the remote system?

/A/2012 13:24:59 M.
AS2012 13:30:59 M,
1/4/2€12 13:24:43 .8
42012 13:29:33 M.
4/4/2C12 13:29:33 M...
H/4/2C17 13:29:33 M.
4/4/2012 13:48:10 ..

/472012 14:05:29 A.
A/1/2C12 14:05:29 M.
/42012 14:05:29 M.
W/4/2012 14:05:30 M.
A/2012 14:05:39 .C.
|4/4/2012 14:07:30 .8

NTYUSER key [\Software\MicrosofltyWindows\CurrentVersion\Expiorer \MauntPoints 2\8#10.3. 58,4805 swindowsifsy stern32) BaseClass: [REG_5Z] Dilve

NTUSER key NSofwars\Microsoft\Windews\CurrantVerian\Explorer\MountPointsi] Remare _Server: 11.3.58.4 Share_Name: \CS\windows\system
NTFS, DETECT crtime TSK: /WINDOWS/Prefatch /AT, EXE-27700D18.pf

NTUSER key P\Softwaze\Sysinternals) Value: No values stored in key,

NTUSER key [\Software\Sysinternais\Pstxec| EuiaAccepted: {§EG_DWORD_LE] 1

NTUSER key [\Softwarej Vatue: No values stored in key.

MSIE Cache File URL record Location: hitps://Ih6.googleusercontent.comy/- OniX ENGUE/TrOhCho X/ AAAAAAAAGYE/ X ipwAs 21k60/5512/CLF 10272011 0000 jpa2v

WinPrefetch [Prafatch [WMIC.EXE] was axecuted - run count 6 path: \WINDOWS\SYSTEM32\WBEM\WMIC.EXE hash: Ox38772CC6 volume: 1 [sarisl ni,
NTYUSER key N\SeftwareiMicroseft] Value: No values stored in key.

NYUSER key [\Seftware\Microscft\Wbem) Value: No values stored In key.

NTUSER key NSaftware\Microsoft\Whem\WMIC] WMICLC: [REG_DWORD LE] 1033 mofcompMUIStatus: [REG_DWORD,_LE] -1

LM A F U TRHGEY TSK: /WINDOWS fPrefetch/\WMIC.EXE-3B772CC6. pf

NTFS_DETECY crtime TSK:/WINDOWS fPrafeteh fTASKLIST. EXE-10D94B23. af

e AT.EXE was first executed on 4/4/2012 at 13:24:43 EDT minus 10 seconds @ 13:24:33 EDT

e The IP Address of the remote system is 10.3.58.4

e The directory mounted was c:\WINDOWS\system32

e 10.3.58.4is SHIELDBASE Domain Controller

6. Listall the any other systems remotely use by mounting the C$ share. When were they last
mounted? Why is it possible that we can see that 10.3.58.5 was mounted twice? Which file and
directory did the first entry originate from?

4/6/2012

4/4/3012 12:14:59 V..
4/4/2012 15:07:53 V...
4/5/2012 10:14:23 M.
4/5/2012 11:36:37 M...
15:21:56 M.

NTUSER key
NTUSER key
NTUSER key
NTUSER key
NTUSER key

[\Software\Micresoft\Windows\CustentVersion\Explorer\MountPoints2] Remote_Server: 10.3.58,4 Share_Name: \C§\win{
[\Software\Microsoft \Windows\CurrentVersion\Explorer\MountPeints2} Remote_Server: 10.3,58.4 share_Name: \G\fo
[\Softwam\M|cmseh\Windows\CmemVersmn\Expicmr\MountFomtxZ} Remote Sewer‘ 10.3.58.6 Share_Name: \C$ Type
[\Sohwam\Microsoﬂ\Wnndows\&ment\larsmn\!xplnmr\MountPomtsz] Remnote_Server: 10.3.58.5 share_Name: \C$T pel
[\Software\Microsoft\Windows\CurrentVarsion\Explorer\MountPoints2] Remote_Server: 10.3.58.5 Share_Name: \C$ Typg]

e 10.3.58.4 c:\Temp was last mounted at 4/4/2012 @ 15:07:53 EDT

e 10.3.58.5 C:\ was last mounted at 4/6/2012 @ 15:21:56 EDT

e 10.3.58.6 C:\ 4/5/2012 @ 10:14:23 EDT

¢ 10.3.

\MountPoints2] Remote_Server: 10.3.58.5 Share_Name: \CS TRNGOIIEIEELLEEPEVIERIL VTSSO Iy AT
LIPS T ST T U R LS [ELO DA LEN S TSK:/Documents and Settings/SRL-Helpdesk/NTUSER.DAT

.1 filename

58.5 was mounted by two separate users based on the directories. One of the entries came

from

the NTUSER.dat file associated with the vibranium user. The 2" entry came from the SRL-

Helpdesk/NTUSER.DAT user account

7. 0On4/4/2012, the user vibranium executed EXCEL.exe, what two files did he open for the first time?
What types of files are those? Where are they originally located?
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47472012 12:51:21 MACB Filebxts key File extension .xlsx opened by EXCEL.EXE

47472012 12:51:22 MACB [ETTEYHINE T30 UEME_RUNPATH:C:/Program Files/Microsoft Office/Office12/EXCEL.EXE

474742012 12:51:22 .C. NTFS SMFT C:/Program Files/Microsoft Office/Office 12/EXCELEXE

47442012 12:51:22 ..B NT:S SMET C:/DPocuments and Settings/vibranium/Recent/Metal Alloy List Research.Ink

4472012 12:51:22 .B  NTFSSMFT €:/Documents and Settings/vibranium/Recent/Detailed Vibranium R&D Documents.tnk
47442012 12:51:22 MACB NTUSER key Software/Microsoft/Windows/CurrentVersion/Exploret

47442012 12:51:22 .8 NIFS SMFT C:/Documants and Settings/vibranium/Lacal Settings/History/History JES/MSHist0120
4/4/2012 12:51:22 M.B  NIFS SMFT C:/Documents and Settings/vibranium/Local Settings/History/Histary. lES/MSHist0120
4/472012 12:51:22 MALB NTUSER key Software/Microsoft/Windows/CurrentVersion/InternetSetiings/5.0/Cache/ExtensibleCq
47472012 12:51:22 MACE NTUSER key Software/Microsoft/Windows/CurrentVersion/InternetSettings/5.0/Cache/ExtensibleC

47442012 12:51:29 MACB Bld i) EXCEL.EXE-34CB65E9, pf: EXCEL.EXE was executed

e C:\Documents and Settings\vibranium\Recent\Metal Alloy List

Research.lnk

e C:\Documents and Settings\vibranium\Recent\Detailed Vibranium R&D
Documents.lnk

# cd /mnt/windows_mount/Documents\ and\ Settings/vibranium/Recent/

# exiftool Metal\ Alloy\ List\ Research.lnk

xifTool Version Nuamber
ile Name

: 8.10

: Metal Alloy List Research.lnk

irectory -

ile Size : 1349 bytes

ile Modification Date/Time : 2012:94:64 16:51:39400:00
ile Permissions I FWXPWXTWX

ile Type : Windows Shartcut

IME Type : application/octet-strean
lags : IDList, LinkInfo, RelativePath, WorkingDir, Unicode
ile Attributes : Archive

reate Date 1 2012:03:68 22:11:26+00:69
ccess Date : 2812:64:04 16:51:38+06:00
odify Date : 2012:63:68 22:11:26+080:685
arget File Size 1 68346
Icon Index : (nene)

un Window : Normal

ot Key : {acne)

arget Fite DOS Name : METALA-~1.XLS

rive Type : Fixed Bisk

olume Label
Local Base Path

: C:\Documents and Settings\tdungan\My Documents\Alloy Research\Detailed Vibranium R&D Docume

ts\Hetal Alloy List Research.ilsx

elative Path
Research.xlsx
orking Directory
ts

achine ID

: ..\..\tdungan\My Documents\Alloy Research\Detailted Vibranium R&D Documents\Metat Alloy List
: C:\Documents and Settings\tdungan\My Documents\Alloy Research\Detailed Vibranium R&D DRocume

1 wks-winxp3Zbit

e C:\Documents and Settings\tdungan\My Documents\Alloy

Research\Detailed Vibranium R&D Documents\Metal Alloy List

Research.xlsx

e The file is an EXCEL workbook

# exiftool Detailed\ Vibranium\ R\&D\ Documents.lnk
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ExifYool Version Number
File Name
irectory
ile Size

File Peraissions

Fite Attributes

dify Date

Icon Index

File Modification Date/Time

: 8.16
: Detailed Vibranium R&D Documents.ink

1 954 bytes

: 2612:04:04 16:59:38+00:80

1 FWXTWXIWX

: Windows Skortcut

: application/octet-strean

: IDList, LinkInfo, RelativePath, Unicoce
+ Directory

: 2612:63:08 22:16:51+480:060

: 2012:94:04 16:59:39+00:680

1 2812:04:04 16:59:38+00:60

t ..\..\tduegan\My Documents\Alloy Research\Detailed Vibrapium R&D Documents
: wWks-winxpizbit

]

(none)
Normatl
(nore)
Fixed Disx

€:\Docuaents and Settings\tdungan\My Cocuments\Alloy Research\Detailed Vibranium R&D Docume

e C:\Documents and Settings\tdungan\My Documents\Alloy

Research\Detailed Vibranium R&D Documents (FOLDER)

e The file points to a folder, not a file (note with LNK files, you sometimes will have a hard time

differentiating between a file and a folder without examining the actual target file information

stored inside the LNK file itself.)

8. When was the FIND.EXE Command executed last? Can you tell what the attacker was possibly looking
for? Which directory name were most of those files located in?

4/5/2012 10:47:30 A, NTFSSMIFT
A/512012 10:37:30 A, NTFS SMFT
47573012 10:18:24 MACE LRl
4452032 10:18:24 A.  NTFS SMFT
41572017 10:18:34 M.LB  NTFS SMIFT

475720312 10:20:25 A NTFS SMFT
47572052 1020:38 A, NTFSSMAFY
47512612 10:20:52 A, NTFS SMET
47572012 10:21:05 A NTES SMFT
4/5/2052 10:21:16 A NTFSSMFT
&/522012 1021:31 A, NTFSSMFT
4¢45/20612 10:21:31 A, RIFSSMFT
4522082 $0:21:31 A NTFS SMFY
47582010 10:21:47 A, NTESSMFT

67572012 10:14:23 MACR LRI e g

&

tings/tdungas/My Documenis/Backstopped Accounts - RED Costs Afloy Research/Credit-Card Numbers-For-Research.ds

C:/Documents and

T/ Dotuments and Settings/tdungan/My Documents/Backstapped Accounts - RED Costs Allpy ResearchyLC Backstopped Awoints xlsx
FIND.EXE-DECI2F1E.pf: FIND.EXE was axecutod

C:IWINDOWSfsysteni32 ling exe

C:/WINDOWS /Prefatch/FIND. EXE-DEC32F1E.pf

C:/Documents asd Settings/tdungan/My Rocumeantsfalloy Research/Detailed Viorantum R&D Documents/SUCCESS-TEST-PLAN-VIBRANIUM-ALLOY-f
Ci/Rocuments and Setlings/tdunganiMy Documents/Alloy Research/Detailed Visranium RE&D Documents/ADAMANTIUM:Backgenund. docx
C:/Batuments and Sertingsfidungan/My Documents/alloy Research/Derailed Viorantum R&D Documents/Metal Alloy List Researchlsx
:/Dotumesnts and Settings/tdunganMy Documents/Alloy Research/Detailed Viorankum RE&D Documents/Researched Sub-Atomic Par ticles.xisx
C:/Cotuments and Settings/tduagan/My Bocuments/Alloy Research/Detailed Viarantum R&D Dacumients/The Shield Backgrourd and Ongolng Rese
Co/Documents 3nd Settingstdengan/My Cocuments/Alloy ResearchiDetailed Visranium R&D Documents/YIBRANIUM. dosx

Ci/Documents ynd Settings/tdungenfMy Documents/alloy Research/Detailed Viaranium R&D DocumentsfVibrainium.doce

C:/Documents snd Settings/tdungan/My Documents/Alloy Researeh/Deétalled Visranium RE&D Documents/Vibrainium(j do:

C:/Bocuments 3nd Settings/tdungan/My Documentsidlloy Research/Detailed Vioranium RED Pocuments/Dossier - Dr Myren Maclain.docx

e Find.exe was executed on 4/5/2012 at 10:18:24 EDT

e Based on the last access time of the files, it looks as though many document files in the directory

“Detailed Vibranium R&D” were last accessed.

9. When was the last emd . exe executed?
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4/6/2012 152022 A
4/6/2012 15:20:31 AL
Af6/2012 15:21:24 A,
4/6f2012 15:21:27
4/6/2012 15:21.27
4642012 15:21:27
4/6/2012 152127
4/6/2012 15:21:27
A/6/2012 15:21:27
46,2012 15:21:37
3672012 1%:21:27
/642012 15:21:27
4/6/2012 15:21:56
4/6/2012 1%:21:56
4/6/2012 15:21:56
A/6/2012 15:22:20
a/6/2012 15:22:20
4/6/2012 15:22:20
d4/6/2012 15:22:20
4/6/2012 15222206
4/6/2012 15:22:21

h-

PEZZPPEIZZ2eprprPeril

WinPrefatch Prefetch [CMD.EXE] was executed - run count 60 path: \WINDOWS\SYSTEM32\CMD. EXE hash: 0x087B84001 volume: 1 s
I AR Tt Ll TSK:/WINDOWS/Prefetch/CMD.EXE-087B4001. pf

NTFS_DETECY atime;ctin TSK/WINDOWS/system324¢mid.exe

NTFS_DETECT atime TSR/ WINDOWS/system32/net.exe

NTES_DETECT atime TSK/WINDOWS/system32/netuil dit

NTFS_DETECT atime TSK/WINDOWS/systemI2ZSET269.tmp; TS/ WINDOWS/ sy stem32/ntlanman.dlf

NTFS_DETECT atime T5K:/WINDOWS/system32/netuin.dl

NT4S_DEHECT atime TSK:/WINDOWS/ system32Znetmsg.dli

NTFS_DEFECT atime TSK;/WINDOWS/system327SET384, tmp; TSK:/WINDOWS/systen32/daveint.dil

WinPrafetch Prefetch [NET.EXE]) was exacuted - rup count 66 path: \WINDOWS\SYSTEM32\NET.EXE hash: Gx01AS3C2F volume: 1 [sar
NTFS_DETECT atime TSK:/WINDOWS/system32/SET374.tmp TSK A WINDOWS/ systerr32 /drprov.dil

[Nis e atle E IR TSK: /WINDOWS/Prefetch/NET. EXE-OLASSC2F.pf

NTUSER key NSoftware\Microselt\Windows\CurrentVersian\Explorer \MountPoints2] Value: No values stored in key.

NTUSER key [\Saftware\Microsoft\Windows\CurrentVarsion\Explorar\MauntPolnts2] Remote_Sarvar:. 10,3.58.5 Share Name: \C5 T
NTUSER key [\Software\Microsoft\Windowsa\CurrentVarsion\Explorar\MauntRointa2\##10.3.58.54C3] BaseClass: [REG_SZ] Drivae _Cc
NTFS_DETECT atme TSK:/WINDOWS/system32/pe.exe

WinPrefetch Prafatch [PE.EXE] waz executed - run count 30 path: \WINDOWS\SYSTEM32\PE.EXE hash: Ox0DC593C2 volume: 1 [serial
NTUSER key \SoftwareySysinternals] Value: No vafues stored in key.

NTUSER key NSoftware] Value: Na values stored in key,

NTUSER key [\Software\Sysinternais\PsExec] Euladccepteri: [REG_DWORD_LE) 1

LS A (I EHTNSL TSK:/WINDOWS/Prafatch PE.EXE-0DC593C2.pf

o cmd.exe was last executed on 4/6/2012 @ 15:20:22 EDT

10. When was the last net . exe executed? What do you think the remote IP was that net was used

against?

4/6/2012 15:20:22 A,
4/6/2012 15:20:31 A
4/6/2012 15:21:24 A
4/6/2012 15:21:27 A
A/6/2012 15:21:27 A,
47612012 15:2127 .
4642012 15:21:27 .
4/6/2012 15:21:37 .
4/6/2012 15:21:37F .
A/6/2012 15:21:27
4/6/2012 15221:27 .
4/6/2012 15:21:27
4/6/2012 15:21:56
47642012 15:21:56
4/6/2017 15:21:56
4/6/2012 15:22:2CG A,
4/6/2012 15:22:20 A.

A4/6/2012 15:22:21 A

SEZZrrEDPprr

4/6/2012 15:22:20 M...
4/6/2012 15:22:20 M...
4/6/2012 15:22:20 M...

WinPrefatch Prefetch [CMD,EXE] was executad - run count 60 path: \WINDOWS\SYSTEM32\CMD, EXE hash: Ox(8784001 volume: 1 [4
[FICWr Qe NG T TSK: WINDOWS fPrefetch JCMD.EXE-OB7B4001. pf

NTFS_DETECY atimeetin TSK/WINDOWS/systemi32/emd.exe

NTFS_DETLCY atime TSK:/WINDOWS/systemIdinet .exe

MTFS_DETECT atime TEK:/WINDOWS/systerns32/netuil.dli

NTFS_DETECT atime TSK:AWINDOWS/system32/SET 289 tonp; TSK/WINDOWS /sy stern 32 /ntlanman.dif
NTFS _DETECY atime TSX:/WINDGWS/system32/netui0.di
NTFS_DETECT atime TSK:/WINDOWS/system32/netmsg.dif
NTFS_DETECT atime TSK:/WINDOWS/system32/SET384.tmp, TSI WINDOWS/systerr 32 fdavdlnt dit

WinPrefetch Prefatch [NET.EXE] was axecuted - run count 66 path: \WINDOWS\SYSTEM32\NET.EXE hash: Ox01AS3C2F volume: 1 [ser
NTFS_DETECT atime TS AWINDOWS/system327SET 374 tonp; TSR /WINDOWS/ systerr 32 fdrprov.dll

T3 AL PRSI TSK: /WINDOWS /Prefatch /NET.EXE-01AS3C2F. pf

NTUSER key \Software\MicrosoftiWindows\CurrentVersiomiExplorer \MountPoints2] Vafue: No values stored ir key.
NTUSER key [\Software\Microsoft\Windowa\CurrentVersion\ Explorer\MountPolnts2] Remiote_Server; 10.3.58.5 Share_ Name: \CS 7
NTUSER key [\Softwara\Microsoft\Windows\CurrentVarsion\Explorar\MountPoints2\§#10,3.58.58¢5] BaseClass: mas_sz] Dtive _C¢

NTFS_DETECY atime TSK:/WINDOWS/system32épe.exe

WinPrafetch Prafetch [PE.EXE] was executed - run count 30 path: \WINDOWS\SYSTEM32\PE.EXE hash: 0x0DC593C2 volume: 1 [serial
NTUSER key DSoftware\Sysinternais] Value: No values stored in key,
NTUSER key fSoftware] Value: No values stored in key.

NTUSER key [\Software\Sysinternals\PsExec) EulaAcceptes: [REG_DWORD _(£] 3
NIt FUIIENAL TSK:/WINDOWS /Prefetch /PE.EXE-0DCS93C2,pf

o

net.exe was last executed on 4/6/2012 @ 15:21:27

net.exe was probably used against 10.3.58.5
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11. Have we seen the combination of cmd.exe, net.exe, pe.exe and 10.3.58.5 used in any previous

analysis prior to the super timeline? What was the full command that was executed based on prior
analysis and what can we correlate via timeline analysis?

Username: NT AUTHORITNSYSTEN SID:  S5-1-3.18
Parent: smssee (B78) Path: \IDCAWNDOWSsystem32
Arguments: CWINDOWS\system 32\ corss. ewe Cp ectDirectory=\Wirdows SharedSection 1024 3071 512 WindowsaDn SubSystemTypesVWingows ServerDisbasesr L ServerD

vibranium

String

WINDOWS\system32umd.exe - net use 2: \110.3.58 5\CS /USER:shieidbase\vibranium hailhycra

e Yes. We saw the command in our memory analysis of strings. We can see the use of the net.exe
command remotely mountingthe C$ 0of10.3.58.5

o The fullcommandis: net use z: \\10.3.58.5\C$ /USER:sheildbase\vibranium
hailhxdra

12. When was pe . exe last executed?
e pe.exe was last executed on 4/6/2012 at 15:22:20 EDT

4/6/2012 15:20:22
4/6/2012 15:20:31
4/6/2012 15:21:24 .
A/6/2012 15:21:27 .
A/6/2012 15:21:27 4
4/6/2012 15:21:27
4/6/2012 15:21:27
4/6/2012 13:21:27 A
A/6/2012 15:21:27 .
4/6/2012 15:21:27
4/6/2012 15:21:27 .
4/6/2012 15:21:27
4/bf2012 15:21:56
4/6/2012 15:21:56

WinPrefetch Prefetch [CMD.EXE] was executed - run count 60 path; \WINDOWS\SYSTEMS32\CMD.EXE hash: 0x08784001 voluma: 1 (s
[MECIAL ARV IERa () TSK:/WINDOWS/Prafetch/CMD, EXE-D87B4001.pf

NTFS_DETECT atime;ctin TSK:/WINDOWS/system32/cmd.exe

NTES_DETECT atime TSK:/WINDOWS/systern32/net.exe

NT#S_DETECT atime TSK/WINDOWS/ system3dfnetuildl

NTFS_DETECT atime TSH:/WINDOWS sy stem32/SETION, trnp; TS WINDOW S/ sy stem 32 /ntlanman.di

NT#S DETECY atime THKIWINDOWS/ systern 32/ netulD.dlf

NTFS_DETECT atime TSK:/WINDOWS/system32/netmsg.dif

NTFS _DETECT atinte TSK:/WINDOWS/system32/SET 384, tmip; TSK/WINDOWS/ system 32/ daveint.dll

WinPrefetch Prefatch [NET.EXE] was executed - run count 66 path: \WINDOWS\SYSTEM32\NET.ENE hash: 0x01A53C2F volumae: 1 [sar
NTFS_DETECT atime TSK:/WINDOWS/system32/SETI74 tmp; TSK/WINDOWS/system 32 /drprov.dil

LM da @ LN TSK: /WINDOWS/Prefetch/NET.EXE-OLAS3C2F, pi
NTUSER key Q\Soﬂwqre\Mrcrosoft\mefews\(unemVersmﬂ‘\Exp!nre;\MoumPcmlsZE Value: No values storad in key.

NTUSER key i yof _\aﬂmwm\halwwom?nhm] Remote_Server: 10.5.58.5 shfq_mnm (=5
4/6/2012 15:21:56 NTUSER key | are\Microsoft\Windows\CurrentVarsion\Explorsr\MountPolntsd\#¥10.3.58.58CS] BaseClass: [AEG._57] Drive _Cq
4/6/2012 15:22:20 NTFS_DETECT atime TSK:/WINDOWS/system32/pe.exe

4/6/2012 15:22:2C A, WinPrafatch Prefetch [PE.EXE] was exacuted - run count 30 path: \WINDOWS\SYSTEM32\PE.EXE hash: 56x0DC593C2 volume: 3 [serial
4/6/2012 15:22:20 M... NTUSER key DSoftware\Sysinternals] Value: No values stored in key,

4/6/2012 15:22:20 M.. NTUSER key MSoftware] Valiie: No values stared in key,

47/6/2012 15:22:20 M.,  NTUSER Xey DSoftwarel SysinternalsiPstxec] Euladcceptec: [REG_DWORD E6]1

A/6/2012 15:32:21 A, R ST TRERA I TSK: /WINDOWS/Prefetch/PE.EXE-ODC593C2.pf

L

= o

> >

LEr»pep

P TX

¢ What do you think the original name of this service is?

o pe.exe is “PSEXEC” — you can see registry keys associated with sysinternals during the 1** time
of execution of pe.exe
e Are there any other systems that might have been the target of the pe.exe?
o Yes
e What is the IP address of that system?
o The remote |P address of the system is 10.3.58.5
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13. EXTRA: Recover the email from the Outlook.pst file that has the 2011-W2.zip file as an attachment.
What is the md5 of the message.txt that it was a part of? Were there any hyperlinks in that email
message? What is the md5 of the zipfile? What is the IP address of the sender?

# cd /mnt/windows_mount/Documents\ and\ Settings/tdungan/Local
Settings/Application\ Data/Microsoft/Outlook

# cp Outlook.pst /cases/xp-tdungan-c-drive/
# cd /cases/xp-tdungan-c-drive

# pffexport Outlook.pst

# cd Outlook.pst.export

# find . | grep zip

./Top of Personal Folders/Sent Items/Messagef6065/Attachments/New-Site-HQ-And-Landing-Pad.zip
./Top of Perscnal Folders/Inbox/Messageff274/Attachments/2611-W2.zip

# cd Top\ of\ Personal\ Folders/Inbox/Message00274/
# mdSsum Message.txt

# cat Message.txt

e 3e7ceadl8a5e237a106ef13850c8daee Message.txt

'aear Timothy Dungan,

There were last minute changes to the IRS W-2 reparting system for Tiling

your tax returns for fiscal year 2811, A new IRS form W-2 needed to be

generated to account for the 2011 payroll tax extension recently passed

by congress that was not accounted for in the previous W-2 mailed to

your hkome, For this year, we recommend you tile an amendment to your

tax retura. Not only «ill you see a bigger income tax refund, but your overall
taxable income amount will aiso drop, possibly resulting in qualification for a lower
tax bracket.

Below is a link to your new 2011 W-2 from Stark Research Labs that includes the payroll tax
credit. ¥We do apologize for getting this out so tate and immediately
prior to your filing deadiine on April 15, 2612. The password is your username of ycur system login.

http: //bit. ly/GEUMGQ

Please forward any questions back to me at mhill.shield@yahco.com

Thank you,
Maria Hitp
Director, SHIELE

e Hyperlink http://bit.ly/GEUMQQ
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# cd Attachments/

# mdSsum 2011-W2.zip

o 7317b667e2falcf4732f946e61f0bd72 2011-W2.zip

# cd ..

# cat InternetHeaders.txt

Return-Fath: mhill.shield@yahoo.com
Received: from amS-vm2.bullet.mail.nel.yahoo.com ({98.138.90.153)}
by mail.stark-research-labs.com
; Tue, 3 Apr 2012 808:27:41 +Q009

Received: from (98.138.96.56] by nm5.bullet,.mail.nel.yahoo.com with NNFMP; 03 Apr 2012 90:27:46 -0000

Received: from [28.138.89.252) by tm9.buliet.mail.nel.yahoo.com with NNFMP; 03 Apr 2012 €6:27:46 -96000

Received: from [127.6.0.1] by ompl@d44.mail.nel.yahoc.com with NNFMP; 83 Apr 2612 68:27:46 -0060
X-Yahoco-Newman-Property: ymail-3
X-Yahoo-Newman-Id: 938012,.46875. bm@ompl644.mail.nel.yahoo.com
Received: (qmail 36874 invoked by uid 66601); 3 Apr 2612 06:27:46 -0006
DKIH-Signature: v=1; a=rsa-sha256; c=relaxed/relaxed; d=yahoo.com; s=51024; t=1333412866; bh=rR1ABd0rfVRZWGbp2uylvorXiFncxvMy
xDONAmS4rss=; h=X»YHail-OSG:Received:X-Hailer:References:Hessage-ID:Date:From:Reply-To:Subject:To:In-Reply-To;HIHE-Version:Co
ntent-Type; b=ws4tZJCah+d+Veziln/rH5RLIGEBWLAZIIOVAhduHywaN/WBTD11nw7mudI2aYBedlyl/p2e RAWTYmE6bfqnBfcrdyXlicmY3Fe)4Xd3Ts8YBC2
xCoShFKtds7AGp+fuCYNOO5 juKgLCAMBEIVNTULAmFpLlb4uPHAXOX INOjvEs
fDomainKey-Signature:a=rsa-shal; g=dns; c=nofws;

s»51824; d=yahoc.com;
hnK‘YHail-OSG:Received:X~Haiter:References:Hessage-ID:Date:From:ReniyAIo:Subject:To:In-Reply-To:HIHE-Version:Content-Type;
b=RUg§ngquxGGPG7iqu+FrYyaPnSjﬁtdoDQHioNZVeT8r1632achyoijdJBfooSYaD4y14jngsenNiGrj7ax698xRN6:f+Id8vaNb22L£021Dc9fcu9y
JRNoVYEQEY j VHVF OWEqMS CpWndXE] LWYYIXSotkwwlXvhpghaPtlU=;
X-YMail-08G: q2HCFzOVH1kVOBotBcSYKYp2aW78E2ZQIUIRYLQGiNXkISRg

83PNVPZXxIKDTgq.s5YBAkzMPallcInMy . PXissloqDC865200. 10a0iq_B_N

FSmSRLbIALtFrmj 1A9SSuUM2E8KkOhuuHm_VzUyx9pt252CeLhES5UoISm3DDH

i4bRcUQWEpPWE1I1Tz6ee . 53a0E7yDMsqWfESB1SSBITZVREALK . MP43PRC. S

DfzgoxwwN_LNxcInamWjon{XsTU6aSFY8503GqiKuk_plXe?VrgDaySDddhy

hPi_Aylc.dQsOskddKkILLciFfS0Z808]) Lkw3hgRajvrlSTraN2pBUHBKhOR

49d4C2v ) yhd263f98ONPNgTaBrhqTScksWySXMFLALAS1Fxk. fQvLA4CrhYs

9tLvmf . mtsc30bmlisIL4f_L.QqP. h7wyDjb3m?Zd0qIDOGIKLECTjVPISZDT

¢3a50d . MnkRRTa85TgKag5A .«
Received: from [72.241.5.37) by webl222066.mail.nel,yahoo.com via HTTP; Mon, B2 Apr 2012 17:27:46 POT
X-Mailer: YahooMaitwebService/8.8.3117,340973
References: <1333384163.62371.YahooMailNeo@web122204.mail.nel. yahoo.com> <1333387467.39356.YahooMailNeo@web122206.mail . nel.ya
hoo.com> <1333396217.32396.YahooMailNeo@web122205,.mail.nel, yaheo.com>

e |P Address = 72.241.5.37
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[Exercise ~ Key Takeaways combined with Exercise File System Timeline

Suspicious binaries were identified in the following directory
o C:\windows\system32\dllhost\

o The dllhost directory was created on Mon Apr 02 2012 20:34:26 ESTSEDT

C:/WINDOWS/system32/dllhost/winclient. reg contained the registry settings for the
svchost.exe beacon

reg.exe executed winclient.reg to add the registry settings for the
svchost.exe file.

Additional possible malware was identified: C: \Windows\System32\hydrakatz.exe

The executable a.exe was executed multiple times and is usually last executed around the time the
hacker was last active on the system.

The rogue account, vibranium, was created around Wed Apr 04 2012 12:40:18

The following files were opened by the vibranium account:
o Metal Alloy List Research
o Detailed Vibranium R&D Documents
o SUCCESS-TEST-PLAN-VIBRANIUM-ALLOY-RESULTS
o Dossier - Dr Myron Maclain

The vibranium user added several outlook accounts and created a new pst file on Thu Apr 05 2012
12:07:58 found in C: /Documents and Settings/vibranium/Local
Settings/Application Data/Microsoft/Outlook/EXFIL.pst

The original spear phishing email was found in tdungan’s Outlook.pst file. It contained two methods
to try and execute code: a link and a zipfile containing a PDF

it is clear that 10.3.58.7 was a hop point to 3 other systems in the SHIELDBASE environment
o 10.3.58.4 (Domain Controller)
o 10.3.58.5 (Natasha Romanoff’s Win7 32 Bit system)
o 10.3.58.6 (Nick Fury’s Win7 64 Bit system)
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Exercise 15 - Volume Shadow Examinations

|Objectives [

s To examine methods to mount and examine volume shadows using the SIFT workstation

e  Explore techniques to extract data from multiple volume shadows in a Windows 7, Win8, or Windows
Server

e  Explore the RecentFileCache.bcf registry hive

o Use Timeline analysis techniques to quickly ascertain where key data might be found inside multiple
volume shadow snapshots in a disk image

Mount Windows 7 Image and Mount Multiple Volume Shadows

(Note: Some of this might already be accomplished via earlier exercises, but this is the state that we hope your system is in prior
to the start of this exercise. Just in case your system rebooted, we are including a guide to help you get back to the proper
analysis starting point prior to the beginning of this exercise.)

1. Start your SIFT VMware Workstation in VMware Workstation.
2. Login the VMware machine.

» LOGIN = sansforensics

» PASSWORD = forensics

3. Start a terminal, elevate your privs to root, and change into the /cases/win7-c-drive directory.

$ sudo su -

# cd /cases/win7-32-nromanoff-c-drive

4. Mount your evidence files so you can see the win7-32-nromanoff-c-drive raw image and files/folders
from the system.

# ewfmount win7-32-nromanoff-c-drive.EO0l /mnt/ewf_mount2 /

# mount -o ro,loop,show sys files,streams_interf ace=windows
/mnt/ewf mount2/ewfl /mnt/windows mount2
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5. Examine how many VSS snapshots exist inside the win7-32-nromanoff-c-drive raw image

# vshadowinfo /mnt/ewf mount2/ewfl

How many Snapshots stores exist? 4

You should see 4 stores.

Store 1: Creation Time = Mar 15, 2012 23:12:03
Store 2: Creation Time = Mar 23, 2012 04:00:15
Store 3: Creation Time = Mar 31, 2012 04:00:12
Store 4: Creation Time = Apr 04, 2012 20:05:02

6. Mount raw image VSS using vshadowmount and mount all logical filesystems found in snapshot

# vshadowmount /mnt/ewf mount2/ewfl /mnt/vss
# cd /mnt/vss
# for i in vss*; do mount -o

ro,loop,show sys files,streams interface=windows $i
/mnt/shadow _mount/$i; done

When you press <RETURN> after inputting the above command -~ you might see an error pop up. One of
the snapshots in this image is corrupted. Change directories to the /mnt/shadow_mount directory and
see if you can determine the store # that failed to mount properly.

# cd /mnt/shadow_mount/
# 1s

vssl vss2 vss3 vssd

You will notice that the vss1 failed to mount properly. That is the corrupted VSS. This happens from time
to time and is nothing to worry about. But notice the error, this will be a good way to identify if a VSS has
been corrupted.
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VSS RecentFileCache.bcf Examinations — Questions

1. Examine the RecentFileCache.bcf file found in the C: \Windows\AppCompat\Programs folder in
each of the 3 mounted volume shadow stores. Which of the volume shadow snapshot
RecentFileCache.bcf files will likely contain data and why?

# cd /mnt/windows_mount2/Windows/AppCompat/Programs

# 1s -la (Note:lfRecentFileCache.bcf is 20 bytes or smaller it is likely empty)
# rfc.pl RecentFileCache.bcf

# cd /mnt/shadow_mount/vss2/Windows/AppCompat/Programs

# 1s -la

# rfc.pl RecentFileCache.bcf

cd /mnt/shadow_mount/vss3/Windows/AppCompat/Programs

ls -1a

rfc.pl RecentFileCache.bcf

* #* =

cd /mnt/shadow_mount/vss4/Windows/AppCompat/Programs

E- 3

ls -la.

# rfc.pl RecentFileCache.bcf

2. Parse the RecentFileCache.bcf file that you discovered in step 1. List the programs that were executed?

# cd /mnt/shadow_mount/vss4/Windows/AppCompat/Programs

# rfc.pl RecentFileCache.bcf
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PS V0L SV ¢ Ak
tﬂ;&.{‘/"\/?.d'_f{d PV,

3. On what day were these programs executed? What was the time the last program (unknown) was
executed?

# 1ls —-full-time /mnt/shadow_mount/vss4/Windows/AppCompat/Programs
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VSS RecentFileCache.bcf Examinations — Questions with STEP BY STEP

1.

Examine the RecentFileCache.bcf file found in the C: \Windows\AppCompat\Programs folder in
each of the 3 mounted volume shadow stores and the current image. Which of the volume shadow
snapshot RecentFileCache.bcf files will likely contain data and why?

VSS4 — it is the only RecentFileCache.bcf file that has a filesize larger than 20.

root@siftworkstation:/mnt/windows_mount/Windows/AppCompat/Programs# ls -la
total 32

drwxrwxrwx 1 root root 4096 Apr 6 2012 Eﬂ
drwxrwxrwx 1 root root 0 Jul 13 2009
-FWXrwxrwx 2 root root 20676 Apr 6 2012 afiny iR
“rwWXrwxrwx 2 root root 20 Apr 6 2012 Recentif:

root@siftworkstation:/mnt/windows mount/Wmdows/AppCompat/Programs# cd /mnt/shag

oW mountﬁvssd.}'h'@dows/AppCompat/Programs/ ls -1la

total 32 — Ratma S S—

drwxrwxrwx 1 root root 4096 Apr 4 20’7? IR e

Ry SR

drwxrwxrwx 1 root root ¢ Jul 13 2009 ,} a2
-rwxrwxrwx 2 root root 20676 Apr 4 2012 ¢/ | PR
-rwxrwxrwx 2 root root | 142 Apr 4 2012 oo o |-

root@siftworkstation: /mnt/shadow mount/vssd/W;ndows/Apptompat/Programs# cd /mnt/
shadow_mount/vss3/Windows/AppCompat/Programs/; 1ls -la

total 28

drwxrwxrwx 1 root root 4096 Mar 20 2012 Eﬂ

drwxrwxrwx 1 root root 0 Jul 13 2009

-rwxrwxrwx 2 root root 20479 Mar 20 2012 Adiny ”;W: O
STWXTWXTWX 2 root root 20 Mar 20 2012 Recent

root@siftworkstation: /mnt/shadow mount/vssS/Wmdows/AppCompatfPrograms# cd /mnt
shadow_mount/vss2/Windows/AppCompat/Programs/, 1s -la

total 28

drwxrwxrwx 1 root root 4096 Mar 20 2012 E
drwxrwxrwx 1 roct root ¢ Jul 13 2009 L
-rwxrwxrwy 2 root root 20479 Mar 20 2012
STWXIWXrwy 2 root root 20 Mar 20 2012 |

root@siftworkstation:/mnt/shadow mount/vss2/Windows/AppCompat/Programs# I

Parse the RecentFileCache.bcf file that you discovered in step 1. List the programs that were executed?

# cd /mnt/shadow_mount/vss4/Windows/AppCompat/Programs

# rfc.pl RecentFileCache.bcf

C:\windows\psexesvc.exe
C:\windows\system32\tasklist.exe
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root@siftworkstation:/mnt/shadow_mount/vss4/Windows/AppCompat/Programs# rfc.pl RecentFileCache.bcf

o \windows\psexesvc.exe
c:\windows\system32\tasklist,exe

On what day were these programs executed? What was the time the last program (unknown) was
executed?

Use the last modification time of the file. 2012-04-04 15:48:47 UTC

root@siftworkstation: /mnt/shadow_mount# ls --full-time vss4/HWindows /AppConpat/Programs/
total 28

-TWXrWXrwx 2 root root 20676 2012-04-04 13:01:31.162634700 +0000 AEINV_PREVIOUS.xnl

-rWXrwxrwx 2 root root 142 2012-64-04 15:48:47.660714700 +0000 RecentFileCache.bcf
root@siftworkstation:/mnt/shadow_mount# |
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VSS SuperTimeline Examinations — Questions

A VSS Supertimeline will take a long time to complete. We cover how to accomplish it in the example
following this exercise, but in the meantime we have already prepped the timeline for you. You can find a copy

precooked for you in the /cases/win7-32-nromanoff-c-drive/precoocked/volume-shadow/
vss-supertimeline.xlsx

Open the copy of precooked for you in the /cases/win7-32-nromanoff-c-
drive/precooked/volume-shadow/vss-supertimeline.xlsx

1. Examine the PreFetch File IEXPLORE.EXE-1B894AFB.pf. Find the instances of that file in the timeline,
based on what we can examine what is the probable last 3 execution times of Internet Explorer based

on the Timeline only? HINT: The creation time of a Prefetch (.pf} file is the first time that application has

run. The modification time of a Prefetch (.pf) file is the last time the application was run. We are seeing multiple
modification times in the timeline due to additional entries provided via Volume Shadow Copies

Execution Time 1:
Execution Time 2:
Execution Time 3:

2. How many times can we tell that DEFRAG.EXE was executed based on the historical data provided by
the original image and the VSS images?

3. Examine the NTUSER.DAT information on the system for both vibranium and for nromanoff. Did the
vibranium account exist prior to 4/2/2012? Why? When was the vibranium account created on the
nromanoff system indicating the first time the user interactively logged in?

4. Does the C:\Windows\System32\dllhost\svchost.exe file exist on this system? First, what is the
creation time of the file? Second, when was the file likely REALLY created (per Access timestamp)?
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VSS SuperTimeline Examinations - Step-by-Step Guide

A VSS Supertimeline will take a long time to complete. We cover how to accomplish it in the example
following this exercise, but in the meantime we have already prepped the timeline for you. You can find a copy
precooked for you in the /cases/win7-32-nromanoff-c-drive/precooked/volume-shadow/
vss-supertimeline.xlsx

1. Examine the PreFetch File IEXPLORE.EXE-1B894AFB.pf. Find the instances of that file in the timeline,
based on what we can examine what is the probably last 3 execution times of internet Explorer based

on the Timeline only? HINT: The creation time of a Prefetch (.pf) file is the first time that application has
run. The modification time of a Prefetch (.pf) file is the last time the application was run. We are seeing multiple
modification times in the timeline due to additional entries provided via Volume Shadow Copies

A B & D J
date ~ time ~ timezon- MAC(~ short
3/22/2012 11:03:42 ESTSEDT .AB [Windows/?refetch/lEXPLORE.EXE-IBBQ&AFB.pf
3/22/2012 11:11:38 ESTSEDT M.C. /Windows!PrefetctEXPLOR-18894AF8.
4/3/2012 18:33:51 ESTSEDT M.. PANLEEN NSV I3 (I el AN T - LV W el
4/4/2012 7:48:23 ESTSEDT ..C. /Windows/Prefetch/IEXPLORE.EXE-1B894AFB. pf

 4/4/2012) 16:11:21 ESTSEDT M.C. indows/Prefetch/IEXPLORE.EXE-1B894AFB. pf

Execution Time 1: ~ 03/22/2012 —11:11:28 (remember the -10 rule)
Execution Time 2: 04/03/2012 — 18:33:41
Execution Time 3: 04/04/2012 - 16:11:11

2. How many times can we tell that DEFRAG.EXE was executed based on the historical data provided by
the original image and the VSS images?

date v time - timezon+ MAC~ short
TPAVPIO S SR S CRIE R I 1 ) N /Windows/Prefetch/DEFRAG.EXE-738093E8. pf
3/20/2012 18:47:11 ESTSEDT M.C. ]\Nindows/Prefetch/DEFRAG.EXE-738093[8.pf
3/30/2012 5:20:13 ESTSEDT M.C. /Windows/Pfefetch/DEFRAG.EXE-?SBOSSES.pf
472/2012 6:21:46 ESTSEDT M... /Windows/?refatch/DEFRAG.EXE-73809358.pf
VLR YRS TIS TR LT g Y ReNs /Windows/Prefetch/DEFRAG.EXE-738093E8. pf

Execution Time 1: 09/21/2011 - 01:15:53 (remember the -10 rule)
Execution Time 2: 03/20/2012 — 18:47:01
Execution Time 3: 03/30/2012 — 05:20:03
Execution Time 4: 04/02/2012 — 06:21:36
Execution Time 5: 04/05/2012 — 07:54:26
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3. Examine the NTUSER.DAT information on the system for both vibranium and for nromanoff
accounts. Did the vibranium account exist prior to 4/2/2012? Why?

date ~/time - timezon~ MA{-~ short

11/10/2010 3:22:13 ESTSEDT ..B /Users/nromanoff/NTUSER.DAT
3/22/2012 23.57:59 ESTSEDT M.C. /Users/nromanoff/NTUSER.DAT
3/30/2012 23:48:07 ESTSEDT M.C.  /Users/nromanoff/NTUSER.DAT
4/3/2012 17:19:53 £STSEDT ..B /Users/vibranium/NTUSER.DAT
4/4/2012 15:10:55 £STSEDT M.C.  /[Users/vibranium/NTUSER.DAT
4/4/2012 16:04:56 ESTSEDT M.C. /Users/nromanoff/NTUSER.DAT
4/6/2012 15:44:17 ESTSEDT MA.. /[Users/nromanoff/NTUSER.DAT
4/7/2012 17:04:56 ESTSEDT M.C. [fUsers/vibranium/NTUSER.DAT

The user account vibranium’s birthdate was created on 4/3/2012. We also know that there were
multiple VSS snapshots that were taken prior to 4/4/2012. This explains why we see multiple
modification times to the NTUSER.DAT files that existed for nromanoff and not for the vibranium
account,.

4. Does the C:\Windows\System32\dllhost\svchost.exe file exist on this system? First, what is the
creation time of the file? Second, when was the file likety REALLY created (per Access timestamp)?

3/31/2003  9:00:00 ESTSEDT ...B /Windows/System32/dithost/svchost.exe
4/3/20612 18:40:19 ESTSEDT .A.. /Windows/System32/dithost/svchost.exe
4/3/2012 18:40:36 ESTSEDT .A.. /Windows/System32/dilhost/winclient.reg
4/3/2012 18:40:39 ESTSEDT ...B _/Windows/System32/dllhost/winclient.reg

Yes, the svchost.exe file exists in the C:\Windows\System32\dllhost directory. It looks as though it
might have been created and “last accessed” around 04/03/2012 at 18:40:19. The birthdate of the
file was 3/31/2003 at 0900. This would indicate that the file is probably timestomped.

Remember since access time is turned off on Win7/8 systems by default, the only time the “accessed
time” is updated is when the file is created on a volume. The attackers might not have known this
and forgot to backdate the file. Note that this analysis technique will only work on environments
that have the access time turned off (Win7/Win8). Otherwise A/V is known to ruin access times on
system and the MFT $Filename timestamps would be the best way to tell. We will cover S$Filename
timestamps in the next couple of sections of the course.
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Exercise — Key Takeaways

e Volume Shadow Copies are critical to examinations on Windows 7, Windows 8, and Windows Server
systems. Make sure your administrators do not turn them off via Group Policy.

¢ Vibranium User first interactively logged into this system around 4/3/2012 at 17:19:53 EDT

¢ The svchost.exe malware is found on the system and created around 4/3/2012 at 18:40:19 EDT

FOR508 - SANS ©2015 Exercise 15 — Volume Shadow Examinations
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Exercise 16 — Extracting Stream Based Data

IObjectives '

e Extract stream based data from both the xp-tdungan memory image and disk image.

o Create a list of keywords based on case data we know about from earlier sources (timeline and
memory forensics).

«  Examine the stream data for both the memory image and disk image to determine what relevant data
could be analyzed in the case.

Exercise Preparation

1. Please ensure your evidence is mounted correctly at /mnt/windows_mount if not, please follow
Exercise 2 — Mounting Evidence Using SIFT again to mount your evidence.

# cd /mnt/windows_mount

# 1s

root@SIFT-Horkstatioq:/mnt/windows_mount# 1s

$Secure

If you do not see the above, then please follow directions in Exercise 2 — Maunting Evidence Using SIFT
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| There are two exercises question sets below

I EXERCISE 1 - Extract Stream Data from Memory

1. Step-by-Step Guide Setup
2. Questions

I EXERCISE 2 - Extract Stream Data from Disk Image

1. Step-by-Step Guide Setup
2. Questions
3. Questions with Step-by-Step Guide
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Extract Stream Data from Memory — Step-by-Step Guide J

1. Create a Keyword List.

# kedit /cases/xp-tdungan-c-drive/keywords.txt

2. Add the following keywords that we have seen through timeline analysis or memory analysis. In
(parentheses — do not add this text) we mention where we initially discovered the string during analysis.

hailhydra (found in memory image in string search used in “net use”)
hydrakatz (found in timeline and executed during attack)
spinlock (exited process found in memory image)

hyvy (found in timeline and executed during attack)
\\dllhost\\svchest\.exe (foundin memory image and timeline- beacon)

199\ .73\.28\.114 (IP Address found in memory and in .regq file)
\\netman\\domain {registry path where beacon config stored)
EXFIL\.pst (name of PST file generated — found in timeline)
\\winclient\.reg (found in timeline, location of beacon config)
\\Temp\\a\.exe (found in timeline and memory, active beacon)
\\pe\.exe (found in timeline and memory, psexec)

# cp /cases/xp-tdungan-c-drive/keywords.txt /cases/xp-tdungan-
memory

3. Change directories to the /cases/xp-tdungan-memory.

# cd /cases/xp-tdungan-memory/

(PLEASE READ: The processing done in the next step will take time. As a result, it is recommended for the
next part of the exercise, we recommend that you use the pre-cooked version listed below while the
command above is extracting the data for you. We won’t usually “cheat” like this, but some data extraction
is very lengthy and your time in class is precious. Close your eyes and imagine those 2 hours have passed
and you are going to begin your data analysis.)

4. Runbulk_extractor using your keywords against the collected memory file.

bulk extractor -F keywords.txt -e net -e aes -e wordlist -o /cases/xp-
tdungan-memory/bulk-extractor-memory-output /cases/xp-tdungan-
memory/xp-tdungan-memory-raw.001
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|Pre-Cooked Extracted Stream Data for Memory Image

1. If your bulk_extractor process has not finished processing yet, please use the pre-cooked version
found in: /cases/xp-tdungan-c-drive/precooked/bulk-extractor/bulk-
extractor-memory-output.zip

# cd /cases/xp-tdungan-c-drive/precooked/bulk-extractor

# unzip bulk-extractor-memory-output.zip

Examine Memory Extracted Data Using BEViewer

1. Run bulk_extractor Viewer and Open the Bulk Extractor Output Directory.

# BEViewer

File Edit View Tools

i1 Open Report.. €

Export Bookmarks...

Open Case...
Save Case...

2] Quit

Open the report.xml found in:
/cases/xp-tdungan-c-drive/precooked/bulk-extractor/bulk-extractor-
memory-output/report.xml

Select the image folderas “Use Path From Report” pointingitto the memory image file:
/cases/xp-tdungan-memory/xp-tdungan-memory-raw.001

2. Spend some time going through the results of bulk extractor from the memory image and answer
the questions in the following two exercises.
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@mct Stream Data from Memory — Questions

1. How many times was the text nfury@stark-research-labs.com found in memory?

. B¢

2. Inthe r£c822. txt output, what is the byte offset of the first hit for 199.73.28.114?

° ,G%‘\(‘{'\ﬁ’

3. Intheurl histogram.txt, findthehttp://192.168.1.5/ads hits. We are looking for
additional C2 channel servers and possibly searching for /ads will aid us in finding additional beacon
locations if the adversaries used more than one.

e What registry key do we see in the memory image around this hit?

° g’vf'{}ﬂ\_ X, CW-\(J'\‘\(AJE mk M\ NT‘MM\’(NM"}“
{

e What filename is around this hit?

. AL,

e What do you think this hit is related to? Why?

. propem Ul e 4T Fogan 44
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@estions Step-by-Step

1. How many times was the text nfury@stark-research-labs.com found in memory?

« 17
Reports Feature Filter | | Match case

7 bulk-extractor-memaory-cutput
[ aes_keys.tat
D cerntxt
CJ ccry_histogram. b
) demain.txt
™Y domain_histogram.txt
email.txt
[ email_domam_histogram.tst
7\ email_histogram.txt
[} ethartat
™) ether_histogram.ta
[ find.og
[ find_histogram.txt
Mt
Dyip_histogram.ixt
[ jsentxa
Y res22.4
[y sqlite_carved. it
[ telephone.ts
[ tedephona_histogram.txt
Dy o
' url_husteqram.tst
[ url_searches.bt
[ url_services. it
™) windirs.t
1 winiok.tst
M winpe.tst
Y winprafetch.ast

D b

{Histogram File email_histogram.txt
.n=138  cps-reguests@verisign.com
n=62  certificate@trustcenter.ds
n=57 infe@diginotaranl

‘n=42  info@valicert.com

; ;n =38  feste@fesie.org

n=25 ¢ ps@netlock.net

‘n=25  ellenorzes@netlock.net
[ n=24  server-certs@thawte.com

‘=23 silver-certs@saunalshiid

(n=21 gold-certs@saunalahti.f

’ premium-server@thawte.com
anfury@stzrk-research:-labs.com.ps
admin@digsigtrust.com
COorrec_cert@Ccorrec.comn.uy
info@e-trust.he
ips@rnailips.es |
persoral-hasic@ihawte.com ;
personal-freemail@thavwte.com ‘
personal-premium@thawte.com j

i

tdungan@r.ms

| AUNGANE BXP. WWW. IS _

: n=5 Jgs@aun.com -
K 0 — I

eferenced Feature File email.tat

ferenced Feature  ofury@starkresearch-abs.com..,
rfury@stark-research-labs.com.ps
rfurysestark-research-labs.comps

1182232332 riury@stark-research-labs.com.ps
152691670 rfury@stark-research-labs.com.ps
153054592 rfury@stark-research-labs.cerm.ps
153368746 NFURY@STARY-RESEARCH-LABS.COM.PS
152486533 rfury@stark-research-lahs.cem.ps
153475566 NFURY@STARY-RESEARCH-LABS.COM.PS
153928710 rfury@starkresezrch-labs.cera. ps
153557082 rfury@stark-research-labs.con.ps

| 154151182 riury@stark-research-labs.com. s
153500766 riwry@stark-research-labs.com.ps

159872630 rinry@stark-research-labs.com.pe
1156745422 riury@stark-research-labs.com. ps
156777454 NFURY@STARE-RESEARCH-LABS,COM,PS

(156801022 NFURY@STARI-RESEARCH-LARS,COM,PS
150515110 rfury@stark-research-labs.com.ps
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2. Inthe rc£822. txt output, what is the byte offset of the first hitfor 199.73.28.114

e 167946790

File Edit View Tools Help

| £ Highlight: T T éZEMatch case

atch case

| Reports

?;Feature Filter

[j bulk- extiakt i mamm} QL i

[ aes_ceys.txt

ﬁ centxt

(Y cen_histogram.ne

D domain.txt

[ domain_histogram.b
E] emat.txt

[ email_histogram.txt |
[ ethertat |
[ ethe-_histogranitxt
[ find.txt

D isonixt

[y 822t

[ telephone.txt

D telzphons | histaqrgm
[:} urhaxt

[y wri_histogram st

[Y url_sesarches.txt

[y url_serices.tat

1310155742

Feature Fl!e rfc822 Ut P
70700 Host: 190.73.28.114 (&
178028202

178028850
1261450817
295583175
307063597
307063701
207063813
307053880
(307063937
207063692
307064032
307753305
300244743
300581091
310162897

Referenced Feature File

{./j

Host: IRP
Host: AgpSetaperture

Subject: %s

host:1 024

Cookie: CUSTOMER,_EXPIRED=Y
Cookie: CUSTOMER_MOT_EX PIF"
Cookie: CUSTOMER,_ SECURE= W
Cookie: PAF‘»T_NUME‘ERﬁﬂlDIUI ]
Cookie: PART_NUMEBER=ROCKE
Cookie: SHIPPING=FEDEX, pathj
Cookie: SHIPPING _SECURE=UPS
cookie;

host:8205

host:1024

Cookie: .

Referenced Feature
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3. Intheurl histogram.txt,findthehttp://192.168.1.5/ads hits. We are looking for
additional C2 channel servers and possibly searching for /ads will aid us in finding additional beacon
locations if the adversaries used more than one.

¢ What registry key do we see in the memory image around this hit?

e System\CurrentControlSet\Services\netman\domain

e What filename is also around this hit?
Saa acxc
e What do you think this hit is related to? Why could this be important?
e This file is related to the dilhost/svchost.exe beacon backdoor due to the existence of
the registry key and file name. This could be important as the svchost.exe process

loads in memory with the default IP address set to 192.168.1.5. That address could
now possibly be used as an indicator of compromise for other systems

Highlight: v Match case

eports Feature Filter  » Match case Navigation

Ybulk-sstractor-mamorny ¢ K xptdungan-memory-raw. 001, 1122862556, hitp:/192.168. 1.5/ ads/
D Image File w4 AUNQATMeTIoN-ra )

Feature File f

Feature Path 11

Feature ki

) ! Histogram File
5 e Niag r

Image
01150

Referencéd Feature File

tYu Farchies ot Reforenced Feature nl
- v e Fireps 3
Y url sericestat i tpn//l -
1172 a2 b noerecute (3 fauled i
11 PR 4 60 i G corecy loop ealt L
L TELY{Y returied it

NENS LT el it
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Extract Stream Data from Disk Image - Step-by-Step Guide

1. Change directories to the /cases/xp-tdungan-c-drive/

# cd /cases/xp-tdungan-c-drive/

(PLEASE READ: This next step will take a LOT of time. We recommend for the next part of the exercise that
you use the pre-cooked version listed below while the command above is extracting the data for you. We
won’t usually “cheat” like this, but some data extraction is very lengthy and your time in class is precious.
Close your eyes and imagine those 7 hours have passed and you are going to begin your data analysis.)

c

2. Runbulk_extractor against using your keywords against the xp-tdungan-c-drive.EO01 file.

# bulk extractor -F /cases/xp-tdungan-c-drive/keywords.txt -e net -e
aes -e facebook -e outlock -o /cases/xp-tdungan-c-drive/bulk-
extractor-c-drive-output /cases/xp-tdungan-c-drive/xp-tdungan-c-
drive.EOQ1

3. Run BEViewer to examine the extracted streams from the disk image from the output in your precooked
exercise location.

|Pre-Cooked Extracted Stream Data from Disk Image

# cd /cases/xp-tdungan-c-drive/precooked/bulk-extractor
# unzip bulk-extractor-c-drive-output.zip

# BEViewer

1. Open the report.xml found in:

/cases/xp-tdungan-c-drive/precooked/bulk-extractor/bulk-extractor-c-
drive-output/report.xml

Select the image folder as “Use Path From Report” pointingitto the c-drive image: /cases/xp-
tdungan-c-drive/xp-tdungan-c-drive.EO1

2. Remember to point the original image back at using BEViewer
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Extract Stream Data from Disk Image — Questions

1. How many times was the text Ldungantistark-research Labs . .com (lower case only)
found in the disk image?

. iy

2. What s the first hit and byte offset in the find.txt report that is found from the hibernation file? (Note:
One of bulk_extractors exciting features is the ability to examine the content of the compressed ram
image embedded in the hiberfil.sys files. Once the hiberfil.sys data stream is detected, it will extract the
streams and make it easier to process. This question shows some of the content extracted from a
hibernation file data location. HINT: students should look for byte offsets that include the keyword "HIBER")

o [°)18373-983% V7R nE - kXY 34

3. How many times was the URL search term “file wiper” (file+wiper or file%20wiper) found
in the disk image?

4. Are any valid Credit Card Numbers found in the image?

e What type of file are many of them found in? (Review: In FOR408 we learned that the new
Office 2007/2010 format for documents that end in “x” (e.g. docx, pptx, xlsx)are
actually zipfiles with embedded xml data. If the data is found in a zipfile, it is possible that it
could be an office document.

° a\'\‘(;LUL /'me"L~/ ’I-J.'f"}/,

e What is the byte offset of the beginning of the zipfile?

A3

5. Using the url_services.txt file, perform a search for the IP address used for the beacon 199.73.28.114.

° How many total hits were there for this IP address and for what port address?

o« 1

e Based on the “Referenced Feature File” window pane below in your BEViewer output, what
application was specifically using this port and IP address. (Best Guess)

° MTV\/VWL
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6. Why do you think the following output exists inside of the url_searches.txt file?

ile &dit view Tools Help
% -
Highlight: v Match case
Reports Feature Filter ¥/ Match case Na
[ bulk-estractoroutput | ] -
Deentn | Mistogram File ursearchestt I
[) cen_histogramest Mintendo+1:%275 + On+Like + Donkey +Ka & Fg:!
[y damain.txt Princess+Leia++holla | Fol
Princess+Lea+l
amai gram.txt 2
[§ domain_histogram.t o & imq
[y emaibtsr = Stark 5
[} email_histogramtat | | n=1 S‘tarl:%gs:-& i
atherts | in= Stark%29Re 7
[) ethertt n=l | Stark%20Res 1
D ether histagram.txt §jn=l Starkw20Rese il
[y exif.tut izn=1 Stark%20Resea s
=S {in=l Stark%20Resear o
|ale A+ e N e
D L jn=lL Stark%20Research 14
[ gps.tt ‘n=l | Stark%ZOResearch%20L 14
(Y jsontst in=1 Stark¥20Rezearch%2¢Lab 1]
N f e g I tine=1 stark%20Research®%Z0Labs 1z
DI;(O.{.;,TM L S e— e e ——— e — R
i in=1 Wwhere+in+the+World+Are+vou%lc+Di 12
[ tatephone.ta a1 2 ! e
{7 telephone_histagram} adohe s reader+ 4N IBT
Y urlit . 1
1—-_-_] uri.txt Referenced Feature File wurltst 15
[y url § Referenced Feature file+wiper 14
[ url_histogram.t« 441 356({102741 84824 - HIBER) hitpsffoawgoot || 145
[ B ST7{(1631885320- HIBER) i htt pse/fvrvrw. google.comis || 17
L A S earcaas. 1067 (10318853920- HIEER) https:/fwvaw.google.comvs || 1
L) url_senices.tx 331 26{10304795206- HIBER) https:iwaww.geot || 19
D zpa 49596 (10369576264 - HIBER) http:f/maps.goog || 19

7. Basedonthe email histogram, who does the user of this machine receive e-mail from or send e-
mail to the most times in the same domain? The user of the machine is tdungan@stark-
research-labs.com
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Extract Stream Data from Disk Image — Questions Step-by-Step

1. How many times was the text tdungan@stark-research-labs.com found in the disk image?

5875
File Edit View Bookmarks Tools Help

v &

1 Reports
| 3 bulk-extractor-memory-cutput

[ bulk-extractor-c-drive-output

[ alerts.txt

D centxt

[} cen_histogram.txt

£ domain.txt

Y domain_histogram.txt
™ elf.txt

Y email.txt

[ email_demain_histagram.txt
emall_histogram.txt
[ ether,txt

[ ether_histogram.txt
[y exif.txt

[y facebook.txt

[ find.txt

[ find_histogram. txt

Highlight: |

' Feature Filter

_ | Match case

tdungan@stark-research-labs.com|

Histogram File email_histogram.tst

El\' :36?

n=404
n=145

n=52

n=7

n=95

n=9

dungan@stark-research-lahs.com

sitptdungan@stark-research-labs.com
dungantdungan@stark-research-labs.c
dungansmtptdungan@stark-research-l:
L 2.0tdungan@stark-research-labs.com
amllemailaddresstdungan@stark-reseal
reg_emall_tdungan@stark-research-la
reg_email_confirmation_tdungan@sta
session_keytdungan@stark-research-la
wdungantdungan@stark-research-labs.
<ermailtdungan@stark-research-labs.cc
120315-484R-21 06tdungan@stark-res
2011 tdungan@stark-research-labs.cont
familytdungan@stark-research-labs.co;
gadgets.tdungan@stark-research-labs..
iprm.contacttdungan@stark-research-la
aow. tdungan@stark-research-labs.com
romanofftdungan@stark-research-labs,
umothydungantdungan@stark-researc

2. What is the first hit and byte offset in the find.txt report that is found from the hibernation file? (Note:

One of bulk_extractors exciting features is the ability to examine the content of the compressed ram
image embedded in the hiberfil.sys files. Once the hiberfil.sys data stream is detected, it will extract the
streams and make it easier to process. This question shows some of the content extracted from a

hibernation file data location)
10187309832-HIBER-55539 \dllhost\svchost.exe
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File Edit View Toels Help

3 —
Highlight v Match case
iteports Foature Filter  » Match cane Havigation
b gt r 3oty t + K Fptdungan-cdrive.£01, 10107209832 HIDEN.S5539, Wilhostisvchost, exo
imba Foature File find e Imaga Fils JoTr<-Srve £
: 15 Feature File

minll Foature Path =
"""" Feature

Image

Referenced Feature File
Relerenced Feature

3. How many times was the URL searchterm file wiper {file+wiperor file%20wiper) foundin
the disk image?

¢ 2 times based on the histogram output of url_searches for file+wiper. You will also
notice another 126 hits for the hit file%20wiper.

IRepmts Feature Filter | Match case Havigation

9 bulk-extractar-c.drive-out| |file 4 K xptdungan.c.drive EOL, 1129... |«
Me Histogram File " Image File xpadungan-<-drive.£01
RET s o [ Feature File o
5 a2 file Feature Path

" X p g v
w2 file Feature

nper Image
1= T

Vel Z306L &

1

1 erdresutl
\ =

1

1

112

1

1

1

1

Referenced Feature File  url ot
Referenced Feature

ht E

b e T |
-1 11

k 1

[ 1

i 1

| 1

i 1

I 1

I 1

® Text  Hex bt e 8

4. Are any valid Credit Card Numbers found in the image?

a. What type of file are many of them found in? (Review: In FOR408 we learned that the new
Office 2007/2010 format for documents that end in “x” (e.g. docx, pptx, xIsx) are actually
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zipfiles with embedded xml data. If the data is found in a zipfile, it is possible that it could be

an office document.

i. Many possible credit card numbers found in the image. Many of the found in a zip file

embedded in XML which could mean that the file was part of an office 2007+

document.

b. What is the byte offset of the beginning of the zipfile?

i. 1619706

5. Using the url_services.txt file, perform a search for the IP address used for the beacon 199.73.28.114.
a. How many total hits were there for this IP address and for what port address?

i. 252 hits for port 443

ii. 9 hits for port 8000

b. Based on the “Referenced Feature File” window pane below in your BEViewer output, what
application was specifically using this port and IP address? (Best Guess)

i. Hyvy.exe (multiple references to port 443 and this IP)

6. Why do you think the following output exists inside of the url_searches.txt file?

FORS08 - SANS ©2015

aports

it
O A

Apt

Foature Filter Malzh case
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ile Edit view TYools Help

o Ji]
Highlight: v Match case
eports Fealure Filter v Match case Ha
A oulkeestrastorn "
D) eonn Histagram Fite url saarches.tot L_""
en_hnstogramit nul intendo ItNE7¢ «On sLike s Donkey + \o‘ F z‘
aman.tit nal Princess+Lels+ +holla ElTe 9"
domain_bistagram | [ Princess+Leire i A
R n=1 St fm 4
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i mistogram.txd fel SLATEH20R d
fiw] StarR%20Re b
= =1 \!41 K% 205Res ;
;_) eher Mslagram e n=l e Eete | :
g:} anftay n=l 2RRpes A
™ find 1y n=1 20Resar ||| ¢
o PR el Stark%2GResearch 1]
Lyaps.ba n=) Starku%20Research®20L 14
gjzr«%' ;nmi Stark%20Reswearch20lab 11
n=1 Stark™%20Research™20Labs 1
[ ydas2zur ; o - - - p
*‘) . » n=l Yihere +in+ the +Worlti+Are + ron%2c+ Dy 1
{j talephans. it n=1 a
; Rone histegrars | 0=l adobe +reader +
L Referenced Feature Fite Url.tst
LY urt fazebookadin ed Feature fide s wiper
Y urt mistogranuta 274164524 - HIEER) htipsaifirwango 144
£ IS are e BIZUGSIESNEOTHIBERIN 1=/ v google.con ;
L prizsearches; 1057(10328853G20- HILER) hittps/fw, google corn 17
DY urt seracests : 12
() op e 19

i. This is common in the autocomplete in the Google search bar. It recorded the
autocomplete format as the user was typing it in. This will show that this is probably
user input into the Google or similar search engine.

Based on the email histogram, who does the user of this machine receive e-mail from or send e-mail

to the most times in the same domain? The user of the machine is tdunganstark-research-
labs.com

i. Itlooks as though nfurydstark-research~la
the output from bulk extractor. nromanoffistark
appears 15038 times.

<om appears 13057 times in

rasaarch-labg . con
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Exercise — Key Takeaways

e Many possible credit card numbers found in the image. Many of them were found in a zip file
embedded in XML which could mean that the file was part of a word document.

e Need to determine what file points to cluster 1619706
e Hyvy.exe (multiple references to port 443 and this IP)
e bulk_extractor has the ability to scan through hibernation files and compressed data

e bulk_extractor has the ability to help you profile the user on the system by examining searches,
histograms of e-mail addresses and URLs, and more
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Exercise 17 - File Carving

Objectives

Extract Unallocated Space from the xp-tdungan-c-drive image
Select signatures from the carving configuration file

Add specific signatures (.exe and .pf) to the carving configuration file
Carve files out of unallocated space

Analyze the files recovered from unallocated space

Exercise Preparation

=

1. Please ensure your evidence is mounted correctly at /mnt/windows_mount if not, please follow
Exercise 2 — Mounting Evidence Using SIFT again to mount your evidence.

# cd /mnt/windows_mount

# 1s

root@SIFT-Horkstation;/mntfwindews_mount# is

$Secure

If you do not see the above, then please follow directions in Exercise 2 ~ Mounting Evidence Using SIFT

For508 - SANS ©2015
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Carve Files from Unallocated Space — Step-by-Step Preparation

1. Extract Unallocated Space From your Disk Image and protect the new image by setting the immutable
bit using chattr +i

# cd /cases/xp-tdungan-c-drive

# blkls xp-tdungan-c-drive.E0l1 > xp-tdungan-c-drive.blkls

2. Edityour foremost. conf file

# gedit /usr/local/etc/foremost.conf

Uncomment the following signatures to carve out:

gif dat (index.dat)
ipg 1nk
tif rdp
htm rar

3. Below are the magic number signatures for (Prefetch and EXE) files; add them to your
foremost.conf configfile.

exe v 80000 \x4d\x5a\x90\x00
pf v 80000 2\x00\x00\x00\x53\x43\x43\x41

4. Determine the cluster size of the image using fsstat.

# fsstat xp-tdungan-c-drive.EOl

¢ Cluster Size = Jl" 1 (

5. Execute Foremost with the edited configuration file against unallocated space.
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# cd /cases/xp-tdungan-c-drive

# foremost -q -b 4096 -o foremost -c /usr/local/etc/foremost.conf
xp-tdungan-c-drive.blkls

6. Execute pe_carve.py to compare against the foremost data carve looking for .exe files

# mkdir pe carve
# cd /cases/xp-tdungan-c-drive/pe_carve/
# 1n -s ../xp-tdungan-c-drive.blkls xp-tdungan-c-drive.blkls

# pe_carve.py xp-tdungan-c-drive.blkls

IAnaIyze Carved Files from Unallocated Space —Questions

1. Analyze the EXE files

e How many recovered executables are broken or false positives?

To determine carved .exe that give errors
# cd /cases/xp-tdungan-c-drive/foremost/exe/
# exiftool 00000041.exe (examine the output of this tool)
# exiftool -csv * | grep -i error
# exiftool -csv * | grep -i error | wec -1

(Note the =1 is a lowercase “L” not a “1”)

. e

e How many executables you recovered are most likely true executables?

For508 - SANS ©2015 Exercise 17 — File Carving



To determine total executables in the foremost directory
# 1s
# 1s | we -1

(Note the =1 is a lowercase “L” not a “1”)

; L 166

# cd /cases/xp-tdungan-c-drive/pe carve
# 1ls -la

# 1s | we -1

e How many executables were recovered by pe_carve.py?

e Run a virus scan against the directory from your Windows system (Microsoft Windows
Defender or ClamAV is fine). Do any .exe files get flagged as malware?

# clamscan -i /cases/xp-tdungan-c-drive/foremost/exe

# clamscan -i /cases/xp-tdungan-c-drive/pe carve/
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e Why do we get different results between pe_carve.py and the foremost.exe carve?

e Runexiftool against some of the executables that were flagged in either the pe_carve
directory or the foremost directory? What is some of the most important data to pull from
the output?

¢ Does this information match any existing executables on the system?

# exiftool /mnt/windows mount/Documents\ and\
Settings/tdungan/Local\ Settings/Temp/a.exe

. ONSN ity gty p L/ 2t A B

2. Analyze the recovered PF files

e Run the prefetch analyzer pf against some of the files.

# cd /cases/xp-tdungan-c-drive/foremost/pf/

# for i in *.pf; do pf -v $i; done | less

e Extract the data so you can parse it easily in EXCEL.
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# cd /cases/xp-tdungan-c-drive/foremost/pf/

# for i in *.pf; do pf -csv $i; done | grep .pf, | cut -d,
-£2,3,4,5 > /cases/xp-tdungan-c-drive/recovered-pf-analysis.csv

Open .csv file for analysis in Excel from your Windows System accessing it via
\\siftworkstation\cases\xp-tdungan-c-drive

e Based on the recovered . pf files, how many times did a prefetch file for a. exe show up in
the csv file?

] 3

o Based on the recovered . pf files, when was the last time that PE.EXE was executed?

. b/67251L  1Biyzite

e Based on the recovered . pf files, how many total times was PE.EXE executed?

8 2y

e Based on the.pf file found in C:\WINDOWS\Prefetch, when was the last time that PE.EXE
was executed?

# cd /mnt/windows mount/WINDOWS/Prefetch/

# pf -v PE.EXE-0DC593C2.pf | grep run

. q/0¢/vIn [ 11244 2

e Based on the . pf file found in C:\WINDOWS\Prefetch, how many total times was PE.EXE
executed?

For508 - SANS ©2015 Exercise 17 — File Carving



e Based on the comparison between the .pf file recovered for pe.exe and the .pf found in
C:\Windows\Prefetch, how many times was pe . exe executed between 13:43 and
19:22 UTCon04/06/2012?

>

3. OUT OF CLASS EXTRA QUESTIONS Analyze the LNK files

o Look at the LNK Files in “Thumbnail Mode” from your windows OS \\siftworkstation\cases\xp-
tdungan-c-drive\foremost\Ink

o What can you observe by looking at the thumbnails?

o Check validity of LNK files using EXIFTOOL

# cd /cases/xp-tdungan-c-drive/foremost/lnk/

# exiftool * | less

o Can you determine the original path of each of the files and what they pointed to?

# exiftool * | grep Local\ Base\ Path

o Which programs (. exe) were executed the most?

# exiftool * | grep Local\ Base\ Path | cut -d":" -£2,3 | sort
| unig -¢ | sort -n

o How many times does the “Dossier — Dr Myron Maclain.docx” appear as a LNK file that was
recovered?
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o What is the file name of the recovered LNK file that points to the “Dossier — Dr Myron
Maclain.docx?” {note: Should look something like 00000182.Ink)

# exiftool * | grep -A 2 -B 21 Myron

o Based on extracting the information from the LNK file, what are the Creation, Access, and

Modification dates of the “C: \Documents and Settings\tdungan\My
Documents\Alloy Research\Detailed Documents\Dossier - Dr Myron

MacLain.docx” file?

= Create Date =

= Access Date =
=  Modify Date =

o What time zone are these times stored in?

o EXTRA - Run log2timeline against directory of LNK files and analyze the results.

# log2timeline -f win_link -r -z ESTS5EDT -w /cases/xp-tdungan-c-
drive/recovered 1lnk files.csv /cases/xp-tdungan-c-
drive/foremost/1lnk

# 12t process -b /cases/xp-tdungan-c-drive/ recovered 1lnk files.csv
> /cases/xp-tdungan-c-drive/timel ine 1lnk files.csv

= According to this timeline, what is the last time of modification for the “Dossier — Dr

Myron Maclain.docx?”
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=  Why would inclusion of this data make your timeline more complete?
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Analyze Carved Files from Unallocated Space —Questions with Step-by-Step Guide

1. Analyze the EXE files

a. How many recovered executables are broken or false positives?

* 940

# cd /cases/xp-tdungan-c-drive/foremost/exe/
# exiftool —-csv * | grep -i error

# exiftool -csv * | grep -i error | we -1
(Note the -1 is a lowercase “L"” nota “1”

942

e How many executables you recovered are most likely true executables?

¢ 1956-942 = 1014

# 1ls
# 1s | we -1
(Note the =1 is a lowercase “L” not a “1”)

1956
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e Run avirus scan against the directory? Do any . exes get flagged?

ﬁ Sicrersft Securty Exgenbialy

Computer status - At sk

Scan completed on 2058 items.

» Secunty Frsentials detested 1 potentiai threat on your computer.

Queck

L Full

9 Custerm...

© Rexl-tinne protectian [s]21
. . Scan now
€ Yews ond spypeate defintions: Up to date

RN SRNGNE A,

-

ll

q Scan detaiy
Scheduled scan: Sunday avound 2:00 AM {Fulf scan) | Changemy scan schedule
Last scare 472272012 at 2:23 AM {Fult scanj

C LA LN
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IXI Potential threat details

L]

Secunty Essentals detacted 1 potensal thraat that maght compeomuse your privacy of damage your compuler.
Your access to theseitems may be s:spenced unb! you ta=e an achon,
Cick Show detads tolearn more. ¥hg: aoe alertleyeis

Detected tems Aertlevel Status Reconmended acton
O TiojaniWn32/Snrort.A Sayers Active Remoye -
Category: Trojan ¥

Description: Ths program is dangerous and exedutes commands from an attacker,
Recommended action: Remave this softare mmedately.

Secunty Escenbas datected programs thal may compromise your prvacy or damage yaur computer, You ¢an
1 acress the fles hat these programs use withdut remowing hem (pot resommended), To access thase 3
Res, selact the Afow actoen and dick Apply actions. [f ths oplon is not avadable, log on as admnistrator of

ask the secunly admrsstrator for heip.

.‘orenwst'-mewmmﬁ.uc
foremostiexe 20007313, exe
vee'foremost'exe \GOUBS65, exe
ive'foremost'e s 00266153, exe
xp \foremastiew2 19233907, ene
fe:2dxp-teungan< drvelforemost'exe \G03203 77, exe -

| Hde detais << | : Apply actors | | Close

Items:

file:Z: \xp-tdungan < drive \foremost\exe 000004 1.exe
file:Z: Yp-tdungan < drive \foremost\exa00007913.exe
file:Z: \xp-tdungan -c-drive \foremost'exe 00067918, exe
file:Z: \xp-tdungan-c-drive \foremost\exe 0000386 5.exe
file:Z: \xp-tdungan < drive \foremost\exe {00266 155.exe
file:Z: \xp-tdungan-c-drive\foremost\exe 0028390 7.exe
file:2: \xp-tdungan - -drive\foremost\exe\00320377.exe
file:Z: \xp-tdungan-c-drive \foremost'exe\00327203.exe
file:Z: \xp-tdungan-cdrive \foremost\exe 00336652 .exe
file:Z: \xp-tdungan < drive \foremost'exe\00837251.exe
file:Z: \xp-tdungan-c-dnive\foremostiexe\00837314.exe

e »;”‘ g?“pf

* Why do we get different results between pe_carve.py and the foremost.exe carve?

For508 - SANS ©2015

Two different carving technigues resulted in different sets of files being
retrieved. Foremost used the MZ header to carve out files at a static length
(80,000 bytes). Pe carve.py scanned unallocated space looking for “This
program” and then determined the file size of the executable. While both
ended up producing files, it is likely both are good to examine. No tool is
perfect, but it is always good to have options. Since .exe carving could be
crucial to your case, we felt it best to expose you to several options of scanning
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for executables that could result in finding a key artifact in one of your
upcoming cases.

e Runexiftool against some of the executables that were flagged. What is some of the most
important data to pull from the output?

o Time Stamp = This is the timestamp when the file was compiled

= Time Stamp =2011:10:13 04:19:53+00

o Code Size and Initialized Data Size = These two values will help you determine the
probable original file size when added together. While not exact, it is the best guess
you might achieve.

e (Code Size =5120

e |nitialized Data Size = 3584

ExifTool Version Number : 8,19

File Name : 000607913 .exe

Directory g .

Fite $ize : 78 k8

Fite Modification Date/Time : 2012:84:27 18:14:44+00:60
File Permissions I PWel-=-T--

File Type : Win32 EXE

MIME Type : application/octet-stream
Machine Type : Intel 386 or later, and compatibles
Time Stamp : 2911:10:13 684:19:53+08:60
PE Type : PE32

Linker Version : 8.8

Code Size ; 5120

Initiatized Data Size : 3584

Uninitialized Data Size : 0

Entry Peint : Ox173f

05 Version : 6.1

Image Version : 6.1

Subsystem Version : 5.1

Subsystem : Windows GUI

e Does this information match any existing executables on the system?

o Yes. Thefile a.exe matches (Time Stamp, Code Size, Initialized Data Size, and more)

# exiftool /mnt/windows_mount/Documents\ and\ Settings/tdungan/Local\
Settings/Temp/a.exe
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root@SIFT-Workstation:/# exiftool /mnt/windows_mount/Documents\ and\ Settings/t
dungan/Local\ Settings/Temp/a. eXe

ExifTool Version Number 8.19

Fite Name ! a.exe

Directory : /mnt/windows_mount/Documents and Settings/tdu
ngan/Local Settings/Temp

File Size : 9.9 kB

Fiie Modification Date/Time : 2012:84:04 14:01:32+06:00

File Permissions ! TWXTWXTWX

File Type : Win32 EXE

MIME Type : application/octet-.stream

Machine Type : Intel 386 or later, and compatibles
Time Stamp : 2011:19:13 64:19:53+4909:066

PE Type : PE32

Linker Version : 9.9

Code Size : 5120

Initiatized Data Size : 3584

Uninitialized Data Size : 8

Entry Point : 6x173f

0S Version : 6.1

Image Version : 6.1

Subsystem Version : 5.1

Subsystem : Windows GUI

2. Analyze the recovered PF files

e Run the prefetch analyzer p£ against some of the files, can you extract the data

# cd /cases/xp-tdungan-c-drive/foremost/pf/

# for i in *.pf; do pf -v $i; done | less

e Extract the data so you can parse it easily in EXCEL

# cd /cases/xp-tdungan-c-drive/foremost/pf/

# for i in *.pf; do pf -csv $i; done | grep .pf, | cut -d,
-£2,3,4,5 > /cases/xp-tdungan-c-drive/recovered-pf-analysis.csv

Open .csv file for analysis in Excel from your Windows System accessing it via
\\siftworkstation\cases\xp-tdungan-c-drive

e Extract the data so you can parse it easily in EXCEL

e Based on the recovered .pf files, how many times did a prefetch file for a.exe show up in the
csv file?
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e a.exe had 13 .pf files recovered for it

FILENAME Run Count Last Executed At:
ALEXE run 288 times  lastrun: 04/05/12 05:59:51.103
A.EXE run 283 times  lastrun: 04/05/12 06:02:05.575
A.EXE run173times lastrun: 04/07/1201:21:39.698
ALEXE run 29C times  lastrun: 04/05/12 06:04:21.452
A.EXE run 112 times  lastrun: 04/03/12 05:15:37.518
A.EXE run 113 times  Jastrun: 04/03/1205:17:52.125
A.EXE run 296 times  lastrun: 04/05/12 06:17:48.908
A.EXE run279times  lastrun: 04/05/12 05:39:14.727
A.EXE run110times  lastrun: 04/06/12 23:01:53.723
A.EXE run 270 times  lastrun: 04/05/12 05:18:54.96%
A.EXE run 5 times last run: 04/03/12 01:05:22.764
A.EXE run 2 times last run: 04/04/12 15:25:55.906
AEXE run 1times last run: 04/04/12 12:26:24.707
ACRORD32INFO.EXE  run 2 times lastrun: 04/02/12 12:54:33.205
APSDAEMON,EXE run 6 times lastrun: 04/04/12 16:41:55.120
AT.EXE run 13 times lastrun: 04/05/12 17:44:55.171

e Based on the recovered . pf files, when was the last time that PE.EXE was executed?

e pe.exe was last executed at 04/06/2012 13:43:20 UTC

e Based on the recovered . pf files, how many total times was PE.EXE executed?

e pe.exe runcount was 27
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1 FILENAME RunCount  LastExecuted At:
2 AEXE run173times last run; 04/07/12 01:21:39.698
WMIPRVSE.EXE run 543 times  last run: 04/07/12 01:03:14.267
4 GOOGLEUPDATE.EXE run 6386 times lastrun:04/06/12 23:58:00.133
S A.EXE run 110times  {astrun: 04/06/12 23:01:53.723
6 JAVAW.EXE run 8 times last run: 04/06/12 19:12:10.477
7 WMIPRVSEEXE run 542 times  last run: 04/06/12 19:06:52.005
8 DFRGNTFS.EXE run 75 times fast run: 04/06/12 17:23:53.798
9 WUAUCLT.EXE run 797 times  last run: 04/06/12 16:39:40.282
10 USERINIT.EXE run 1517 times last run: 04/06/12 16:38:35.411
11 USERINIT.EXE run 1516 times last run: 04/06/12 16:38:35.052
12 [PE.EXE run 27times  last run: 04/06/12 13:43:20.168
13 MCSCRIPT_INUSE.EXE rund02times last run: 04/06/12 07:00:11.009
14 WMIPRVSE.EXE run 541 times  last run: 84/06/12 04:45:26.638
15 VERCLSID.EXE run 105 times  Jast run: 04/06/12 04:01:18.932
16 WMIPRVSE.EXE run 540 times  last run: D4/06/12 01:14:44.047
17 HELPSV(C.EXE run 208 times  last run: 04/06/12 01:14:28.190
18 MCSCRIPT_INUSE.EXE rund0ltimes lastrun:04/05/12 21:10:04.532
19 CMD.EXE run 34 times last run: 04/05/12 17:48:55.939
20 AT.EXE run 13 times  last run: 04/05/12 17:44:55.171
21 EXPLORE.EXE run 5 times last run: 04/05/12 15:11:08.743
22 WINLOGON.EXE run 65 times  last run: 04/05/12 14:41:58.318
23 CSRSS.EXE run 79 times fast run: 04/05/12 14:41:58.063

e Based onthe.pf files found in C:\WINDOWS\Prefetch, when was the last time that PE.EXE was

executed?
e pe.exe was last executed at 04/06/2012 19:22:20 UTC

e Based on the.pf files found in C:\WINDOWS\Prefetch, how many total times was PE.EXE

executed?

e pe.exe runcount was 30

# cd /mnt/windows_mount/WINDOWS/Prefetch/

# pf -v PE.EXE-ODC593C2.pf | grep run

PE.EXE, ‘run 30 times, last run: 04/66/12 19:22:26.316
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e Based on the comparison between the .pf file recovered for pe.exe and the .pf found in
C:\Windows\Prefetch, how many times was pe . exe executed between 13:43 and
19:22 UTCon04/06/2012?

¢ pe.exe (recovered .pf} had a runcount of 27
¢ pe.exe (C:\WINDOWS\Prefetch) had a runcount of 30
e pe.exe was executed 2 more times (runcount 28 and 29)

3. OUT OF CLASS EXTRA QUESTIONS Analyze the LNK files

o Look at the LNK Files in “Thumbnail Mode.” What do you see?

= Many of the LNK files have an ICON associated with them. In some cases you can even
tell the exact application that is associated with it (e.g. 7zip, QuickTime, or Internet

Explorer)
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o Check validity of LNK files using EXIFTOOL

# cd /cases/xp-tdungan-c-drive/foremost/lnk/

# exiftool * | less

o Canyou determine the original path of each of the files and what they pointed to?
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# exiftool * | grep Local\ Base\ Path

Local Base Path : C:\Program
Files\Messenger\msmsgs.exe

Local Base Path : C:\WINDOWS\system32\cmd.exe
Local Base Path : C:\WINDOWS\system32\rcimlby.exe
Local Base Path : C:\WINDOWS\explorer.exe

Local Base Path C:\Program

Flles\Google\Chrome\Appl1cat10n\18 0.1025.151\Installer\setup.exe
Local Base Path :\WINDOWS\system32\tourstart.exe
Local Base Path : \WINDOWS\system32\mobsync.exe
Local Base Path : \WINDOWS\system32\notepad.exe
Local Base Path :\WINDOWS\system32\narrator.exe
Local Base Path : \WINDOWS \system32\osk.exe

Local Base Path : \WINDOWS\ system32\magnify.exe

QOGOOO

o Which programs (. exe) were executed the most?

= 4 \Program Files\Internet Explorer\iexplore.exe

= 4 \Program Files\Outlook Express\msimn.exe

# exiftool * | grep Local\ Base\ Path | cut -d":" -£f3 | sort | uniqg -c¢
| sort —n

2 \WINDOWS\system32\notepad.exe

2 \WINDOWS\system32\osk.exe

3 \Program Files\Google\Chrome\Application\chrome.exe

3 \Program Files\Paragon Software\Partition Manager 11
Personal\program\launcher.exe

3 \Program Files\Windows Media Player\wmplayer.exe

3 \WINDOWS\explorer.exe

3 \WINDOWS\system32\rcimlby.exe

3 \WINDOWS\system32\tourstart.exe

4 \Program Files\Internet Explorer\iexplore.exe
4 \Program Files\Outlook Express\msimn.exe

o How many times does the “Dossier — Dr Myron Maclain.docx” appear as a LNK file that was
recovered?

= 1 Time
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o What is the file name of the recovered LNK file that points to the “Dossier — Dr Myron

MacLain.docx?”

# exiftool * | grep -A 2 -B 21 Myron

======== (00020274.1lnk
ExifTool Version Number
File Name

Directory

File Size

File Modification Date/Time
File Permissions

File Type

MIME Type

Flags

WorkingDir, Unicode
File Attributes
Create Date

Access Date

Modify Date

Target File Size

Icon Index

Run Window

Hot Key

Target File DOS Name
Drive Type

Volume Label

Local Base Path

8.10
00020274.1nk

4.9 kB

2012:04:27 18:14:44+00:00
rw-r—--r-—-

Windows Shortcut
application/octet-stream
IDList, LinkInfo, RelativePath,

Archive

2012:03:08 22:10:54+00:00
2012:03:12 21:27:54+00:00
2012:03:12 21:27:52+00:00
140751

(none)

Normal

(none)

DOSSIE~1.DOC

Fixed Disk

C:\Documents and Settings\tdungan\My

Documents\Alloy Research\Detalled Documents\Dossier - Dr Myron

Maclain.docx
Relative Path

.\My Documents\Alloy

Research\Detailed Documents\Dossier - Dr Myron MacLain.docx

Working Directory

: C:\Documents and Settings\tdungan\My

Documents\Alloy Research\Detailed Documents

Machine ID

: wks-winxp32bit

For508 - SANS ©2015

= 00020274.1nk is the file that contains the information related to “Dossier - Dr

Myron MacLain.docx”

o Based on extracting the information from the LNK file, what is the Creation, Access, and

Modification dates of the “C: \Documents and Settings\tdungan\My
Documents\Alloy Research\Detailed Documents\Dossier - Dr Myron

MacLain.docx” file

Exercise 17 — File Carving




Create Date : 2012:03:08 22:10:54+00:00
Access Date : 2012:03:12 21:27:54+00:00
Modify Date : 2012:03:12 21:27:52+00:00

o What time zone are these times stored in?

= UTC

o Run log2timeline against directory of LNK files and analyze the results.

# log2timeline -f win link -r -z ESTS5EDT -w /cases/xp-tdungan-c-
drive/recovered lnk files.csv /cases/xp-tdungan-c-drive/foremost/lnk

# 12t process -b /cases/xp-tdungan-c-drive/recovered lnk files.csv >
/cases/xp-tdungan-c-drive/timeline lnk files.csv

* Openthecsvfile found \\siftworkstation\cases\xp-tdungan-c-

drive\ timeline lnk files.csv in Excel

= According to this timeline, what is the last time of modification for the “Dossier — Dr Myron
MacLain.docx?”

e Modification Time = 03/12/2012 17:27:52 EST5EDT

date time MACE short
3/1272012 17:27:52 M., C:/Documerts and Settings/wdungan/My Dotuments/Ailoy 3esearch/Detailed Dorumants/Dossier - D Myron MeeLain, docx
31272612 17:27:5d A.. :/Documents and Settings/tdungan/My Documents/Alloy Jesearch/Detailed Documents/Dossiar - DE Myron Maclain. docx

= Why would inclusion of this data make your timeline more complete?

e Since most of this data originated from deleted/recovered LNK files, it might give

us additional timestamps in our overall timeline. It might not make a difference in

every case, but it surely will make the case data more complete and accurate.
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Exercise — Key Takeaways

Foremost does a decent job of recovering key file types
We can easily find malware by scanning recovered .exe files
Certain file types you can run the targeted log2timeline against (such as LNK and EXE files)

Use basic analysis capabilities of the SIFT Workstation to examine recovered files and determine if
they are useful to your case

No new data that we didn’t already know, but if this system once had active malware on it and it
was subsequently deleted, we would have a decent chance of recovering that malware from
unallocated space as well as finding evidence of execution via recovered .pf and .Ink files
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Exercise 18 - NTFS Filesystem Challenge

Objectives

e Determine the filename of a file if you are given a fragment of data from another tool such as

bulk_extractor
e  Gain experience using the Sleuthkit
e  Understand how to map between the data layer, the metadata layer, and the filename layer

Exercise Preparation

1. Please ensure your evidence is mounted correctly at /mnt/windows_mount if not, please follow
Exercise 2 — Mounting Evidence Using SIFT again to mount your evidence.

# cd /mnt/windows_mount

# 1ls

=
root@SIFT-Workstation:/mnt/windows mount# 1s

$Secure

if you do not see the above, then please follow directions in Exercise 2 — Mounting Evidence Using SIFT
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Windows Filesystem Challenge — Questions

1. Perform a timestomp detection check on the possible malware using istat

Using istat, determine which of the following files have been timestomped.

Possible
MFT SSTD_INFO SFN Timestomping?
Filename Record # Creation Creation (Y/N)
C:\WINDOWS\system32\dllhost\svchost.exe

C:\WINDOWS\system32\hyvy.exe 5 13% 3737 [20ey 1ue| lej3/ 0 b 20 Y
C:\WINDOWS\system32\hydrakatz.exe yy | S( 23 1119 |41/ 211 544 i
C:\WINDOWS\system32\sekurlsa.dll R le N[220 Y LK) T Yy

C:\WINDOWS\system32\spinlock.exe H1 i s Lo e/ 1) 1 »

"V\
For each file above:

Determine MFT Record #, $SI, and SFN for each file. Finally, assess whether or not you think Timestomping
possibly occurred. In this example, we will look at svchost.exe

# 1s -1i /mnt/windows_mount/WINDOWS/system32/dllhost/svchost.exe

3022 -rwxrwxrwx 1 root root 102400 2008-04-14 00:12 svchost.exe

Once you know the MFT Record Number, the first number in the line, use istat to examine the contents of that
record. Compare the creation time of the SFILENAME Attribute with the creation time of the
SSTANDARD_INFORMATION attribute. If the SSTANDARD_INFORMATION creation time occurs prior to the
SFILENAME creation time, there is possible timestomping occurring. (Note: If you use the SFILENAME
creation time as a timeline pivot point, it would help determine if the assessment of timestomping is correct.
In this case, the SFILENAME creation time occurs near the same time that the winclient. reg file and the
dllhost directory were created on 2 April 2012 ~2030.
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# istat /cases/xp-tdungan-c-drive/xp-tdungan-c-drive.E01 3022

MFT Entry Header Values:

Entry: 3022 Sequence: 10
SLogFile Sequence Number: 2199495480
Allocated File

Links: 1

$STANDARD INFORMATION Attribute Values:

Flags: Archive

Owner ID: O

Security ID: 392 ()

Last User Journal Update Sequence Number: 1894779272
Created: Mon Mar 31 12:00:00 2003
File Modified: Mon Apr 14 00:12:36 2008
MFT Modified: Fri Apr 6 19:07:16 2012
Accessed: Fri Apr 6 19:07:16 2012

$FILE NAME Attribute Values:

Flags: Archive

Name: svchost.exe

Parent MFT Entry: 3015 Sequence: 15
Allocated Size: 102400 Actual Size:
Created: Tue Apr 3 00:35:02 2012
File Modified: Tue Apr 3 00:35:03 2012
MFT Modified: Tue Apr 3 00:35:03 2012
Accessed: Tue A2pr 3 00:35:03 2012

102

Attributes:

Type: $STANDARD INFORMATION (16-0) Name: N/A Resident size: 72
Type: $FILE NAME (48-5) Name: N/A Resident size: 88

Type: SDATA (128-4) Name: N/A Non-Resident size: 102400

init size: 102400

MAATIEAM ANATIE AA AMAFIE AN AAATIE ArS AAATIE ATI ANATIEAA MAAFIEAA AAATIEEA

Filename MFT SSTD_INFO SFN Possible
Record # Creation Creation Timestomping?
(Y/N)
C:\WINDOWS\system32\dIllhost\svchost.exe 3022 3/31/03 4/3/12 YES
12:00:00 00:35:02
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2. Data FROM Stream Based Extraction Exercise

e Are any valid Credit Card Numbers found in the image?

o What type of file are many of them found in?

= Many possible credit card numbers found in the image. Many of the found in a
2ip file embedded in XML which could mean that the file was part of a word
document.

o What is the byte offset of the beginning of the zipfile?
* 1619706

o What file name is found with CC data that is part of byte offset 1619706?
cC - )?uML”»J\ - fye el e g Am o

1. Determine cluster size

e Clustersize=# fsstat xp-tdungan-c-drive.E01l

e Cluster size = Zf“"

2. Determine cluster address using byte offset and cluster size
e Original_Cluster Num= (byte offset)/(cluster size)

e Original_Cluster_Num = 9%

3. Find the INODE_NUM that points to the cluster using ifind
¢ MFT_Num= # ifind xp-tdungan-c-drive.E0l1 -d
{ORIGINAL_CLUSTER_NUM}

e MFT_Num= 3

4. Ensure MFT Record Number points to cluster using istat
* # istat xp-tdungan-c-drive.E0l1 {MFT_NUM}

5. Use icat to extract the file for analysis

e # icat xp-tdungan-c-drive.EO0l {MFT NUM} > /cases/xp-tdungan-c-
drive/sample recovered

6. Using MFT Record number determine FILENAME using ffind

For508 - SANS ©2015 Exercise 18 — NTFS Filesystem Challenge



e Filename= # ffind xp-tdungan-c-drive.E0l {MFT_ NUM}

¢ Filename = CC = Pacd 5’1’”.4, A}m.-»f,pcxﬁ

3. What file name is found based on the following bulk extractor hit?

25382928 HYDRAKATZ.EXE

1. Determine cluster address using byte offset and cluster size
a. Original_Cluster Num = (byte offset)/ (cluster size)

b. Original_Cluster_Num = b1a’ty

2. Find the INODE_NUM that points to the cluster using ifind
a. MFT_Num= # ifind xp-tdungan-c-drive.E01 -d
{ORIGINAL_CLUSTER_NUM}

b. MFT_Num = L’A 80} Lf

3. Using MFT Record number determine FILENAME using ffind
a. Filename= # ffind xp-tdungan-c-drive.EO0l {MFT_ NUM}

b. Filename = h'YﬁﬂA\‘A/rl v =29 Blfﬂ/hﬂ.‘\)ﬂj

4. What file name is found based on the following bulk extractor hit?

235565072 HYVY.EXE

1. Determine cluster address using byte offset and cluster size

a. Original_Cluster Num= (byte offset)/(cluster size)

b. Original_Cluster_Num = /3 /X%H

2. Find the INODE_NUM that points to the cluster using ifind
a. MFT_Num= # ifind xp-tdungan-c-drive.E0l1 -d
{ORIGINAL_CLUSTER NUM}

b. MFT_Num = ¥l ey
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3. Using MFT Record number determine FILENAME using ffind
a. Filename = # ffind xp-tdungan-c-drive.E0l {MFT_NUM}

b. Filename= ATV r frl = 2 A TYEF 1% ?7

5. What file name is found based on the following bulk extractor hit?

367259794 EXFIL.pst

1. Determine cluster address using byte offset and cluster size
a. Original_Cluster_Num = (byte offset)/(cluster size)

b. Original_Cluster_Num = @"] 0/( ;

2. Find the INODE_NUM that points to the cluster using ifind
a. MFT_Num= # ifind xp-tdungan-c-drive.E01l -d
{ORIGINAL CLUSTER NUM}

b. MFT_Num = 4 (a2

3. Using MFT Record number determine FILENAME using ffind
a. Filename= # ffind xp-tdungan-c-drive.E0l1 {MFT_ NUM}

b. Filename =

6. What file name is found based on the following bulk extractor hits?

15010878359 <li><a href="HYDRAkatz.exe">HYDRAkatz.exe</a>
15010878405 <li><a href="HYvy.exe">HYvy.exe</a>
15010878473 <li><a href="sekurlsa.dll">sekurlsa.dll</a>

1. Determine cluster address using byte offset and cluster size
a. Original_Cluster_ Num= (byte offset)/ (cluster size)

b. Original_Cluster Num= 7 ( (4T
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2. Find the INODE_NUM that points to the cluster using ifind
a. MFT_Num= # ifind xp-tdungan-c-drive.E0l1 -d
{ORIGINAL CLUSTER NUM}

\50
b. MFT_Num = 7]

3. Using MFT Record number determine FILENAME using ffind
a. Filename= # ffind xp-tdungan-c-drive.E0l {MFT_NUM}

b. Filename = _ Cacllfi 1

7. NINJA QUESTION: Run “jp” against the xp-tdungan-c-drive.img and answer the question below.

# cd /mnt/ewf_mount

# jp -image /mnt/ewf mount/ewfl -basel0 -bodyfile > /cases/xp-tdungan-
c-drive/jp-bodyfile

# mactime -d -b /cases/xp-tdungan-c-drive/jp-bodyfile -z ESTSEDT >
/cases/xp-tdungan-c-drive/jp-timeline.csv

OPEN TIMELINE IN CSV FORMAT VIA EXCEL AND ANSWER THE QUESTION BELOW

How often is a.exe created on the NTFS filesystem? Asking the question another way ->Determine the
beacon interval of the svchost.exe through examining the creation date/time of a.exe on the
filesystem. Remember a .exe is created each time the beacon is active and attempts a connect out.
We have assumed that the “pause” interval, set to the integer 32, is how often it beacons. Can we use

the jp output to prove it?

INTERVAL = SECONDS
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Windows Filesystem Challenge — Questions with Step-by-Step Guide

1. Perform a timestomp detection check on the possible malware using istat

Using istat, determine which of the following files have been timestomped.

MFT
Filename Record #

C\WINDOWS\system32\dllhost\svchost.exe 3022

C:\WINDOWS\system32\hyvy.exe 5237
C\WINDOWS\system32\hydrakatz.exe 4736
C:\WINDOWS\system32\sekurlsa.dll 3260
C:\WINDOWS\system32\spinlock.exe 7793

For each file above:

SSTD_INFO
Creation

3/31/03
12:00:00
3/31/03
12:00:00
3/31/03
12:00:00
3/31/03
12:00:00
4/a/12
17:04:44

SFN

Creation

4/3/12
00:35:02
4/3/12
16:30:02
4/3/12
15:19:49
4/3/12
15:30:13
4/4/12
17:04:44

Determine MFT Record # for each file. In this example, we will look at svchost.exe

Possible
Timestomping?
(Y/N)

YES
YES
YES

YES

NO

# 1ls -1i /mnt/windows_mount/WINDOWS/system32/dllhost/svchost.exe

3022 -rwxrwxrwx 1 root root 102400 2008-04-14 00:12 svchost.exe

Once you know the MFT Record Number, the first number in the line, use istat to examine the contents of that
record. Compare the creation time of the SFILENAME Attribute with the creation time of the
SSTANDARD_INFORMATION attribute. If the SSTANDARD_INFORMATION creation time occurs prior to the
SFILENAME creation time, there is possible timestomping occurring. (Note: If you use the SFILENAME

creation time as a timeline pivot point, it would help determine if the assessment of timestomping is correct.

In this case, the SFILENAME creation time occurs near the same time that the winclient. reg file and the

dllhost directory were created on 2 April 2012 ~2030.
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# istat /cases/xp-tdungan-c-drive/xp-tdungan-c-drive.E0l1 3022

MFT Entry Header Values:

Entry: 3022 Sequence: 10
$LogFile Sequence Number: 2199495480
Allocated File

Links: 1

$STANDARD INFORMATION Attribute Values:

Flags: Archive

Owner ID: O

Security ID: 392 ()

Last User Journal Update Sequence Number: 18947798272
Created: Mon Mar 31 12:00:00 2003
File Modified: Mon Apr 14 00:12:36 2008
MFT Modified: Fri Apr 6 19:07:16 2012
Accessed: Fri Apr 6 19:07:16 2012

$FILE NAME Attribute Values:

Flags: Archive

Name: svchost.exe

Parent MFT Entry: 3015 Sequence: 15
Allocated Size: 102400 Actual Size:
Created: Tue Apr 3 00:35:02 2012
File Modified: Tue Apr 3 00:35:03 2012
MFT Modified: Tue Apr 3 00:35:03 2012
BAccessed: Tue Apr 3 00:35:03 2012

102

Attributes:

Type: $STANDARD_INFORMATION (16-0) Name: N/A Resident size: 72
Type: SFILE NAME (48-5) Name: N/A Resident size: 88

Type: $DATA (128-4) Name: N/A Non-Resident size: 102400
init_size: 102400

3397543 3397544 3397545 3397546 3397547 3397548 3397549 3397550
3397551 3397552 3397553 3397554 3397555 3397556 3397557 3397558
3397559 3397560 3397561 3397562 3397563 3397564 3397565 3397566
3397567

Filename MFT SSTD_INFO SFN Possible
Record # Creation Creation Timestomping?
(Y/N)
C:\WINDOWS\system32\dllhost\svchost.exe 3022 3/31/03 4/3/12 YES
12:00:00 00:35:02
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Data FROM Stream Based Extraction Exercise
Are any valid Credit Card Numbers found in the image?
e What type of file are many of them found in?

¢ Many possible credit card numbers found in the image. Many of the found in a
zip file embedded in XML which could mean that the file was part of a word
document.

e What is the byte offset of the beginning of the zipfile?

¢ 1619706

2. What file name is found with data that is part of byte offset 1619706?

1. Determine cluster size

a. Clustersize =# fsstat xp-tdungan-c-drive.EO01
b. Clustersize=4096 bytes

2. Determine cluster address using byte offset and cluster size
a. Original_Cluster_Num= (byte offset)/(cluster size)

b. Original_Cluster_Num =1619706 / 4096 = Cluster 395

3. Find the INODE_NUM that points to the cluster using ifind
a. MFT_Num= # ifind xp-tdungan-c-drive.E01 —-d 395

b. MFT_Num=313-128-3

4. Ensure MFT Record Number points to cluster using istat
a. # istat xp-tdungan-c-drive.EO01 313

5. Use icat to extract the file for analysis
a. # icat xp-tdungan-c-drive.EO0l 313 > /cases/xp-tdungan-c-

drive/s ample_recovered_3 13

6. Using MFT Record number determine FILENAME using ffind
a. Filename= # ffind xp-tdungan-c-drive.E01 313
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b. Filename =/Documents and Settings/tdungan/My Documents/Backstopped

Accounts - R&D Costs Alloy Research/CC-Backstopped-Accounts.xlsx

Note: The above file was determined by bulk_extractor to contain credit card numbers.

‘J o F- s CC-Backstopped Sccountsxdse [Read-Daly] - Microac Excet
m Haras Insert Page Layout Farmulas Cats Review iew Add-Ins

m;‘ %‘«Cu! Cabn 11 - A A = = o S weap fext General 211_

—i &8 capy -
i jfc?:risl pamger B 4 U DA EEE FEE dGregeacetrr 8- % v WR Fiﬁ?ntl:tl
A3 - fe
A B C D E F G H

1

2 Masterzard

3l |

q 5417153144100950

5 5218084286395560

6 53225789129%6140

7 5542607932820870

f! 550743738161733¢

9 $580687336385260

10 5206422317613290

11 5101214723509110

12 5455923812376430

13 3232697876896120

14 5296816393721790

15 54063008025318060

15 53065362236353440

17 $260%3695980627¢

13 5288905982820640

i&] 5280763078551980

20 5513662609830030

21 5205975375479800

22 5217854295914950

23 5373095286838550

24

25 VISA 16 digit

26 eeeemeieneen

27 4024007103717850

28 4024007138739030

29 4716063915607960

30 4024007151573550
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3. What file name is found based on the following bulk extractor hit?

25382928 HYDRAKATZ.EXE

1. Determine cluster address using byte offset and cluster size
a. Original_Cluster_Num = (byte offset)/(cluster size)

b. Original_Cluster_Num =25382928 / 4096 = 6197

2. Find the INODE_NUM that points to the cluster using ifind
a. MFT. Num= # ifind xp-tdungan-c-drive.E0l -d 6197

b. MFT_Num =4894

3. Using MFT Record number determine FILENAME using ffind
a. Filename= # ffind xp-tdungan-c-drive.EQ0l1 4894

b. Filename =/WINDOWS/Prefetch/HYDRAKATZ.EXE-27B49502.pf

4. What file name is found based on the following bulk extractor hit?

235565072 HYVY.EXE

1. Determine cluster address using byte offset and cluster size

a. Original_Cluster Num = (byte offset)/ (cluster size)
b. Original_Cluster_Num =235565072 / 4096 = 57511

2. Find the INODE_NUM that points to the cluster using ifind
a. MFT_Num= # ifind xp-tdungan-c-drive.E01l -d 57511

b. MFT_Num =5144

3. Using MFT Record number determine FILENAME using ffind
a. Filename= # ffind xp-tdungan-c-drive.EO0l 5144

b. Filename =/WINDOWS/Prefetch/HYVY .EXE-2A94EF14 .pf
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5. What file name is found based on the following bulk extractor hit?

367259794 EXFIL.pst

1. Determine cluster address using byte offset and cluster size
a. Original_Cluster Num = (byte offset)/ (cluster size)

b. Original_Cluster_Num =367259794 / 4096 = 89663

2. Find the INODE_NUM that points to the cluster using ifind
a. MFT_Num= # ifind xp-tdungan-c-drive.E01 —-d 89663

b. MFT_Num =8245

3. Using MFT Record number determine FILENAME using ffind
a. Filename= # f£find xp-tdungan-c-drive.E0l1 8245

b. Filename =/Documents and Settings/vibranium/Local
Settings/Application Data/Microsoft/Outlook

6. What file name is found based on the following bulk extractor hits?

15010878359 <li><a href="HYDRBAkatz.exe">HYDRAkatz.exe</a>
15010878405 <li><a href="HYvy.exe">HYvy.exe</a>
15010878473 <li><a href="sekurlsa.dll">sekurlsa.dll</a>

1. Determine cluster address using byte offset and cluster size

a. Original_Cluster_Num = (byte offset)/ (cluster size)

b. Original_Cluster_ Num = 15010878405 / 4096 = 3664765

2. Find the INODE_NUM that points to the cluster using ifind
a. MFT._Num= # ifind xp-tdungan-c-drive.EO0l —-d 3664765

b. MFT_Num = 3150
3. Using MFT Record number determine FILENAME using ffind

a. Filename= # f£find xp-tdungan-c-drive.E01 3150
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b. Filename = /Documents and Settings/tdungan/Local
Settings/Application
Data/Mozilla/Firefox/Profiles/uimccx5n. default/Cache/ CACHE 001 _

7. NINJA QUESTION: Run “jp” against the xp-tdungan-c-drive.img and answer the question below.
# cd /mnt/ewf _mount

# jp -image /mnt/ewf mount/ewfl -basel0 -bodyfile > /cases/xp-tdungan-
c-drive/jp-bodyfile

# mactime -d -b /cases/xp-tdungan-c-drive/jp-bodyfile -z ESTS5EDT >
/cases/xp-tdungan-c-drive/jp-timeline.csv

OPEN TIMELINE IN CSV FORMAT VIA EXCEL AND ANSWER THE QUESTION BELOW

How often is a.exe created on the NTFS filesystem? Asking the question another way ->Determine the
beacon interval of the svchost.exe through examining the creation date/time of a.exe on the
filesystem. Remember a .exe is created each time the beacon is active and attempts a connect out.
We have assumed that the “pause” interval, set to the integer 32, is how often it beacons. Can we use
the jp output to prove it?

a. Open jp-timeline.csv in EXCEL
b. Hide all columns except Date, Type, Meta, File Name
c. Freeze Top Row = VIEW -> FREEZE PANES -> FREEZE TOP ROW
d. Filter Columns = HOME -> SORT & FILTER -> FILTER

[Date * Type|~ Meta ~ File Name

Fri Apr6 m... 7372 a.exe

Fri Apr06 m..b 7372 a.exe

Fri Apr 06 mi.. 7372 a.exe

Fri Apr6 m..b 7372 a.exe

FriApr06 m... 7372 a.exe

£ri Aproé m..b 7374 A.EXE-239305€A.pf
FriAprgé m... 7374 A.EXE-239305EA.pf
FriApr06 ..c. 15838 l.ini

fri Aproe ..c. 15838 1.tmp

e. Filter only on “a.exe”
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f. Filter only on type “m..b"
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g. Calculate the delta between each entry. Note you can use EXCEL to help you here or eyeball it.
What you can easily see is that each one is almost 33-34 seconds apart. If you remember, in the

A B C
1 LDate - Type |-/ Meta| »|{File Name B
3 (FriApr06201219:48:00 m..b 7372 a.exe
S FriApr06201219:48:33 m..b 7372 a.exe
32 FriApr06201219:49:06 m..b 7372 a.exe
34 Fri Apr06 2012 19:43:39 m..b 7372 a.exe
36 .Fri Apr 06 2012 19:50:13 m..b 7372 a.exe
38 Fri Apr06201219:50:46 m..b 7372 a.exe
46 Fri Apr0620121%:51:13 m..b 7372 a.exe
48 ;Frl Apr 062012 19:51:52 m..b 7372 a.exe

\SYSTEM\CONTROLSETOO1\SERVICES\NETMAN\DOMAIN registry key, the “PAUSE” value was set to
equal “32” seconds.

’
MNan

ne

2blhome

'mr‘.

e

Type Data
REG_SZ hitp://199.73 28.114d/ads/
" REG.DWORD  0»00000020 32)

R S e

If you add file creation and process execution on top of the interval you would probably see the file

“a.exe” is created each time the beacon attempts to connect out. Below you can see the delta
calculation in excel of the previous entry and the one following it. Please note it did take some
hacking around EXCEL to get this to work. The reason we did it is to show that the interval is

between 33-34 seconds each time.
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Date

(v Type Y Meta v FileNan.¥

19:48:00 m..b
19:48:33 m..b
19:49:06 m..b
19:49:33 m..b
19:50:13 m..b
19:30:46 m..b
19:51:19 m..b
18:51:52 m..b
19:52:26 m..b
19:52:59 m..b
19:53:32 m..b
19:54:05 m..b
19:54:38 m..b
19:55:12 m..b
19:55:45 m..b
1%:56:18 m..b
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7372 a.exe
7372 a.exe
7372 a.exe
7372 a.exe
7372 a.exe
7372 a.exe
7372 a.exe
7372 a.exe
7372 a.exe
7372 a.exe
7372 a.exe
7372 a.exe
7372 a.exe
7372 a.exe
7372 a.exe
7372 a.exe

00:00:33
00:00:33
00:00:33
00:00:34
00:00:33
00:00:33
00:00:33
00:00:34
00:00:33
00:00:33
00:00:33
00:00:33
00:00:34
00:00:33
£0:00:33
00:00:34
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Exercise 19 — Challenge Prep

Objectives

1. Using all the skills we learned this week and using malware funneling methods we will begin prepping
the evidence from other systems found on the Stark Research Labs Network.

2. Prepare Memory Analysis.
Prepare Timeline Analysis.

w

4. Anything else you might think of

Exercise Setup and Challenge Preparation Rules

e For the final challenge each of you will be broken into teams of 3-4 individuals max. If we have an odd
number then and only then will a team of 5 be allowed. Those leaving early from class should be all on

one team.

e There are 3 systems that the attackers are suspected of moving laterally inside our enterprise
environment at Stark Research Labs. The three systems that they are suspected to have moved to are:

0 Win7-64-nfury-10.3.58.6
0 Win7-32-nromanoff-10.3.58.5
0 Win2008R2-controller-10.3.58.4

e Each individual should select a system and will be the lead analyst for that system to prepare initially

and analyze.

o If you have more than more analysts than systems, divide the preparation tasks. One of you
can start to prep memory analysis using redline, the other can create the super timeline.

e Once you have been assigned your system, begin to process the data for the challenge in the morning.

e Itisassumed that you will need to keep processing through the night. Please accomplish the quicker

tasks first and then the longer ones overnight.

e One final note: Since there is so much data to process, we would ask that each team ONLY process, but
Teams that start ahead the morning of Day 6 already having
analyzed prepped case data will be penalized and in the event of a tie with another team will end up

do not begin analysis of the data.

losing the challenge. Prep ONLY.

e Atthe beginning of the final section, Section/Day 6, the instructor will hand out the last exercise.
(Note: It is NOT in your book. To win the challenge, you must answer the questions correctly and the
team that has the most correct answers and is the furthest along in the case will win the challenge.
The challenge is hard and it is expected that each team will end up working closely together to solve it.)
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Exercise Preparation

1. Reboot your SIFT workstation (I have found that working from a clean system works best).
2. Start your SIFT VMware Workstation in VMware Workstation.
3. Login the VMware machine.
» LOGIN = sansforensics
» PASSWORD = forensics
4. Re-Open First Exercise and follow the steps to copy the system (OS-USER-IP) that you have been
assigned to analyze into your cases directory. You should copy three directories (c-drive, memory,
and incident-response).

|Final Challenge Preparation

I Mount your images for analysis in your system

e Start a terminal, elevate your privs to root, and change into the /cases/0S-USER-c-drive
directory.

$ sudo su -

# cd /cases/OS-USER-c-drive/

e Mount your evidence files so you can see the xp-tdungan-c-drive raw image and files/folders
from the system.

# ewfmount OS-USER-c-drive.EOl /mnt/ewf_mount/

# mount -o ro,loop, show_sys_files,streams interface=windows
/mnt/ewf mount/ewfl /mnt/windows_mount

Your raw image is here: /mnt/ewf mount/ewfl

Your EO1 image is here: /cases/0S~USER-c-drive/0OS-USER-c-
drive.EQ1

Your mounted files/folders are here: /mnt/windows mount

You can view your files/folders here : \isiftworkstation\mnt\windows mount

e Each system lead should turn back to Redline Preprocess Exercise and perform the Redline Pre-
Process against the memory raw memory image of their newly assigned system.

e Convert any Hibernation files (hiberfil.sys)

e Any options are allowed for prepping your memory images. It is your call on what you think is
best for analyzing all of the memory from your machine.

e Itis ok to ask your instructor about other options here for preparation that would be allowed
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e Ask yourinstructor “if it is allowed” if you are in doubt. Usually something that will take over
10 minutes to process will generally be allowed.
e Do not begin to analyze. Prep only.

lPrepm'e Timeline Analysis

e See addendums for each system

e Following this exercise, there are step-by-step guides for creating the overall timeline image for
each additional system.

I_ M{hat e!sg?

We have just covered the core of your basic analysis preparation.

e If you or your team determine any additional steps you would like to accomplish, please
consider them. In fact it is greatly encouraged. Remember if there is anything you would like
to do that might take some time using any toolset out there that could help you, consider it.

e Please try and clear the additional processing with your instructor prior to beginning it.
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Win7 NFury10.3.58.6 PREP

F\r‘:‘ount NFURY Windows 7 Image and Mount Multiple Volume Shadows

(Note: Some of this might already be accomplished via earlier exercises, but this is the state that we hope your system is in prior
to the start of this exercise. Just in case your system rebooted, we are including a guide to help you get back to the proper
analysis starting point prior to the beginning of this exercise.)

1. REBOOT your SIFT VMware Workstation in VMware Workstation.
2. Login the VMware machine.

» LOGIN = sansforensics

» PASSWORD = forensics

3. Start a terminal, elevate your privs to root, and change into the /cases/win7-64-nfury-c-drive
directory.

$ sudo su -

# cd /cases/win7-64-nfury-c-drive

4. Mount your evidence files so you can see the win7-64-nfury-c-drive raw image and files/folders from
the system.

# ewfmount win7-64-nfury-c-drive.EOl /mnt/ewf mount/

# mount -o ro,loop,show_sys files,streams interface=windows
/mnt/ewf mount/ewfl /mnt/windows_mount

5.  Mount raw image VSS using vshadowmount and mount all logical filesystems found in snapshot

# vshadowmount /mnt/ewf _mount/ewfl /mnt/vss

# cd /mnt/vss

# for i in vss*; do mount -o

ro,loop,show_sys_files,streams_interface=windows $i
/mnt/shadow_mount/$i; done
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I Create SuperTimeline across the core image and the VSS image ‘

|Create a VSS SuperTimeline — Step-by-Step Guide |

1. Step 1-—Run Log2timeline.py

# cd /cases/win7-64-nfury-c-drive

# log2timeline.py —-parsers
“winevtx,filestat,winreg,webhist,lnk,prefetch” win7-64-nfury-
pPlaso.dump win7-64-nfury-c-drive.EQ1

Only include VSS snapshots 6,7

2. Filter using psort.py

# psort.py -z "ESTSEDT" -o L2tcsv win7-64-nfury-plaso.dump "date >
'2012-04-02 20:00:00' AND date < '2012-04-07 00:00:00'" >
nfury.timeline.csv

3. Switch over to your Windows Workstation {Host System Preferred) and open the \\SIFTWORKSTATION
from an open folder on your Desktop.

4. Take the filtered timeline and open it up in Excel using the color-timeline template from your windows
system.
a. Open Timeline Color Template
i. TIMELINE_ COLOR TEMPLATE.xlsx

&Y TIMELINE_COLOR_TEMPLATE.xlsx
“Z) TIMELINE_COLOR_TEMPLATE zip

b. Switch to Color Timeline worksheet/tab.
c. Click on Cell A-1,
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éj R U TIMELINE_COLOR_TEMPLATE xdsx
m Home fnsert Page Ltayout Formulas Data Reviews Yiew Add-Ins

5")7 %c"t Cafibri -1l A A= gg »- Spwrap Tex General

ety Copy - .

Pajte S Format Painter B ZU- _- - -é-' EEE EF fgfflerge&Center' $ - %

Al - f
A B C D E F G

F

2

g

4

5

6

i

d. Select 'DATA' Ribbon.
e. Import Data "FROM TEXT".

¥ d TIMELINE_COLGR_TEMPLATExdsx

m Home Insert Page Larout Formulas Cata Review View Add-Ins

) \ Y 1 3 2 3| Connactions Al ] \f’ o Liess ‘:;.*;.5
RE M e g DT -
From From Frojg From Qthar Existing Refresh f;l Sort Filter { o Text to
Access Web  TePR Saurces+  Cennections All - ¢ J7 advanced  ¢otumns Dy
Al - f
A B C D E F G

f. Selectnfury.timeline.csvfile->\\siftworkstation\cases\win7-64-nfury-
c-drive
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{1 Import Text File
@\/v b Network » sftworkitaticn » cases » sp-tdungan-c-drive » -4y
Crganze » New Freider
e SHELD-USE 10
e OQUTPUT (2
Bulk-etrecter-dulput
.qv ) . precocied
B ODIFFFZELEB.HO “”':”i:m
B QOOFFF2879F-HO o TR
y ) Z4) timehine.csv
& SOOFFFLIS3T-CS ohitelit b
S GOFFEL38149-C7 —e .
K OIEFFI1E3-CT ap-tdungan-c-drcetat
4; —— xp-tdungan-c-drive_tod;fite tat
3027

g. TEXT IMPORT WIZARD Will Start.
h. Step 1->Select Delimited -> Select NEXT.

Text Import Wizard - Step 1 of 3 [ RN | s

The Text Wizard has determined that your data is Fixed Width.

I this is correct, choose Next, or choose the data type that best describes your data.

Original data type
Choose the file type that best describes your data:
0 Debmiteds - Characters such as commas or tabs separate each fisld.
Fixed width N Fields are aligned in columns with spaces between each field,
Start import at row: 1 L File origin: 437 : OEM United States (v

Praview of file \\siftworkstatonicases\xp-tdungan-c-drive \tmeline. csv.

iHace,time, vimezone, MACB, scurce, scurcecype, type, user, hest, short, dese, vers] -
33/31/2063,0?:09:00,:':5?5351‘, ...B,FILZ ,NTFS $MFT,$5I [...8] time,-,WKS-WI
33/’31/‘2003, 07:00:00, ESTSEDT, M. .., FILZ NTFS SMFTI,$S5I [M...] time, -, HKS-WI
33/31/2003,07:00:GQ,ZSTSEM,M...,‘:‘ILS,HT?S $METT, s8I [M...] Time,-,WES-WI
33{31/2003,07:01}:OQ,ZSISZD‘I,M. .., FILE, NTFS S$MFT,s8SI [M...] time,- WKS-WI] -

‘ I ]

Cancel | @ext > | Finish

i. Step 2 ->Unselect Tab under Delimiters -> Select Comma under Delimiters -> Select NEXT >

FORS508 - SANS ©2015 Final Prep Addendum: NFury 4



Text Import Wizard - Step 2 of 3 [ 2 (o2
This screen lets you set the delimiters your data contains. You can see how your text is affected in the preview
below:.

Detmiters
Tzb
Semicolon
,
Bl soxe 3
Other:

Data preview

ate imezone PA ource ¥pe =
)3/31/2003 ST3ZDT FILE SI {...B] time
3/31/2003 STSEDT FILE 5I (¥...] time
3/31/2003 P7:00; ST3IDT FILE SI [M...] tire
D3/3L/2003 P ST5E0T FILT SI [M...] time -
4 i} L]
j- Step 3 ->Select Finish.
k. Where do you want to put the data? Simply Select OK.
Import Data -7 |||-EZ§-!|
Where do you want to put the data?
Q@ BExsting worksheet:
=5AS1 T"

[o

New worksheet

Once imported View -> Freeze Panes -> Freeze Top Row.
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J1ev Add-ins

) e 1| } = = split 1] View S:ge by Side L)
A 09 =Y ~1 — T | = Hide 435 Syneheonous Saoliing &l
Zoom 100% Zoomto New  Arrange Freeze ) ) Save
Selection  Window  All Panes~ A4 Reset Window Position  workspace
S Unfreeze Panes
I Unlock all rows and coiumns to scrofl
Wirough the entire worksheet.
—y Freeze Top Row
1 Keep the top row visibl2 while s¢rolling
through the rest of the worksheet
F [ Freeze Frst Column
. i1 Keep the tirst column visible while s¢rolling
rCEtfpe ty_pe through the rest of the warksheet.
ES SMFT $SI [...B] time

m. Optional Hide Columns Time Zone, Host, Version.

D E

Cut
Copy
Paste Options

Paste Special.
fnsert

Delste

Clear Contents
Format Cells.
Column AWadth..,
Hide

Linhide

n. Select HOME Ribbon.
g d9-e-is
m Home | Insert Page tayc
= & Cut _
y Calibri
= Copy -
Paste )
1- > fF-t'rmat Painter 4 U

0. Select all Cells "CTRL-A".
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p- In Home Ribbon -> Sort and Filter — Filter and you will be ready to begin analysis.

L AutoSum | A a5
1 il = / A I }}

| Fiil

) Sort & Find &
y Clear - Filter = Salect -
}‘l Sort Smallest to Largest

il Sort Largest to Smailest

+3  Custom Sort
f= Filte

g. Before you analyze too much — please save your new Color Timeline as an XLSX file:
/cases/win7-64-nfury-c-drive/vss-supertimeline.xlsx
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Win7 NRomanoff 10.3.58.5 PREP

lMount NROMANOFF Windows 7 Image and Mount Multiple Volume Shadows

(Note: Some of this might already be accomplished via earlier exercises, but this is the state that we hope your system is in prior
to the start of this exercise. Just in case your system rebooted, we are including a guide to help you get back to the proper
analysis starting point prior to the beginning of this exercise.)

1. REBOOT your SIFT VMware Workstation in VMware Workstation.
2. Login the VMware machine.
» LOGIN = sansforensics
» PASSWORD = forensics
3. Start a terminal, elevate your privs to root, and change into the /cases/win7-c-drive directory.

$ sudo su -

# cd /cases/win7-32-nromanoff-c-drive

4. Mount your evidence files so you can see the win7-32-nromanoff-c-drive raw image and files/folders
from the system.

# ewfmount win7-32-nromanoff-c-drive.E0l /mnt/ewf mount/

# mount —-o ro,loop, show_sys files, streams interface=windows
/mnt/ewf mount/ewfl /mnt/windows_mount

5. Mount raw image VSS using vshadowmount and mount all logical filesystems found in snapshot

# vshadowmount /mnt/ewf mount/ewfl /mnt/vss
# cd /mnt/vss
# for i in vss[234]; do mount -o

ro,loop,show_sys files,streams interface=windows $i
/mnt/shadow_mount/$i; done
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I Create SuperTimeline across the core image and the VSS image

|Create a VSS SuperTimeline — Step-by-Step Guide

1. Step 1-Run Log2timeline

# cd /cases/win7-32-nromanoff-c-drive
# log2timeline.py —--parsers
“winevtx,filestat,winreg,webhist,lnk,prefetch” win7-32-nromanoff-

plaso.dump win7-32-nromanoff-c-drive.EO1l

Only include VSS snapshots 3,4

2. Filter using psort.py

# psort.py -z "ESTSEDT" -o L2tcsv win7-32-nromanoff-plaso.dump
"date > '2012-04-02 20:00:00' AND date < '2012-04-07 00:00:00'" >

nromanoff.timeline.csv

3. Switch over to your Windows Workstation (Host System Preferred) and open the \\SIFTWORKSTATION
from an open folder on your Desktop.

4. Take the filtered timeline and open it up in Excel using the color-timeline template from your windows
system.
a. Open Timeline Color Template
i. TIMELINE COLOR TEMPLATE. xlsx

1) TIMELINE_COLOR_TEMPLATE xisx
") TIMELINE_COLOR_TEMPLATE.zip

b. Switch to Color Timeline worksheet/tab.
c. Click on Cell A-1.
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1l

AN | S [ TIRELINE_COLOR_TEMPLATE alsx

m Home Insest Page Lavout Fotmulas Data Review Viewy Add-Ins

20 % Cut o F G

\ & Calibri 11 - A =g B e wrap Text Generai
YosaCopy v .

Paste ) - - V. R - = = = i= P s Sy = .

Pas F Format Painter B /7 U I D A EEE I afuerge &denter § v,
Chph Sard Magament by

Al - 2
A B C D E F G

1

MO U A W N

d. Select 'DATA' Ribbon.
e. Import Data "FROM TEXT".

: TIMELINE_COLOR_TEMPLATE xlsx
P Home Insert Page Layout Formulas Data Review View Add-Ins
¥ kY . e : B b Connections ¢ FF50 A H—
& le|lh Lo dRE T men
From From Fro I ;‘ Sort Filter Tetto |

Actess  Web Tem

i’/ Advanced ¢Caiumns D

Al

f. Select nromaoff.timeline.csvfile->\\siftworkstation\cases\win7-32-
nromanoff-c-drive
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{4} Import Text File
@:jv > Neh.czl » siftwerkstation » cases » rp-tdungan-c-drrie » - iy
Grgsnie ¥ Piewe Tridee
s SHEELD-USE (3 ST )
e CUIFUT [t
butte etractar-oulput
‘b\ T precocied

& Q00FFF41EE-HO ke;’—";miim
8 Q00FFFI2878F-HO e
& QOOFFF14337-CS Bl smeline.civ
. whitefeton
S GOGFFEI36110-CT y
€ GIEFFI6183-CT ap-tdungon-c-drrratat
»“ OAEEEL 26 CT | xptdungan.c-diie_todyhietd
g. TEXT IMPORT WIZARD Will Start.
h. Step 1-> Select Delimited -> Select NEXT.

TextImport Wizard - Step1 of 3 |2 |th|

The Text Wizard has determined that your data is Fixed Width.

If this is correct, choose Next, or choose the data type that best describes your data.

Original data type
Choose the file type that best desaribes your data:
O [Delimitedy - Characters such as commas or tabs separate each field.
Fixed wi Fields are aligned in columns with spaces between each field.
Start mport atrow: 1 -2+ File origin: 437 : OEM United States [w

Preview of file \\s:iftworkstation\cases\wp-tdungan < -drive\bmehne.csv.

ate,vime,timezeone, MACS, scurce, scurcerype, type, user, heat, shert, desc, vers) -
3/31/2003,07:00:00,Z5T5=ZDT, .. .B,FILE NIFS $MFI,$58I [(...B) time, -, WKS-AI
3/31/2003,07:00:00,E5T5ZDT M. .., FILE NTIFS $M7T, 5851 [(M...] time, - WKS-WI
33/31/2093,07:00:00,Z8TSEDT, M. .., TILT NIFS SMFT, 831 (M...] time, -, WKS-WI
D3/31/2043,07:00:00,25T5ZDT, M. .., FILE, NTES $MFT,$SI (M...] time,-,WKS-HI] -

] 1% [

Cancel | [ Next > ] Finish

i. Step 2->Unselect Tab under Delimiters -> Select Comma under Delimiters -> Select NEXT >
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This screen lets you set the delimiters your data contains. Your can see how your textis affected in the preview

Delimiters

O

7] Semicolon ] Treat consacutive delimiters as one
@ i ’ , i=
Flspxce et ol |
Clote: [ ]

Data preview

cimazone MACE 1 ou 3 Ype isez

Text Import Wizard - Step 2 of 3 -2 IE

ate -
33/31/2003 P7:00:00 ESTISEDRT SI {...B} time
03/31/2003 SI52DT SI (M...] time
33/31/2003 p7:00:00 EST3ZDT SI [M...] tize
373172005 Jp7: STSEDT SI tM...) Tize -
of bt »
j- Step 3 ->Select Finish.
k. Where do you want to put the data? Simply Select OK.
Import Data |0 ||t
Where do you want to put the data?
@ Bisting worksheet:
=$AS1 (25
& New worksheet

l.  Onceimported View -> Freeze Panes -> Freeze Top Row.
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S

rcetype
Is swaer

Add-Ins

Zoom 100% ZJoomto

Selection

&

New
NMindow Al P

type
$SI [...B] time

X3} View Side by Side

24, Synchranous Scetiing

Arrange Freeze

anes *

Unfreere Panes
Unlack 2l rows and columns to scroll
through the entire warksheet,

B

Freeze Top Row

i Keéep the top row visible while s¢rolling
throughthe rest of the workshest

! Freeze First Column

| Keepthe tirst column visibl

m. Optional Hide Columns Time Zone, Host, Version.

Paste Options

Paste Speqial
Insent

Dalete

Clear Contents
Earmat Cells,..
Column Widtk
Hide

Unhide

n. Select HOME Ribbon.

Paste

4™ R 5
m M« Insert Page Lay¢
= # Cu
: Calibni

L U -

rmat Painter

o. Select all Cells "CTRL-A".
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p- In Home Ribbon -> Sort and Filter — Filter and you will be ready to begin analysis.

[ AutoSum * | A | &
| Fill 2 Jl}
Sort & 1d &

i Clear ~ Filter T::-'e;'. v

21 Sort Smallest to Largest

§ %l sortiargest to Smallest
; 8B custom Sort...

/= Filtar

g. Before you analyze too much — please save your new Color Timeline as an XLSX file:
/cases/win7-32-nromanoff-c-drive/vss-supertimeline.xlsx
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win2008R2-controller 10.3.58.4 PREP

Mount win2008R2-Controller Image

{Note: Some of this might already be accomplished via earlier exercises, but this is the state that we hope your system is in prior
to the start of this exercise. Just in case your system rebooted, we are including a guide to help you get back to the proper
analysis starting point prior to the beginning of this exercise.)

1. REBOOT your SIFT VMware Workstation in VMware Workstation.
2. login the VMware machine.
» LOGIN = sansforensics
» PASSWORD = forensics
3. Start a terminal, elevate your privs to root, and change into the /cases/win2008R2-controller-c-
drivedirectory.

$ sudo su -

# cd /cases/win2008R2-controller-c-drive

4. Mount your evidence files so you can see the win2008R2-controller-c-driveraw image and files/folders
from the system.

# ewfmount win2008R2-controller-c-drive.E01 /mnt/ewf/

# mount -o ro,loop,show _sys files,streams_ interface=windows
/mnt/ewf/ewfl /mnt/windows mount
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I Create SuperTimeline of MFT hive data across the core image and the VSS image_

|Create a SuperTimeline — Step-by-Step Guide

1. Step 1-Run Log2timeline.py

# cd /cases/win2008R2-controller-c-drive
# log2timeline.py —--parsers
“winevtx,filestat,winreg,webhist,lnk,prefetch” win2008-dc-plaso.dump

win2008R2-controller-c-drive.EO01l

Do Not Include Any Snapshots

2. Filter using psort.py

# psort.py -z "ESTSEDT" -o L2tcsv win2008-dc-plaso.dump
"date > '2012-04-02 20:00:00' AND date < '2012-04-07 00:00:00'" >

2008dc.timeline.csv

3. Switch over to your Windows Workstation (Host System Preferred) and open the \\SIFTWORKSTATION
from an open folder on your Desktop.

4. Take the filtered timeline and open it up in Excel using the color-timeline template from your windows
system.
a. Open Timeline Color Template
i. TIMELINE COLOR TEMPLATE.xlsx

Z1] TIMELINE_COLOR_TEMPLATE xlsx
2} TIMELINE_COLOR_TEMPLATE.2ip

b. Switch to Color Timeline worksheet/tab.
c. Click on Cell A-1.
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f.

-'J - B TIMELINE_CCLOR_TEMPLATE xlsx
ﬁﬁ Home  Inset  Pagelsyout  Formulas  Data  Review  View  Adddns
=) % Cut Catibri Il v AT A o=l ¥ SRwapTet General
43 Copy ~ = 5 B L
Pste o comatoamter B L U v A EEBE EE Svegescentar $ %
Clipboard Ta Font “ Alignment [ ; KNumt
Al - K
A B C D E F G
1 | I
2
3
4
5
6
)
d. Select 'DATA' Ribbon.
e. Import Data "FROM TEXT".
A= TIMELINE_COLOR_TEMPLATExsx
Home FormuRs | Data Review View Add-Ins
N TS L 1Lh) Connactions & Clear
P %] 8l Al% \ .
@ @ = : : R | 2 T ‘,{»&eapgty s
From From  Feoj From Other Refreshn %4} Sonm Filter - Textta f
Access Web  Te Saurces ¥ Connections Al > 2@' Advanced : Columns D
Get ENerral Data Sort & Feiter i
Al - 5
A B C D E F G
i[ ]
2
2

Select 2008dc. timeline.csvfile ->

\\siftworkstation\cases\win2008R2-controller-c-drive
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i) Import Test File
(;‘, : _-v + Metwerk » siftacrkstation » cates » aptdungan-c-drive » =t I ‘s

tganize Mew (eldes

, SHIELD-USE (L)
- OUTIUT (1)

bulk-extractor-autout
b Hetwe precqoned

e beywordstst
o GNEFFLR ‘ = resuitetat
B OOFIFLASIT-CS 4 imeline cyv
W OO0EIFI36119.CT aftelitiat .
W OOOFEFI51B3.CT aptdungan- ¢ drivetnt
i : "5" = \.-; 5 ’ ap-tdungan-¢-drive_bod,fiedst

OOOFEFESE2C2-C7
h. TEXT IMPORT WIZARD Will Start.
i. Step1l->Select Delimited -> Select NEXT.

Text Import Wizard - Step 1 of 3 i Ii-r&.h

The Text Wizard has determined that your data is Fixed Width.

If this is correct, choose Next, or choose the data type that best desaibes your data.

Original data type
Choose the file type that best describes your data;
o Qeknj{ . - Characters such as commas or tabs separate each field,
" Fixed wi Fieids are aigned in columns with spaces between each field.
Startimport atrow: 1 * File origin: 437 : OEM Unuted States TJ

Preview of file \\siftworkstation'cases \xp-tdungan ¢-drive \timeline. csv.

date, time, timezone, MACS, acurce, sourcetype, type,user hoat, shore, desc, vers] #
2103/31/2003,07:00: GQ,:STS:Q’ .. B,EIL7 WIEFS $¥FT,8SI [...B] time, -, WKS-WI
E’3313L/‘003,07.00.03 ESTSEDT, M. .., FILE, NTFS $MFT,35I [¥...] time,-, WKS-%I
03/31/2003,07:00:00,E5T52DT M. .. ,FILE, NTFS $MFT, 551 (M...] time,- WKS-9I
03/31/2003,07:09:00,25TSEDT, M. .., FILE, NTFS $MFT,$8I [M...] time, -, WKS-WI] ~

< LLL) [}

Cancel | | hext > | | Enish

j- Step 2 ->Unselect Tab under Delimiters -> Select Comma under Delimiters -> Select NEXT >
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Text Import Wizard - Step 2 of 3

Delmiters
Tab
Semmicolon Treat consecutive delimiters as one

M s [ ®
m Qualifier; E_.\M\.MM.,M.W

This screen lets you set the delimiters your data contains. You can see how youwr text is affected in the preview
balow.

=]

Flothe: | ]
Data preview
ate cimezone MACE QuUICcCetype Kype
03/3172003 P7: B F NTES $MFT 5I {...B)
33731720038 P7: iIES SMFT SI [¥.:..]
N3/31/2903 P7: {IES SMFT s8I [¥.
iTES $MFT SI ¥
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k. Step 3 ->Select Finish.
. Where do you want to put the data? Simply Select OK.

Import Data |-% :]é_&f
Where do you want to put the data?
@ Existing worksheet: _
=
& New worksheet

m. Once imported View -> Freeze Panes -> Freeze Top Row.
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3 Add-Ins
1 |
3 15 | |
(Y w0 \
Zoom 100% Zoomto

F
rcetype
S SMFT

'{ = ] = Spiit 11 View Side by Side
- S ' — Hide
Maw  Atrange Freeze
Window Al Panes ~
~-1 Unfreeze Panes
{ | Uniock 2ll rows and ¢olumns to scroll

type
$SI [...B] time

through the entire worksheaeat
Freeze Top Row

i Keep the top row visiblz while serolling
through the rest of the worksheet

Freeze First Column

Keep the first column visible while scrolling

through the rest of the worksheet

Save

Workspacs

n. Optional Hide Columns Time Zone, Host, Version.

Copy
Paste Options

Paste Special
fnsent

Delete

Clear Content;
Format Cells.
Column Wadtk. .
Hide

Unhide

0. Select HOME Ribban.

|
TR
m Hom Insert Page Laye
=1 ¥ Cu
O Calibn
' Copy -t
Paste .
b FJ Format Painter £ U

p. Selectall Cells "CTRL-A".
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g. In Home Ribbon -> Sort and Filter - Filter and you will be ready to begin analysis.
L AutoSum - ‘.f\i _,' - 3
| Fill - :/‘! f}
i Sort & | Find &
g Clear~ Filter = 'Select -
:} l Sort Smallest to Largest
f\ Sort Largest to Smailest
';.: -:_'._J"T:.r:': Sort...
‘= FEilter
r.

Before you analyze too much — please save your new Color Timeline as an XLSX file: /cases/
win2008R2-controller-c-drive/supertimeline.xlsx
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ABOUT SANS

SANS is the most trusted and by far the largest source for information
security training and certification in the world. It also develops, main-
tains, and makes available at no cost the largest collection of research
documents about various aspects of information security, and it oper-
ates the Internet’s early warning system - the Internet Storm Center.

The SANS (SysAdmin, Audit, Network, Security) Institute was established
in 1989 as a cooperative research and education organization. Its
programs now reach more than 165,000 security professionals around
the world. A range of individuals from auditors and network administra-
tors to chief information security officers are sharing the lessons they
learn and are jointly finding solutions to the challenges they face. At the
heart of SANS are the many security practitioners in varied global organ-

izations from corporations to universities working together to help the
entire information security community.

SANS provides intensive, immersion training designed to help you and
your staff master the practical steps necessary for defending systems
and networks against the most dangerous threats - the ones being
actively exploited. This training is full of important and immediately
useful techniques that you can put to work as soon as you return to your
office. Courses were developed through a consensus process involving
hundreds of administrators, security managers, and information secu-
rity professionals, and they address both security fundamentals and
awareness and the in-depth technical aspects of the most crucial areas
of IT security. www.sans.org

IN-DEPTH EDUCATION AND CERTIFICATION TRAINING WITHOUT TRAVEL ALTERNATIVES

Nothing beats the experience of attending a live SANS training event with
incomparable instructors and guest speakers, vendor solutions expos, and
myriad networking opportunities. Sometimes, though, travel costs and a
week away from the office are just not feasible. When limited time and/or
budget keeps you or your co-workers grounded, you can still get great SANS
training close to home.

During the past year, more than 12,000 security,
networking, and system administration professionals
attended multi-day, in-depth training by the world's top
security practitioners and teachers. Next year, SANS
programs will educate thousands more security profes-
sionals in the US and internationally.

Global Information Assurance Certification
The Global Information Assurance Certification (GIAC)
was founded in 1999 to validate the real-world skills of IT
security professionals. GIAC's purpose is to provide assur-
ance that a certified individual has practical awareness,
knowledge, and skills in key areas of computer, network,
and software security. GIAC currently offers certifications Six reasons to consider SANS OnSite:

for over 20 job-specific responsibilities that reflect the 1. Enjoy the same great certified SANS instructors and

current practice of information security. GIAC is unique in unparalleled courseware

measuring specific knowledge areas instead of general 2. Flexible scheduling - conduct the training when it is

purpose information security knowledge. 22,365 convenient for you

students have obtained GIAC certifications with hundreds . Focus on internal security issues during class and find solutions

more in the process of doing so. www.giac.org . Keep staff close to home

. Realize significant savings on travel expenses

. Enable dispersed workforce to interact with one another
in one place

SANS OnSite Your Location - Your Schedule

With SANS OnSite program you can bring a unique combination of high-
quality and world-recognized instructors to train your professionals at
your location and realize significant savings. For organizations that need
to train a large number of people, the SANS OnSite program is simply
hard to beat!

SANS BREAKS THE NEWS

SANS NewsBites is a semi-weekly, high-level executive
summary of the most important news articles that have
been published on computer security during the last
week. Each news item is very briefly summarized and
includes a reference on the Web for detailed information,
if possible. www.sans.org/newsletters/newsbites

DoD or DoD Contractor working to meet the stringent requirements
of DoD-Directive 85707 SANS OnSite is the best way to help you
achieve your training and certification objectives. Contact us today
for more information at onsite@sans.org or 678-714-5712.

SANS OnDemand Online Security Training & Assessments

When you want access to SANS' high-quality training ‘anytime, anywhere,
choose our advanced online delivery method! OnDemand is designed to
provide a very convenient, comprehensive, and highly effective means for
information security professionals to receive the same intensive, immer-
sion training that SANS is famous for. Students will receive:

@RISK: The Consensus Security Alert is a weekly
report summarizing the vulnerabilities that matter most
and steps for protection. www.sans.org/newsletters/risk

« Four months access to online training

» Integrated lectures by SANS top-rated
instructors

« Assessments to reinforce your
knowledge throughout the course

+ Hard copy of course books

» Access to our SANS Virtual
Mentor

* Labs & hands-on exercises
* Progress Reports

Ouch! is the first consensus monthly security awareness
| report for end users. It shows what to look for and how to
avoid phishing and other scams plus viruses and other
malware using the latest attacks as examples.
www.sans.org/newsletters/ouch
SANS @Home Personal SANS Instruction at Home
SANS @Home delivers live instruction via the Web using various Internet-
based technologies. Streaming audio, instant messaging, online forums,
and e-mail are all leveraged to make the student’s online learning experi-
ence as fun and engaging as possible.

The Internet Storm Center (ISC) was created in
2001 following the successful detection, analysis, and
widespread warning of the LiOn worm. Today, the ISC
provides a free analysis and warning service to thousands
of Internet users and organizations and is actively
working with Internet Service Providers to fight back
against the most malicious attackers. http://isc.sans.org

Visit our Web site for more ways to Train Without Travel
www.sans.org/training/without_travel

For group programs, please contact us at groupsales@sans.org




